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Notices 

The information contained herein is subject to change without notice. The only warranties 

for Hewlett Packard Enterprise products and services are set forth in the express warranty 

statements accompanying such products and services. Nothing herein should be construed 

as constituting an additional warranty. Hewlett Packard Enterprise shall not be liable for 

technical or editorial errors or omissions contained herein. 

Confidential computer software. Valid license from Hewlett Packard Enterprise required for 

possession, use, or copying. Consistent with FAR 12.211 and 12.212, Commercial 

Computer Software, Computer Software Documentation, and Technical Data for 

Commercial Items are licensed to the U.S. Government under vendor's standard 

commercial license. 

Export of the information contained in this publication may require authorization from the 

U.S. Department of Commerce. 

Links to third-party websites take you outside the Hewlett Packard Enterprise website. 

Hewlett Packard Enterprise has no control over and is not responsible for information 

outside the Hewlett Packard Enterprise website. 
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What’s New in This Manual 

New and Changed Information 

The fifth edition of the ASAP 3.0 Client supports the following features: 
 

HPE ASAP 3.0 Availability Stats And Performance data can now be integrated 

with local/remote websites including optional integration with HPE Systems 

Insight Manager (SIM). To add ASAP statistics to a website, do the following: 
a) Click the new WEBSITE button on Notify control panel. 
b) Select desired content: Score, Alerts, Detail, Entity, .. 
c) Select new customization options: Graphs, Icons, Border, Shade,.. 
d) If SIM website, check new SIM checkbox on the ASAP Notify control panel. 
e) Click OK or APPLY to commit your website into production. 
For more info about ASAP website integration see Notify Control Panel on page 
108. 

 

ASAP 3.0 Client supports all ASAP server versions ASAP 1.n, 2.n, and 3.n. 
The client factory EDL includes V1, V2, and V3 EDL files. Asap3Sys.edl provides 
support for 34 entities, and 1600+ meta-data attributes. For more information see 
ASAP client EDL files Asap1Sys.edl, Asap2Sys.edl, or Asap3Sys.edl files. 

 

An updated CPU EDL entity definition provides 6 new CPU memory statistics in 

the form of 6 new state pairs. For more info see the Asap3Sys.edl file. New CPU 

entity attributes include: 

- Total Memory Size 
- Swappable physical memory 
- Free physical memory 
- Locked physical memory 
- Maximum memory that can be locked 
- Highest locked memory since last CPU reload 

 

A new Swap EDL entity definition provides 63 new memory and swap file state 

and statistics attributes. For more info see Asap3Sys.edl file. 

 - new Swap entity icon 
 

An updated Spooler EDL entity definition provides monitoring and goals for 

Unique batch jobs. For more info see Asap3Sys.edl file. 
 

The FIND dialog box for the EDL IDE has two new check boxes labeled Date and 

Time. These check boxes allow searching and replacing EDL source containing a 

date or time. For more information see EDL - IDE Toolbar Buttons on page 130. 
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Seven new TCP/IP EDL sub-entity definitions provide additional monitoring and 
goals for a total of 977 TCP attributes and 111 Telserv attributes. The total 
TCP/IP/TelServ entities monitored are 19 TCP subsystem entities and 1088 
attributes. For more info about TCP/IP entities see the Asap3Sys.edl file. 

 

Summary of current TCP/IP Icons (new ASAP 3.0 entities are in bold). 

  - TCPARP 
 

  - TCPICMP + TCPICMP6 

 
 - TCPIGMP 

 

 - TCPIP + TCPIP6 

 
  - TCPLOOP 

 - TCPMONGQ 

 - TCPPort 

 
 - TCPProcess 

 - TCPQIO 

 - TCPRoute 

 - TCPRTE 

 - TCPSOCK 

 - TCPSubnet 

 - TCPUDP 

 - Telserv Process 

 - TelservService 

 - TelservWindow 
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New HTML Entity-Attribute Grid Reports allow interactive color-encoded grid- 
graph HTML reports. These reports can be accessed either via the Current Entity 
Report toolbar button that appears directly below the Entity drop-down on the main 
client window, or via FILE ... SAVE HTML as ... menu-items. For more information 
about interactive HTML reports, see Selecting an Entity on page 49; and the 
File... Save HTML as.... menu items. 

 

New Notify Content Report options allow HTML reports to be sent via email, 
web page, or phone. The ASAP Notify control panel Content tab provides 16 new 
controls that allow you to provide a wide range of customized ASAP HTML reports. 
For more information about how to customize ASAP HTML reports, see ASAP 
Notify Control panel Notify Content tab on page 109. 

 

A new Notify Root File and Shell File fields on the Notify Content tab of the 
Notify control panel allow ASAP HTML reports to be automatically included and 
dynamically updated into a local or remote proxy web site. The ASAP Notify control 
panel Content tab has two new fields labeled Shell File and Root File which allow 
ASAP HTML Reports to either be integrated into local websites, to create a 
standalone ASAP website, or to be integrated with remote proxy websites. For 
more information about how to use ASAP Shell and Root files see ASAP Notify 
Control panel Notify Content tab on page 109. 

 

A new HPE ASAP-SIM Systems Insight Manager interface allows ASAP real-
time reports to be dynamically displayed in HPE SIM. The ASAP Notify control 
panel includes a new SIM check box that allows integration with HPE SIM. For 
more information about how to use ASAP SIM options, see ASAP Notify Control 
panel Notify Content tab on page 109. 

 

An new description of the procedure for configuring a secure SSGCOM service 
that eliminates any requirement for userid's or passwords is now provided in this 
manual. For more information about how to configure a secure CSG/SSG 
communications link, see Configuring a secure SSGCOM service on page 38. 

 
 

The forth edition of this manual contained these changes: 
 

A new browse window popup menu item Show Related Measurement allows you 

to measure various ASAP objects on demand. For more detail, see Browse 

Window Pop-Up Menus on page 60. 
 

A new Show Related Measurement control panel allows quick point-and-click 

configuration of Measure on Demand. Measurements are automatically correlated 
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and formatted in ASAP report windows. This new feature allows users to determine 
which files and processes are causing a disk, file, process, or processor to be 
busy. For details, see Show Related Measurement on page 79. 

 

Sort View columns are now auto-sized to the maximum heading and/or context 

size. For more details, see new section Sizing Sort View Columns on page 60 

preceding the Browse Window Popup menus section. 
 

Sort View is now persistent from one update to the next, automatically sorting data 
after each host update. For more details, see Sort View Toolbar Button on page 
57 and the View... Sort-Grid View menu item described in Sizing Sort View 
Columns on page 60. 

 

A new State Filter Toolbar allows single-click object state filtering and viewing. For 

more details, see Selecting Minimum State on page 52. 
 

A new Copy Special report window function allows copying the window text, 

without header, trailer, carriage-return, or line-feed characters. For more details, 

see Report Window on page 76. 
 

The Show Removed Objects check box and the Delete Removed Objects drop- 
down on the General property tab allow you to configure how removed objects 
should be handled. Removed objects can now be retained indefinitely or 
alternately can be automatically deleted after a user configured number of minutes 
or hours. For more details, see Show Removed Objects Check Box on page 94. 

 

A new OEM Context drop-down on the OEM property tab allows you to control 
whether standard OEM context is passed to the OEM, or whether full XML or CSV 
OEM context is passed to the OEM. For more details, see OEM Property Sheet 
on page 98. 

 

The X1 toolbar button now provides dual functions for ease of use. Clicking X1 the 

first time sets the samples count to 1, subsequent clicks increment samples+10 

until Max Rows/Object is reached, and then clicking X1 sets the samples count 

back to 1. For more details, see Selecting a Sample on page 51. 
 

The EDL language has been enhanced to allow relationships to be defined 
between ASAP entities. Two new RELATION and MAP statements have been 
added to the EDL language. This aspect of the ASAP EDL language is called the 
relation definition language or RDL for short. For more details, see table for 
Section 6: Entity Definition Language (EDL) and the EDL-Relation Statement 
on page 158. 

The ASAP 2.5 version of the client contains these changes: 
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A new Notify control panel allows you to configure sending of automatic alerts and 

reports. Notifications can be sent automatically via e-mail, wireless phone, pager, 

or Internet browser. For more detail, see Notify Control Panel on page 108. 
 

Notifications can be configured to be sent in either color-coded HTML format for 

use with e-mail or Internet servers and browsers or as plain text messages for use 

with wireless phones or pagers. See Notify Control Panel on page 108. 
 

Notifications can be configured to occur when objects change state, scheduled to 
report at various times of the day, or can be automatically stored on disk for use as 
web content at the end of each ASAP analysis sample. See Notify Content on 
page 109. 

 

A new Notify button has been added to the OSC tab of the ASAP Properties 

window. This button displays the new Notify control panel. See Notify Button on 

page 105. 
 

A new Set Password button has been added to the General tab of the ASAP 
Properties window. This button displays a dialog that allows you to password 
protect various property sheets (and lock functions) in the ASAP environment. See 
Set Password Button on page 93. 

 

There are new ways to save or e-mail ASAP data in HTML format. New pull-down 

menus, FILE SAVE HTML and FILE SAVE HTML AS, allow statistics to be saved, 

displayed, and mailed in color-coded HTML format. 
 

A new pull-down menu item, EDIT COPY HTML, allows ASAP statistics to be 

copied to the clipboard in color-coded HTML format. 
 

The Client provides several new ways to automatically download and compile 
server EDL files. In the main client browse window, there is a new pull-down menu 
item - FILE COMPILE SERVER EDL. In the EDL IDE window, there is a new pull- 
down menu item - FILE DOWNLOAD SERVER EDL. See Compile Server EDL 
under File Menu Items on page 62. 

 

A new EDL synchronization dialog box automatically appears whenever an EDL 

version mismatch appears, allowing automatic EDL version synchronization. 
 

There is a new Auto Restart Session check box on the SSG tab of the ASAP 

Properties window. When checked, the ASAP client now automatically restarts 

failed host sessions. See Auto Restart Session Check Box on page 119. 
 

A new Dashboard menu item has been added to the Browse window View menu. 

This new function allows you to save or display user-defined dashboards. A 
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dashboard can contain a variety of graphs. As you define more dashboards, this 
menu grows dynamically, retaining each of your named dashboards. When the 
client is shut-down, graphic elements and associated properties are retained and 
upon startup are restored and become active elements once again. See View 
Menu Items on page 65. 

 

Graph Type is a new menu item on Dashboard graph windows. To select Graph 
Type, right-click on an existing dashboard graph and then select the Graph Type 
menu item to display a list of different graph types. Selecting one of these graph 
types changes the display accordingly. Upon shutdown, graph type is retained 
along with other window position, size, samples, minimum state, and dashboard 
node, entity, and object properties. Different dashboard graphs can have different 
graph types. 

The third edition of the manual contained these changes: 
 

new base type was added to DataItems - EDL Entity Property on page 135. 
 

Clarity was added to Format - EDL Attribute Property on page 146. 

The second edition of this manual contained these changes: 
 

Updated information throughout to indicate ASAP Client supports Windows NT, 

Windows 95, and Windows 98, Windows 2000, ME, Windows XP, Windows 7.  
 

Updated information throughout to indicate support for Application, CPU, Disk, 

Expand, Node, Processbusy, and System entities 
 

Added information about the new File, Process, RDF, Spooler, Tape, and TMF 

entities throughout the manual 
 

Added new Browse Window toolbar buttons to Toolbar Button Summary on page 

46. 
 

Added information about the Entity Definition Language (EDL) and use of EDL files 

throughout the manual, including Save EDL Button on page 57 and File Menu 

Items on page 62. 
 

Added information about the Object State Change (OSC) Window to OSC Window 

on page 68. 
 

Added operational status to the downloaded performance attributes for the 

appropriate entities in Entity Property Sheet on page 89. 
 

Added information about the Icons button to General Property Sheet on page 91. 

A 
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Added information about the Icon Server Control Panel on page 97. 
 

Added information about trace audits to SSG Property Sheet on page 116. 
 

Added Section 6: Entity Definition Language (EDL). 
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About This Manual 
This manual describes the Availability Statistics and Performance (ASAP) product, 
which provides a network-wide system monitoring, statistics collection, and 
presentation infrastructure for NonStop™ systems. 

Using ASAP, you can monitor the performance and availability objectives of many 
entities, including Application, CPU, Disk, Expand, File, Node, Process, Processbusy, 
RDF, Spooler, System, Tape, and TMF. 

If you install the optional ASAP Extension, ASAP reports application statistics and 
service-level objectives as well. 

This manual is intended for system operators business analysts and system 
administrators who use ASAP. 

ASAP requires the D42 RVU or G06 or later. Knowledge of the NonStop™ operating 
system is recommended for system operators and administrators. 

Manual Organization 
 
 

Section Describes... 

Section 1: Introduction 
to ASAP 

ASAP, its architecture, and components. 

Section 2: Installing 
ASAP 

Installing the ASAP Server and Client on your systems. 

Section 3: Starting the 
ASAP Client 

Starting up the ASAP Server and Client, configuring the 
Client Server Gateway (CSG), and configuring the 
entities for ASAP to monitor. 

Section 4: Using ASAP The windows in the ASAP Client interface, their 
elements, and how to use them to perform various 
tasks. 

Section 5: Configuring 
ASAP 

The ASAP Properties window in the ASAP Client 
interface and how to use it to customize your ASAP 
environment. 

Section 6: Entity 
Definition Language 
(EDL) 

Entity Definition Language (EDL), which you can use to 
define abstract entities and their associated properties. 

 

Related Resources 

Additional technical resources including frequently asked questions, example screen 
shots, softdoc and readme file history, database calculators, Java native interface, and 
shared wrappers are available at the HPE NonStop™ ASAP technical portal 
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Notation Conventions 

Hypertext Links 
Blue underline is used to indicate a hypertext link within text. By clicking a passage of 
text with a blue underline, you are taken to the location described. For example: 

This requirement is described under Backup DAM Volumes and Physical Disk 
Drives on page 3-2. 

General Syntax Notation 

This list summarizes the notation conventions for syntax presentation in this manual. 

UPPERCASE LETTERS 

Uppercase letters indicate keywords and reserved words. Type these items exactly as 
shown. Items not enclosed in brackets are required. For example: 

MAXATTACH 

 
lowercase italic letters 

Lowercase italic letters indicate variable items that you supply. Items not enclosed in 
brackets are required. For example: 

file-name 

 
computer type 

 

Computer type letters within text indicate C and Open System Services (OSS) 
keywords and reserved words. Type these items exactly as shown. Items not enclosed 
in brackets are required. For example: 

myfile.c 

 
italic computer type 

 

Italic computer type letters within text indicate C and Open System Services 

(OSS) variable items that you supply. Items not enclosed in brackets are required. For 
example: 

pathname 

 
[ ] Brackets 

Brackets enclose optional syntax items. For example: 
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TERM [\system-name.]$terminal-name 

INT[ERRUPTS] 

A group of items enclosed in brackets is a list from which you can choose one item or 
none. The items in the list can be arranged either vertically, with aligned brackets on 
each side of the list, or horizontally, enclosed in a pair of brackets and separated by 
vertical lines. For example: 

FC [ num ] 

[ -num ] 

[ text ] 

K [ X | D ] address 

 
{ } Braces 

A group of items enclosed in braces is a list from which you are required to choose one 
item. The items in the list can be arranged either vertically, with aligned braces on 
each side of the list, or horizontally, enclosed in a pair of braces and separated by 
vertical lines. For example: 

LISTOPENS PROCESS { $appl-mgr-name } 

{ $process-name } 

ALLOWSU { ON | OFF } 

| Vertical Line 

A vertical line separates alternatives in a horizontal list that is enclosed in brackets or 
braces. For example: 

INSPECT { OFF | ON | SAVEABEND } 

 
… Ellipsis 

An ellipsis immediately following a pair of brackets or braces indicates that you can 
repeat the enclosed sequence of syntax items any number of times. For example: 

M address [ , new-value ]… 

[ - ] {0|1|2|3|4|5|6|7|8|9}… 

An ellipsis immediately following a single syntax item indicates that you can repeat that 
syntax item any number of times. For example: 

"s-char…" 



 
Page 18 of 161 HPE NonStop ASAP Client Manual                     

Punctuation 

Parentheses, commas, semicolons, and other symbols not previously described must 
be typed as shown. For example: 

error := NEXTFILENAME ( file-name ) ; 

LISTOPENS SU $process-name.#su-name 

Quotation marks around a symbol such as a bracket or brace indicate the symbol is a 
required character that you must type as shown. For example: 

"[" repetition-constant-list "]" 

 
Item Spacing 

Spaces shown between items are required unless one of the items is a punctuation 
symbol such as a parenthesis or a comma. For example: 

CALL STEPMOM ( process-id ) ; 

If there is no space between two items, spaces are not permitted. In this example, no 
spaces are permitted between the period and any other items: 

$process-name.#su-name 

 
Line Spacing 

If the syntax of a command is too long to fit on a single line, each continuation line is 
indented three spaces and is separated from the preceding line by a blank line. This 
spacing distinguishes items in a continuation line from items in a vertical list of 
selections. For example: 

ALTER [ / OUT file-spec / ] LINE 

[ , attribute-spec ]… 

!i and !o 

In procedure calls, the !i notation follows an input parameter (one that passes data to 
the called procedure); the !o notation follows an output parameter (one that returns 
data to the calling program). For example: 

 

CALL CHECKRESIZESEGMENT ( segment-id  !i 

 , error ) ; !o 
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!i,o  
 

In procedure calls, the !i,o notation follows an input/output parameter (one that both 
passes data to the called procedure and returns data to the calling program). For 
example: 

error := COMPRESSEDIT ( filenum ) ; !i,o 

 

!i:i  
 
In procedure calls, the !i:i notation follows an input string parameter that has a 
corresponding parameter specifying the length of the string in bytes. For example: 

error := FILENAME_COMPARE_ ( filename1:length !i:i 

, filename2:length ) ; !i:i 

 

!o:i  
 
In procedure calls, the !o:i notation follows an output buffer parameter that has a 
corresponding input parameter specifying the maximum length of the output buffer in 
bytes. For example: 

error := FILE_GETINFO_ ( filenum !i 

, [ filename:maxlen ] ) ; !o:i 

 

Notation for Messages 
This list summarizes the notation conventions for the presentation of displayed 
messages in this manual. 

Bold Text 

Bold text in an example indicates user input typed at the terminal. For example: 

ENTER RUN CODE 

?123 

CODE RECEIVED: 123.00 

The user must press the Return key after typing the input. 

Nonitalic text 

Nonitalic letters, numbers, and punctuation indicate text that is displayed or returned 
exactly as shown. For example: 

Backup Up. 
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lowercase italic letters 

Lowercase italic letters indicate variable items whose values are displayed or returned. 
For example: 

p-register 

process-name 

[ ] Brackets 

Brackets enclose items that are sometimes, but not always, displayed. For example: 

Event number = number [ Subject = first-subject-value ] 

A group of items enclosed in brackets is a list of all possible items that can be 
displayed, of which one or none might actually be displayed. The items in the list can 
be arranged either vertically, with aligned brackets on each side of the list, or 
horizontally, enclosed in a pair of brackets and separated by vertical lines. For 
example: 

proc-name trapped [ in SQL | in SQL file system ] 

 
{ } Braces 

A group of items enclosed in braces is a list of all possible items that can be displayed, 
of which one is actually displayed. The items in the list can be arranged either 
vertically, with aligned braces on each side of the list, or horizontally, enclosed in a pair 
of braces and separated by vertical lines. For example: 

obj-type obj-name state changed to state, caused by 

{ Object | Operator | Service } 

process-name State changed from old-objstate to objstate 

{ Operator Request. } 

{ Unknown. } 

 
| Vertical Line 

A vertical line separates alternatives in a horizontal list that is enclosed in brackets or 
braces. For example: 

Transfer status: { OK | Failed } 

 
% Percent Sign 

A percent sign precedes a number that is not in decimal notation. The % notation 
precedes an octal number. The %B notation precedes a binary number. The 
%H notation precedes a hexadecimal number. For example: 
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%005400 

%B101111 

%H2F 

P=%p-register E=%e-register 

 

Notation for Management Programming Interfaces 

This list summarizes the notation conventions used in the boxed descriptions of 
programmatic commands, event messages, and error lists in this manual. 

UPPERCASE LETTERS 

Uppercase letters indicate names from definition files. Type these names exactly as 
shown. For example: 

ZCOM-TKN-SUBJ-SERV 

 
lowercase letters 

Words in lowercase letters are words that are part of the notation, including Data 
Definition Language (DDL) keywords. For example: 

token-type 

 

!r 

The !r notation following a token or field name indicates that the token or field is 
required. For example: 

ZCOM-TKN-OBJNAME token-type ZSPI-TYP-STRING. !r 

 

!o 

The !o notation following a token or field name indicates that the token or field is 
optional. For example: 

ZSPI-TKN-MANAGER token-type ZSPI-TYP-FNAME32. !o 
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Section 1: Introduction to ASAP 
This section provides an overview of the ASAP product: 

HPE Availability Statistics and Performance (ASAP) software product provides an 
infrastructure for monitoring the availability and performance of system and application 
objects: 

 

System object information includes the operational status and performance of 

NonStop™ servers. 
 

Application information includes user-defined application domain availability 

statistics. 

ASAP consists of monitoring components that together provides a performance and 
availability monitoring infrastructure: 

 

ASAP Client is an analysis client that runs on Microsoft Windows 7, Vista, 2003 
Server, XP, 2000, NT, ME, or Windows 98, and provides both graphical user 
interface (GUI) and intelligent agent functions to a wide range of enterprise 
management solutions including HPE Systems Insight Manager, HPE OpenView 
Operations, and HPE Web Viewpoint. The ASAP Client continuously 
communicates with the ASAP Server running on the Nonstop™ servers, and 
communications with wireless phones, pagers, e-mail servers, and HTML 
browsers. 

 

ASAP Server is the ASAP server that monitors, gathers, and analyzes availability, 

state, and performance statistics throughout a network of HPE NonStop™ servers. 
The ASAP product includes monitoring agents that monitor system components 
such as CPUs, Comm lines, Disks, Expand, Files, Memory, Nodes, Processes, 
Business Processes, RDF, Spooler, Swapfiles, Systems, Tape, Tcp/IP, TMF, as 
well as application processes. The ASAP Server also includes fully automated 
Goals and Actions integrated into the base product. 

 

ASAP Server plug-ins provide in-depth statistics and availability monitoring of a 

particular subsystem. For example, the TCP/IP plug-in provides an additional 12 

new entities along with 600 additional performance and availability statistical 

attributes associated with the TCP/IP subsystem. 
 

ASAP extension provides an application programmer interface (API) so you can 

monitor the availability and performance of your application domains. The API lets 

Application domain statistics become fully integrated with ASAP Client/Server 

functions. 
 

ASAP Hybrid extends the capabilities of ASAP application monitoring to remote 

systems running the Linux OS. Application metrics from remote Linux systems are 
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integrated in ASAP on one or more NonStop™ servers providing an overall view 
of entire application sets as they span one or more remote NonStop™And Linux 
servers. 

 

Topic Page 

Feature Summary 24 

ASAP Architectural Overview 26 

ASAP Client Component Overview 27 

OEM Architectural Overview 29 

The ASAP Client graphical user interface (GUI), the primary data analysis interface to 
ASAP displays NonStop™ OS performance and state information, as well as customer 
application availability statistics. Using the ASAP Client, you can view and analyze 
real-time or historical network-wide views of Application, Comm, CPU, Disk, Expand, 
File, Node, Process, ProcessBusy, Query, RDF, Spooler, System, Tape, TCP/IP, 
Telnet Server, and TMF entities. Informational views can encompass all of your 
NonStop™ OS nodes, reflect a selected set of nodes, or focus on a single node, 
entity, or object. 

The ASAP Client also has built-in agent functions that run on Windows 7, 2003 
Server, XP, 2000, NT, ME, or Windows 98. ASAP Client automatically retrieves and 
analyzes statistics from the ASAP Server. ASAP Client services can be configured to 
forward object statistics and state information to wireless phones, pagers, SMTP e-
mail servers, HTML browser, or to enterprise management frameworks such as HPE 
OpenView. 
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Figure 1-1. Sample ASAP Client Screen 

 

Feature Summary 

The ASAP Client includes a powerful set of graphics, controls, and toolbars that help 
you browse, report, and analyze application and system statistics. ASAP runs on 
Windows 7, Vista, Windows XP, Windows 2000, Windows ME, and Windows NT 
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workstations connected by TCP/IP or asynchronous communications links to one or 
more NonStop™ systems. 

The ASAP Client provides: 
 

Windows 7 and XP context sensitive interface 
 

Windows 7, XP, Windows 2000, Windows ME, Windows NT, Windows 95, and 

Windows 98 compatibility 
 

High-speed hierarchical object cache of statistics 
 

Real-time, network-wide state and performance views 
 

True 3-D graphical views of all ASAP statistical entities 
 

Browse windows for detailed entity analysis and reporting 
 

Graph windows for multiple real-time views of host objects 
 

Report windows for customized reporting of selected objects 
 

Performance and State icons propagated upward through tree view 
 

Automatic host communication using the Client Server Gateway (CSG) 
 

Context-sensitive menus on all graphs and grids for data mining 
 

Full customization of displays including entity and attribute specification 
 

Encapsulated interface to Open Enterprise Management (OEM) Gateway 
 

Reporting of Application, CPU, Disk, Expand, File, Node, Process, Processbusy, 

RDF, Spooler, System, Tape, and TMF entities 
 

Internationalization and user-customization of objects, states, icons, and colors 
 

Hierarchical Object Integration Layer (OIL) tree view of NonStop™ OS nodes, 

entities, and objects 
 

Entity Definition Language for external definition of entities and associated 

attributes 
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Automated alerts and detailed notification reports that can be sent via wireless 

phone, pager, e-mail, or internet browser 
 

Reports that can be sent when objects change state, scheduled to report at various 

times of the day or stored for use in web content at the end of each analysis 

sample 
 

Dashboard views that can be named, saved, and displayed to provide unique sets 

of user-defined graphical views 
 

Reports can be obtained by selecting a busy object such as a disk, and then 

selecting Show Related Measurement to obtain highly detailed Measure reports on 

the busiest files and process openers for a selected CPU, Disk, File, or Process. 

ASAP Architectural Overview 

ASAP consists of these functional layers: 
 

The ASAP Server includes remote-node statistics-gathering processes (SGPs) that 
run throughout an Expand network of NonStop™ systems. These intelligent SGPs 
gather and analyze Application, CPU, Disk, Expand, File, Node, Process, 
Processbusy, RDF, Spooler, System, Tape, and TMF entity information and report 
this information to a local-node ASAP database server. 

 

The ASAP database server collects and normalizes network-wide application and 

system availability data and stores this information in the ASAP database. The 

ASAP local-node server includes command interpreters and database servers 

acting on behalf of ASAP workstation clients. 
 

The ASAP Client includes GUI and agent functions to help you view and analyze 
system and application statistics. Using ASAP, you can view the overall state of 
your applications and systems, as well as performance information. You can also 
focus on specific nodes, entities, or objects. The ASAP Client runs on workstations 
running Windows 7, XP, Windows 2000, Windows ME, Windows NT, Windows 95, 
or Windows 98. 
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Window 

Figure 1-2. ASAP Architectural Overview Diagram 
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The ASAP Client communicates object information to the Open Enterprise 

Management Gateway (OEM). State information is also reported, letting enterprise 

management frameworks supported by OEM adapters display objects and their 

operational states. 

ASAP Client Component Overview 

Browse Window 

Use the Browse window to view statistics; to browse and analyze nodes, entities, and 
objects; and to control the ASAP environment. This window updates in real-time to 
reflect the nodes, entities, and objects you select. For more information, see Browse 
Window on page 46. 
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Graph Window 

You can create one or more Graph windows from a Browse window. Graph windows 
are useful for maintaining multiple views of specific node-entity-object combinations. 
These windows update in real-time to reflect the nodes, entities, and objects you 
select. For more information, see Graph Window on page 75. 

Report Window 

You can get detailed reports about a selected node, entity, or object in Browse or 
Graph windows from context-sensitive pop-up menus. Report windows update in real- 
time to reflect customized reports about the nodes, entities, and objects that you 
select. For more information, see Report Window on page 76. 

 

ASAP Properties Window 

Use the ASAP Properties window to customize your ASAP view, including the entities 
to retrieve from the NonStop™ OS host systems, the attributes of each entity to display, 
the font to use, and the options to use for graphing and maintaining your Host Session. 
For more information, see Section 5: Configuring ASAP. 

Session Window 

ASAP can retrieve both real-time and historic statistics information. Through the 
Session window, you can view, start, stop, and track the progress of your Host 
Session. You can start and stop your Host Session using the Session window's menus 
and toolbar. For more information, see Session Window on page 80. 

 

Real-time Data Management 

ASAP maintains a real-time hierarchical cache memory of statistics to improve 
performance. This performance data cache minimizes the amount of host I/O required 
for standard real-time displays and provides fast response times for specific interactive 
data browsing queries. For more information on real-time data retrieval, see Entity 
Property Sheet on page 89. 

 

OEM and OIL Views 

You can use the Open Enterprise Management Gateway (OEM) or Object Integration 
Layer (OIL) to obtain high-level views of NonStop™ OS nodes, entities, and objects. 
Select an object in the OEM or OIL to generate an ASAP report on that object. 
Statistics and state information can also be automatically propagated upward through 
the OIL tree view on a priority basis. The algorithm ensures that even when you 
collapse the OIL tree view, the relative utilization and state of nodes, entities, or 
objects are visible. For more information, see OEM Property Sheet on page 98 and 
OIL Property Sheet on page 100. 
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OSC View 

You can use the Object State Change (OSC) view to obtain a history of object state 
changes. The OSC view provides both a high-level graphical overview and a detailed 
log of object state changes. The OSC scoreboard displays an annotated matrix 
summarizing the number and type of state changes that have occurred. The 
scoreboard contains a row for each entity type monitored and a column for each state 
monitored. When you select a cell in the scoreboard, the OSC log is searched for all 
Object State Changes that match the selected entity type and state. For example, if 
you click a cell that intersects the Disk row, the Down column automatically locates all 
Down Disk state changes that have occurred. For more information, see OSC Window 
on page 68. 

 

Notifications - Overview 

You can use the Notify control panel to configure automatic alerts and report 
notifications. ASAP alerts and report notifications can be sent via phone, pager, e-mail, 
or Internet browser. Notifications can be sent when objects change state, or can be 
scheduled to occur at various times of the day, or they can occur at the end of each 
analysis sample for inclusion in web site content. Notification reports can include high- 
level object state summaries, object state change alerts, or lists of critical sorted object 
state information. Reports can be formatted either in color-coded HTML format or in 
short text format for use with short text message devices such as wireless phones or 
pagers. For more information, see Notify Control Panel on page 108. 

Icon Server 

You can customize icons and colors that appear in your ASAP environment and in the 
OEM and OIL views to allow for internationalization. Use the Icons button on the 
General tab of the ASAP Properties window. For more information on the Icon Server, 
see Icon Server Control Panel on page 97. 

 

EDL ADE 

The ASAP Client includes an Entity Definition Language application development 
environment (EDL ADE). The EDL lets you define system entities, customer 
application domains, and third-party entities, and dynamically add them to the ASAP 
client environment. For more information, see Section 6: Entity Definition Language 
(EDL). 

OEM Architectural Overview 

The Open Enterprise Management (OEM) Gateway provides customer applications 
with an optional encapsulated interface layer to enterprise management frameworks. 
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The ASAP subsystem communicates node, entity, and object information to the OEM 
Gateway. It reports object state information, so objects and their operational states are 
displayed in Enterprise Management Frameworks supported by OEM Gateway 
adapters. 

The OEM consists of a Server component and one or more Adapter components. 
Statistics agents such as the ASAP Client communicate with the OEM Server 
component. The Server communicates with an OEM Adapter or Adapters on behalf of 
the client’s agents, while the Adapters handle communication to and from enterprise 
management frameworks. 

The OEM layer handles all details of the interface to enterprise management 
frameworks. As a result, ASAP can communicate statistics information in a uniform 
and consistent manner so that various enterprise management frameworks can display 
these object statistics. 

 
Figure 1-3. OEM Architectural Overview Diagram 
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Section 2: Installing ASAP 
 
 

Topic Page 

Installing Monitoring Components 32 

Installing the SSG 33 

 
Installing ASAP on the Workstation 

34 

The ASAP GUI and Agent components running on your Windows workstation 
communicate with NonStop™ servers. ASAP uses the SeeView Server Gateway (SSG) 
to communicate with your NonStop™ OS node. 

 
Figure 2-1. ASAP Installation Overview Diagram 

 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

To install ASAP: 

 
 

VST004.vsd 

1. Verify that the ASAP host subsystem is installed on your NonStop™ systems. 
This lets ASAP receive performance data from your NonStopTM servers. 

2. Verify that the SSG is installed on your local NonStop™  OS node. SSG is 
normally already installed on NonStop™  servers. 

3. Install the ASAP Server on your local NonStop™ M system. 

4. Install the ASAP Server on one or more remote NonStop™  systems. 

5. Install the SSG Server on your local NonStop™  system. 

6. Install the ASAP Client on your Windows workstation. 

For abbreviated instructions for using these scripts, see Installing Monitoring 
Components on page 32. For detailed instructions about installing these products, 
see the specific product manual. 
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Installing Monitoring Components 

For a detailed description of how to install ASAP host components on local and remote 
NonStop™  servers, see the ASAP Server Manual and the ASAP Extension Manual. 

To install ASAP Server on the host: 

1. Upload the ASAP Server files from the ASAP Server CD. 

2. TACL 1 > LOGON network-group.userid 

3. TACL 2 > VOLUME $ASAP-ISV-Volume.ZASAP 

4. TACL 3 > OBEY INSTALL 

5. Follow the directions for “Full Install on this node” in the online help. 

6. Follow the directions for “Remote Monitor Install” in the online help. 

7. When ASAP host installation is complete, start the ASAP subsystem by using the 
ASAP command interpreter START COLLECT and START MONITOR commands. 
For example: 

TACL 1 > ASAP 

+ START COLLECT 

+ START \CHICAGO 

+ START \NEWYORK 

+ START \SANFRAN 
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Installing the SSG 

For a detailed description of how to install the SSG on NonStop™  servers, see the 
SeeView Server Gateway (SSG) Manual. 

For D43 and later, the SSG is normally already installed on NonStop™  systems. If 
SSG is already installed, you do not need to reinstall it. 

To see if the SSG is installed on your local host node: 

TACL 1 > SSGCOM 

If START or STATUS commands are available from within SSGCOM, the SSG 
command interpreter, the SSG is installed on your system. 

If SSG is not installed on your system, you need to perform a SSG Local Node Install 
before you can use ASAP. ASAP does not require Remote Server Call (RSC), so you 
do not need to install RSC before using ASAP. 

To install the SSG on your local node: 

1. TACL 1 > LOGON network-group.userid 

2. TACL 2 > VOLUME $SSG-ISV-Volume.ZNOWSSG 

3. TACL 3 > OBEY INSTALL 

4. Follow the Local Node Install directions in the online help. 

5. When SSG installation is complete, start the SSG by using the SSGCOM 
command interpreter START command. For example: 

TACL 1 > SSGCOM 

+ START 
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Installing ASAP on the Workstation 

How you install ASAP on your Windows workstation depends on whether you are 
installing from a CD or from a NonStop™  server. 

Installing ASAP From a CD 

ASAP is normally distributed on an HPE Independent Product CD. 
 

To install ASAP from CD: 

1. Insert the CD into your PC. 

2. Run Setup.EXE. Setup runs automatically if the Windows AutoRun feature is 
enabled on your system. If AutoRun is not enabled, manually run Setup.EXE from 
the CD. 

3. Follow the directions in Setup. 
 

Consideration: 

ASAP Setup does not replace preexisting files such as DLL, EXE, and OCX files if the 
preexisting files on your workstation are newer or a later version than those in the 
ASAP distribution file. 

Installing ASAP From a NonStop™  Server 

The ASAP workstation installation file is normally distributed on an HPE Independent 
Product CD. However, if it is on your NonStop™  server, you can install it from the 
NonStop™  OS host. 

 

To install ASAP from the NonStop™  OS host: 

1. Download the ASAP SETUPEXE file from your NonStop™  OS host system 
to a temporary directory on your workstation. Use a temporary name such as 
C:\AsapTemp. 

2. Name the downloaded file Setup.EXE. 

3. Run Setup.EXE. 

4. Follow the directions in Setup. 
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Section 3: Starting the ASAP Client 
Before running the ASAP Client, start the ASAP Server subsystem on your 
NonStop™  OS host systems by using the ASAP Server command interpreter 
START MONITOR and START COLLECT commands. For detailed information 
about installing and starting ASAP on the host, see the ASAP Server Manual. 

 

Topic Page 

Starting ASAP 35 

Starting and Configuring the CSG 36 

Configuring ASAP Entities 43 
 

Starting ASAP 

To start the ASAP Client, from the Start menu on your PC, select: 

Start > Programs > ASAP 

When started, ASAP displays a startup dialog box with these buttons: 
 

Button Use to... 

Setup Configure ASAP or experiment with ASAP without a host connection. 

Because ASAP displays statistical information defined in EDL DATA 
statements, not information in your host database, selecting Setup lets 
you run the ASAP Client without a host connection. This approach is 
useful for analyzing existing EDL files and for education and 
demonstration. 

EDL DATA statements appear in the Asap2 Factory.EDL and Asap2 
Custom.EDL files. The factory EDL file is shipped with the ASAP Client 
and should never be modified. The custom EDL file contains your 
customized settings. DATA statements let you experiment with the 
ASAP Client environment without a host connection. When you start 
the ASAP Client, EDL files are associated with your ASAP 
environment. EDL file contents define the entities and data that the 
client displays. For more information, see Section 6: Entity Definition 
Language (EDL). 

Connect Connect to your NonStop
™  OS host system and view current availability 

and performance information. 

When you select Connect, ASAP accesses your host computer 
through an ActiveX server called the Client Server Gateway (CSG) on 
your workstation. The CSG is installed as part of the standard ASAP 
setup. 

Cancel Stop the ASAP launch. 
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Running the CSG 

You can start the CSG in two ways: 
 

Manually: Double-click the CSG.EXE file. 
 

Automatically: ASAP starts the CSG through ActiveX OLE automation. 

Either method is acceptable, but to fully understand the process you might want to 
manually start and configure the CSG the first time. 

Starting and Configuring the CSG 

Once the CSG is installed successfully, launch and configure it. The first time you click 
the Connect button, you need to configure the CSG for your workstation. For detailed 
information about how to set up and use the CSG, see the Csguser.doc file in the 
Program Files\Tandem\CSG workstation directory. 

To start and configure the CSG: 

1. Run the CSG in any of these ways: 
 

Double-click CSG.EXE to start it manually. 
 

Click Connect at ASAP startup. 
 

Click the Start Session toolbar button in the ASAP Session window. 

2. From the CSG View menu, select Options to open the CSG.CSG Options 

window. 

If you are running the CSG for the first time, it displays: “The CSG has not been 
configured. You must configure the CSG before continuing.” Click OK to open the 
CSG Options window. You can reconfigure the CSG later by selecting Options 
from the CSG View menu. 

3. When the CSG.CSG Options window opens, click the Defaults tab if it is not 

already selected. The Defaults property sheet appears. 

4. In the Active Transport frame, select the TCP/IP or Async option to specify the 

active transport. 

If you use a TCP/IP connection to your NonStop™  OS host, select the TCP/IP 
property sheet; then specify the TCP/IP address of your NonStop™ OS host. 
For example: 

TCP/IP Address: 168.87.8.20 

TelNet Port: 23 

Host Service Name: TACL 
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If you use an asynchronous connection to your host, select the Async property 
sheet; then specify the attributes for your connection. For example: 

Com Port: Com1 

Baud Rate: 19200 

Date Bits: 7 

Stop Bits: 1 

Parity: Even 

Flow Control: None 

Echo: Host 

Connection Type: Modem (Hayes Compatible) 

Phone Number: 555-1234 (if you are using a modem) 

5. Select the Session property sheet to specify host connection options. For 

example: 

[x] Auto Logon 

[ ] Auto Logoff 

[x] Auto Start Session 

Host SSGCOM File Name: $SYSTEM.SYSTEM.SSGCOM 

6. Click OK at the bottom of the CSG Options window. 

7. Click the CSG Start Session toolbar button, or select the Start Session menu 
item from the CSG File menu. 
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Configuring a secure SSGCOM service 
 

This section describes the steps involved in configuring a secure, Telnet-based 
communication link for use by the ASAP Client. This section would be of interest if you 
are concerned about the possibility of user ID and password information being 
transmitted in clear text across the local network. By following the steps below, CSG 
and SSG can be configured in such a way that no logon userid or password 
information are required to the NonStop™  server. Further, the TelServ process used 
by ASAP can be set up so that it cannot be used for any purpose other than serving as 
a communication pipe for ASAP. 

 

Configuring NonStop™  server SSGCOM service 

Configuration of the NonStop™  server SSGCOM service involves three separate 
steps: starting the TelServ process, configuring the SSGCOM Telnet service, and 
specifying SSG security settings in the SSGCONF file: 

1. Start TelServ Process 

This step starts a “secure” TelServ process. This includes starting the process itself on 
a TCP/IP port other than the standard default of port 23, specifying that it should not 
display a banner or menu, and specifying that it should not allow access to TACL. 

For the purposes of this example, we’re starting a TelServ process named $TLSV on 
port 8423 of TCP/IP process $ZTC04: 

TACL 1> PARAM ZTNT^TRANSPORT^PROCESS^NAME $ZTC04 

TACL 2> TELSERV/NAME $TLSV, TERM $ZHOME, PRI 170, NOWAIT/8423 – 

nobanner –nomenu -notacl 

In the above, “8423” defines the port number on which TelServ will accept 
connections, the “-nobanner” option prevents TelServ from displaying a banner or 
welcome message, the “-nomenu” option prevents TelServ from displaying a service 
menu, and the “-notacl” option prevents users from accessing a TACL command shell 
via this TelServ. Together, these options essentially deliver a TelServ process that 
cannot be used for doing anything on the system when it is started. Even if a user with 
a Telnet client connects to port 8423, they cannot access any resources on the system 
regardless of whether they have a user ID and password or not. 

 
2. Configure TelServ Process In SCF 

This step adds an SSGCOM service to the TelServ created in step 1. This service is 
what the ASAP Client will use to access ASAP data. Our recommendation would be to 
define this as the default service for the TelServ process. By doing so, any user who 
connects to the port will be immediately presented with an SSGCOM prompt. 

To continue the example above, the following SCF commands would add the 
SSGCOM service to the TelServ process created in step 1 above: 
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TACL 3> SCF 

1-> ASSUME PROCESS $TLSV 
2-> ADD SERVICE ssgcom, PROGRAM $system.system.ssgcom, ACCESS 

ALL, SUBTYPE DYNAMIC, TYPE CONVERSATION, DISPLAY OFF, DEFAULT ON 

There is no requirement that the service name be “SSGCOM”.  You can call the 
service whatever you’d like. Also, as mentioned above, by specifying “DEFAULT ON”, 
any user who connects to the port will be presented with an SSGCOM prompt. Since 
SSGCOM will be configured to only allow access to ASAP data, this configuration does 
not pose any security issues. However, if you would prefer to force the user to “guess” 
the correct service name, you can set DEFAULT to OFF. In this case, a user 
connecting interactively from a Telnet client will be presented with the standard 
TelServ “Enter Choice>” prompt and nothing more. At that point they’d have to enter 
“SSGCOM” to even get the SSGCOM prompt, and even then there’s nothing they can 
do in terms of compromising system security. 

 
3. Set SSG Security Parameters 

The last step on the NonStop™  system is to define SSG security settings. This is 
done by editing the $SYSTEM.SYSTEM.SSGCONF file and adding the following 
lines: 

SET SECURE DEFAULT USER 

SET SECURE TACL NONE 

SET SECURE ASAP ANY 

SET SECURE MEASCOM ANY 

SET VERIFYUSER OFF 

The various “SET SECURE” statements limit which server resources can be accessed 
by SSGCOM. Specifically, only access to ASAP and MEASCOM are permitted (the 
latter is used by the ASAP Client’s “Show Related Measurement” capability). Thus the 
SSG subsystem itself will only be able to supply ASAP data, and nothing else. 

The “SET VERIFYUSER OFF” statement configures SSGCOM to bypass its internal 
user ID/password verification step, which means that anyone is able to utilize SSG 
services as no user ID and password are required or transmitted. But since the other 
security settings have limited the SSG to only supplying ASAP data, this access does 
not pose a threat. Furthermore, in many ways this type of configuration is actually 
more secure than those requiring a logon, because not every user who needs to 
access ASAP data is required to have a valid logon to the NonStop™  server. They 
only need to be able to access the SSGCOM service across the network in order to 
obtain ASAP data; they do not need to have any logon information for the NonStop™  
itself. 
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Configuring CSG to use secure SSGCOM service 

If the NonStop™  server has been configured with an SSGCOM service as described 
in the prior section, you can configure the CSG to use the SSGCOM service to 
completely eliminate the need for userid's and/or passwords. To do this perform the 
following steps: 

1. From the CSG main window, click on View…Options from the CSG main menu to 
bring up the CSG Options dialog, and click on the “TCP/IP” tab. 

2. Supply the TCP/IP host name or address and the Telnet port number on the server 
(this is the port number specified in step 1 of “Configuring The NonStop™  Server” 
above). 

3. If you configured the SSGCOM service with DEFAULT set to ON (i.e. SSGCOM is 
the default service), then clear the “Host Service Name” field on the CSG’s TCP/IP 
tab. So the entire tab should look something like this: 
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4. If you configured the SSGCOM service with DEFAULT set to OFF (i.e. SSGCOM is 
not the default service), then set the “Host Service Name” field to “SSGCOM” (or 
whatever value you specified for the service name in step 2 of “Configuring 
NonStop™  server SSGCOM service” above). So the entire tab should look 
something like this: 
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5. Finally, you can disable all logon/security-related settings on the Session tab of the 
CSG Options dialog. These settings are no longer needed. In addition, if the PC 
you are configuring has previously been running the ASAP Client and CSG, you 
may want to click on the “Reset Security” button to clear saved ID and password 
information from the CSG. The Session tab should look something like this when 
you are done: 

 

 

 

 

You can now start the ASAP Client as you would normally. It will start a CSG/SSG 
session using the new CSG settings and new TelServ on the server. At no point will 
you be prompted for logon information because no component requires it. Startup and 
shutdown should also be a bit faster since the steps of starting TACL, logging onto 
TACL, loading macros, etc. are bypassed. 
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Configuring ASAP Entities 

Once you establish a host connection through the CSG and the ASAP Host Session is 
enabled, ASAP automatically retrieves availability and performance information 
periodically. The ASAP update interval is based on the ASAP SET RATE configured 
on the host. For example, if the host sample rate is five minutes, the ASAP Client 
refreshes itself with host information every five minutes. The actual time of the ASAP 
Client update is automatically synchronized with the host update time. 

At each sample interval, ASAP retrieves information for the entities configured in the 
ASAP Properties window. 

To change the selected entities: 

1. From the View menu in a Browse or Session window, select Options to open the 

ASAP Properties window. 

2. Select the Entity property sheet. 

3. Select the entities that you want to view. For example: 

[ ] App 

[x] Cpu 

[x] Disk 

[ ] Expand 

[ ] File 

[ ] Node 

[x] Process 

[ ] Processbusy 

[ ] RDF 

[ ] Spooler 

[ ] System 

[ ] Tape 

[ ] TMF 

Any entities you select must be enabled in your ASAP host configuration. If you 
select an entity that is not enabled, ASAP cannot receive information for that entity. 

4. At the bottom of the ASAP Properties window, click OK. 
 

Considerations 
 

For selected entities to appear in the ASAP Client, you must enable the entities in 

your ASAP Server configuration. This lets system managers on various host 

systems control which entities are enabled. 
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For example, if you select Disk in your Client configuration but your ASAP host 
configuration does not have the Disk entity enabled with an ASAP SET DISK ON 
command, the Client cannot display disk information. 

 

You do not need to select an entity to get detailed reports about it. The Entity 

property sheet controls which entities are automatically downloaded and cached in 

the ASAP hierarchical cache memory. 

For example, if you enable the CPU entity, you can still get detailed reports for 
related entities using the Show Related Apps, Show Related Disks, Show Related 
Processes, and Show Related Expand Lines popup menus. 

If you try to monitor all entities on all nodes from a single ASAP Client, you might 
significantly increase the amount of data downloaded at each sample interval, but 
not receive significantly more data. Download performance depends on the 
number of nodes and objects you monitor. Try enabling only one or two entities, 
such as CPU and Disk, to see if they provide enough information. 

If the time to download statistics is excessive, try configuring multiple ASAP Clients 
on different workstations with each Client monitoring different sets of entities or 
nodes. You can also significantly reduce the amount of data downloaded at each 
sample interval by customizing an entity’s Command definition in EDL. For more 
information, see Section 6: Entity Definition Language (EDL). 
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Section 4: Using ASAP 
Using ASAP, you can obtain real-time and historic views of your NonStop™  OS to see 
everything from generalized overviews of availability and performance for system and 
application objects to detailed customized views of specific node-entity-object-attribute 
combinations. 

ASAP also provides a consistent viewing paradigm for all application domain and 
NonStop™  OS objects: Application, CPU, Disk, Expand, File, Node, Process, 
ProcessBusy, RDF, Spooler, System, Tape, and TMF. Regardless of the entity type, 
you can use context-sensitive pop-up menus to get detailed reports about an entity by 
clicking graph and grid elements. 

You see these interface components while using ASAP: 
 

Component Description Page 

Browse 
window 

Provides a way to browse and analyze node-entity-object 
availability and performance statistics. You see both data 
grid and graph views of the specified area. The window 
updates automatically in real-time based on selected nodes, 
entities, and objects. 

46 

OSC 
window 

Provides a high-level graphical overview of object state 
changes and a detailed log of state changes. You can obtain 
both high-level and detailed state change information. 

68 

Graph 
window 

Shows information in a compact graphical form useful for 
maintaining multiple views of nodes, entities, and objects. 

You can create many Graph windows from a single Browse 
window. Graph windows are tiled automatically and update 
in real-time based on the selected node, entity, and objects. 

75 

Report 
window 

Shows detailed reports about a selected node, entity, or 
object in a Browse or Graph window. 

You can open Report windows from a Browse or Graph 
window using context-sensitive pop-up menus. 

76 

Session 
window 

Controls your Host Session. You can start and stop Host 
Sessions using the window’s menus or toolbar, and monitor 
Host Session progress through the window’s Session log. 

The Session log contains information about host 
communications and software versions. 

80 

ASAP 
Properties 
window 

Lets you customize which entities and attributes the Browse 
and Graph windows display. 

Section 5: 
Configuring 
ASAP 
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OIL tree 
view 

Provides a hierarchical view of host nodes, entities, and 
objects so that you can view the overall availability and 
performance of many nodes, entities, and objects. 

Availability and Performance icons are displayed in the OIL, 
guiding you to the nodes, entities, and objects with the 
highest alerts. 

100 

 

Browse Window 

Use the Browse window to: 
 

View system and application statistics 
 

Browse and analyze nodes, entities, and objects status and performance: 

a. Select a node-entity-object combination. 

Both the grid and the graph in the Browse window update in real-time based 
on the combinations you choose. 

b. Select an item in the graph. 

The corresponding data in the grid is automatically selected and highlighted. 
This coupling lets you work in either the graph or the grid and have both a 
graphical and a numerical view of the entity at the same time. 

 

Control the ASAP environment, using the: 

 File, Edit, View, and Help menus to control the ASAP environment. 

 Drop-down controls to select node, entity, object, and sample interval and to 
access NonStop™  OS nodes, entities, and objects. 

 Toolbar to navigate quickly through various nodes, entities, and objects. 
 

Toolbar Button Summary 
 
 

 Select information for all nodes in the Node drop-down list 

 Select the previous node in the Node drop-down list 

 Select the next node in the Node drop-down list 

 View Back (up arrow) and View Next (down arrow) 

 Display Entity Toolbar 

 Display Application entity information 

 Display CPU entity information 
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 Display Disk entity information 
 Display Expand entity information 

 Display File entity information 

 Display Process entity information 

 Display ProcessBusy entity information 
 

 Display RDF entity information 

 Display Spooler entity information 

 Display System entity information 

 Display Tape entity information 

 Display TMF entity information 
 

 Select All objects for the current node-entity 

 Select First object in the Object drop-down list 
 

 Select Last object in the Object drop-down list 

 Select Previous object in the Object drop-down list 
 

 Select Next object in the Object drop-down list 

 Set Samples count to one, then +10 until max rows/object, then back to 1 
 

 Refresh Client with Server data 

 Suppress State reporting for selected objects 
 Display Utilization Thresholds dialog box 
 Display ASAP Properties window 

 Display Download Wizard dialog box 

 Rotate 3D Graph 

 Save ASAP environment in EDL file 

 Switch between Sort and Grid view 

 Display Command Wizard dialog box 
 Display Object State Change (OSC) window 
 Disable or Enable OEM Gateway 
 Disable or Enable Object Integration Layer (OIL) 

 Display ASAP Properties window 
 Display Client-Server Session window 

 

Selecting a Node 

To change the NonStop™  OS host nodes displayed in the Browse window, use the 
Node drop-down list or the toolbar. 

The names in the Node drop-down list depend on which host nodes your ASAP host 
configuration monitors. For example, if AsapMon processes are running on the nodes 
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\Chicago, \Newyork, and \Sanfran, these node names appear in the ASAP Node drop- 
down list. 

 

To select a node using the Node drop-down list: 

1. Click the arrow in the Node drop-down list. 

2. Select the desired node from the list, or choose all items in the list by selecting the 

asterisk (*). 
 

To select a node using the toolbar: 

Click one of these buttons: 
 

Selects all nodes in the Browse window 

Selects the previous node in the Node drop-down list 

Selects the next node in the Node drop-down list 

When you monitor large NonStop™  OS networks, HPE does not recommend selecting 
the all nodes (*) option because it could demand the analysis of performance 
information for thousands of objects. Slow workstation responsiveness might indicate 
that you are trying to browse too much information. 

If your workstation does not respond in a reasonable amount of time, look at data one 
node at a time or create individual Graph windows for each node. For more 
information, see Browse Window Pop-Up Menus on page 60. 

 

Selecting a Previous View 

The Browse window retains the last two dozen view settings for the window. 

To change view settings, select items in the drop-down lists that appear along the top 
of the Browse window. Each time you select a different view, ASAP retains the node, 
entity, object, samples, and minimum state settings for that view. 

To browse backward or forward through the view history, use the Browse window 
View... Back and View... Next menu items or the View Back/Next toolbar button. 

 

To select a different view using the toolbar button: 

Click the View Back/Next button. 
 

To select the previous view, click the up arrow of the button. 
 

To select the next view in the history, click the down arrow of the button. 

 

To select a different view using the View menu: 

Select the Browse window View... menu. 
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To see the previous view, select View... Back. 
 

To see the next view in the history, select View... Next. 
 

Selecting an Entity 

Entities include classes of objects such as CPUs, Disks, Expand lines, and Processes. 
You can change the entity displayed in the Browse window using the Entity drop-down 
list or the Entity toolbar buttons. 

The Entity drop-down list contains only entities that are enabled. For example, if only 
CPU and Process entities are enabled, only these entities appear in the ASAP Entity 
drop-down list. 

 

To select an entity using the Entity drop-down list: 

1. Click the arrow in the Entity drop-down list. 

2. Select an entity from the list. 
 

To display the Entity toolbar: 

Click the Display Entity Toolbar button. 
 

To change an entity using the Entity toolbar buttons: 

Click one of these buttons: 
 

Application entity information 

CPU entity information 

Disk entity information 

Expand entity information 

File entity information 

Process entity information 

ProcessBusy entity information 

RDF entity information 

Spooler entity information 

System entity information 

Tape entity information 

TMF entity information 

Note a complete list of entities appears on the Entity Tab of the ASAP Property sheet 
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Considerations 

You can add or remove entities from the ASAP environment using the EDL language. 
For more information, see Section 6: Entity Definition Language (EDL). 

You can dynamically configure icons using the Icon Server. For more information, see 
Icon Server Control Panel on page 97. 

 
To obtain HTML Entity-Attribute Grid reports: 

1. Click the Current Entity toolbar button to generate HTML Reports for either the 
current entity or for all enabled entities. The Current Entity button is located 
immediately below the Entity drop-down and is just to the left of the "wrench" 
toolbar button. HTML Report detail is a function of whether the wrench button is 
depressed. If the wrench is depressed then all enabled entities appear in the 
toolbar and consequently all enabled entities appear in the HTML Report. If the 
wrench is not depressed then the HTML Report is only for the current entity. 

2. HTML Report column display is controlled with the Show In Grid property on the 
Attribute tab of the ASAP Property sheet. 

3. HTML Report column graphs are controlled with the Show In Graph property on 
the Attribute tab of the ASAP Property sheet. 

4. HTML Report object selection is controlled via the drop-downs that appear along 
the top of the main ASAP client window. These functions include: 
- Node drop-down selects node/nodes to be analyzed 
- Entity drop-down selects entity, note all entities if the wrench depressed 
- Object drop-down selects objects to be analyzed, note wildcards are allowed 
- Samples drop-down selects the depth of history to be analyzed 
- State drop-down selects the minimum state of objects to be analyzed 

5. ASAP HTML Reports have several useful applications including copying/pasting 
ASAP reports into documents and/or e-mailing ASAP reports to others. 

6. To COPY an ASAP HTML Report once the report is displayed in IE, select: 
- EDIT ... Select ALL... 
- EDIT ... COPY 
- Paste copied data into your document 

7. To E-mail reports via IE, select: 
- FILE... 
- SEND... 
- PAGE by e-mail 
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Selecting an Object 

To change the object or objects displayed in the Browse window, use the Object drop- 
down list. The object names in the Object drop-down list depend on which host entities 
your ASAP host configuration monitors. For example, if AsapMon processes are 
running on a node but do not have the currently selected entity enabled on the host 
node, the Object drop-down list is empty for that entity because the host systems are 
not configured to report on objects under this entity. 

 

To select an object using the Object drop-down list: 

1. Click the arrow in the Object drop-down list. 

2. Select the desired object from the list, or choose all items in the list by selecting 

the asterisk (*). 
 

To select an object using the Object toolbar buttons: 

Click one of these buttons: 
 

All objects for the current node-entity 

First object in the Object drop-down list 

Last object in the Object drop-down list 

Previous object in the Object drop-down list 

Next object in the Object drop-down list 

Selecting a Sample 

To change the amount of sample history displayed in the Browse window, use the 
Samples drop-down list. The number of samples selected in the Samples drop-down 
controls the amount of history displayed in the Browse window. For example, if you 
select Samples x 3, a history of the last three performance samples for the current 
node-entity-object combination appears. 

 

To specify a sample interval: 

1. Click the arrow in the Samples drop-down list. 

2. Select a samples value from the list, choose the asterisk (*) to specify the most 
recent sample, or click the Samples x 1 toolbar button X1 to display the most 
recent sample. Subsequent clicking of the X1 toolbar button increases Samples 
count by +10 until Max Rows/Object is reached and then the count “wraps” back to 
samples x 1. You can configure the value of Max Rows/Object on the SSG tab of 
the ASAP Properties window 

Do not select the all nodes option (*) when viewing more than one sample interval. It 
could require the analysis of performance information for thousands of objects. 
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Slow workstation responsiveness might indicate that you are trying to display too many 
samples. When your workstation does not respond in a reasonable amount of time, try 
looking at data one node at a time or creating individual Graph windows for each node. 
For more information, see Browse Window Pop-Up Menus on page 60. 

 

Selecting Minimum State 

 
Figure 4-1. Minimum State Menu 

 
 

 

 

 

VST005.vsd 

 

To control whether objects of a particular state appear in the Browse window, use 
either the State Filter Toolbar or the Minimum State drop-down menu as shown in 
figure 4–1. The state selected is the Minimum State to be displayed, and controls 
which objects appear in the Browse window. When you select a minimum state, ASAP 
displays only objects with a state equal to or greater than the state you selected. 

 
For example, if you select minimum state Warning, the Browse window displays only 
objects with a state equal to or greater than Warning. In this case, objects with a state 
less than Warning (Exists, Up, Low, Medium, or High) do not appear in the Browse 
window. 

Minimum State is useful for: 
 

Selectively limiting the display to exception data only 
 

Reducing the total number of objects displayed in the Browse window 
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To remind you that not all objects can be displayed, the Browse window status bar (at 
the bottom of the Browse window) displays the number of objects shown and found as 
a pair of numbers. For example, => 3/16 displayed in the status bar indicates the 
number of objects shown with state equal to or greater than the minimum state is 3 out 
of 16 total objects found. This reminds you that more objects might be found than 

  actually displayed when Minimum State filtering is enabled.  

Note 

You can also display the Minimum State menu by selecting States... from the View menu 
in the Browse window. Also, you can use the Minimum State drop-down as a “tear-off” 

  menu so you can keep it visible and place it where you want on the screen.  

ASAP determines the state of objects based on control settings in the Attribute Tab of 
the ASAP Properties window. An attribute has a state assigned to it if its Show in 
Graph property is enabled. To control how ASAP determines the state, select the State 
Determination algorithm. 

Status of PC-Host Session 

   -----  

The Browse window has a PC-Host Session Status display that consists of PC and 
Host icons connected by a communications link. 

 

The PC icon is a shortcut to the ASAP Properties window. To open the ASAP 
Properties window so you can change ASAP properties, click the PC icon. 

The Host icon is a shortcut to the ASAP Session window. To open the Session window 
so you can check the status of the Host Session and view the Session log, click the 
Host icon. 

 

Health Indicators 

The PC-Host Status window provides an overall indication of the health of the Client- 
Server session. The PC-Host Status window can contain these visual health indicators: 

 
The Host Icon Green with slow blink indicates that the Host Session is up and no 
errors were encountered on the last host I/O. To view the Session window and a 
summary of session status messages, click the Green icon. 

 
 

The Host Icon Gray with slow blink indicates that the Host Session has been 
manually disabled. To display the Session window and a summary of session status 
messages, click the Gray icon. 

 
The Host Icon Red X with fast blink indicates that the ASAP Host Session was 
activated but communication to the host server via the Client-Server Gateway is down. 
To view the Session error log, click the Red X icon. After reading the session log, stop 
and restart the Host Session via the CSG, then via ASAP. If this does not correct the 
problem, check your workstation for cabling errors. 

 The Host Icon Red ? with fast blink indicates that the last client/server I/O operation 

had an error. To view the Session error log, click the Red ? icon. This type of error is 
typically transient, and ASAP usually recovers automatically. Monitor the Session 
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window for a few minutes to see if ASAP recovers automatically. If it does not, stop 
and restart your Host Session. 

The communications link between the PC and host shows actual data movement 

when the ASAP Client is communicating with the ASAP Server. An explanation of the 
ASAP Client health indicators appears when you click the Communications Link icon 
between the PC and Host icons. 

 

Rotate Graph Control 
 

Use the Rotate Graph control or the Rotate Graph toolbar button to change the rotation 
and elevation angles of the graphs in the Browse window. 

 

To use the Rotate Graph control: 

1. Click the control, keeping the mouse button pressed. 

2. Drag in the direction you want to rotate the graph. 

Change the rotation of a graph by dragging the mouse to the left or right. 

Change the elevation of a graph by dragging the mouse up or down. 

To use the Rotate Graph toolbar button: 

Click the Rotate Graph toolbar button to rotate the viewing angle of the Graph in the 
Browse window slightly each time it is clicked. Click this button repeatedly to show the 
graph at a variety of angles, retracing prior viewing angles at the end of each complete 
rotation. 

To permanently save Browse window graph rotation or elevation changes, select the 
Save Rotate Angles check box on the Graph property sheet. 

Refresh With Latest Data Button 
 

Click the Refresh with Latest Data toolbar button to retrieve a fresh copy of data from 
the host. Because the ASAP Client automatically fetches data from the host whenever 
the host is scheduled to receive new data, forced refreshes typically do not result in 
any changes to the ASAP display. 
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Suppress States Toolbar Button 
 

Use the Suppress States toolbar button to suppress state reporting for selected 
objects. 

 

To select a single object, click the row associated with the object in the data grid or 

graph portion of the Browse window. 
 

To select a range of objects, click and drag the range of rows in the data grid; the 

range is highlighted. 

Once you select the objects for state suppression, click the Suppress States toolbar 
button. You can also select Suppress States from the View menu. The State 
Suppression dialog box appears. 

To add the selected objects to the Suppressed Object State List, click Add. 

To remove the selected objects from the Suppressed Object State List, click Remove. 

To remove all objects from the Suppressed Object State List, click Clear All. 

To save the Suppressed Object State List, click Save. This list is reapplied to existing 
objects when you restart the ASAP client. If you do not click Save after changing your 
Suppressed Object State List, your changes are only temporary. 

To close the State Suppression dialog box, click Close. 

To get help for the State Suppression dialog box, click Help. 
 

Thresholds Toolbar Button 
 

To display the Utilization Thresholds control panel, click the Thresholds toolbar button. 
For more information on this panel, see Utilization Thresholds Control Panel on 
page 102. 

 

Properties Toolbar Button 
 

Click the Properties toolbar button to open the ASAP Properties window. For more 
information on this window, see Section 5: Configuring ASAP. 
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Download Wizard Toolbar Button 
 

For help downloading statistics for analysis, use the Download Wizard. The Download 
Wizard lets you download data for a selected date, time, and sample interval. 

Normally, ASAP retrieves the most recent data in your host database. The Download 
Wizard lets you analyze data in the NonStop™  OS database for a different time or 
day, provided the database contains data for the specified time and date. 

 

To download data for a different date or time: 

1. Click the Download toolbar button labeled with the Camera icon. 

2. Use the ASAP Download Wizard dialog box to specify the date, time, sample 
interval, and download options. 

3. Use the Date tab to specify the date that you want to analyze. The database must 

contain data for the specified date. 

4. Use the Time tab to specify the ending time that you want to analyze. 

5. Use the Samples tab to specify the total number of samples to download. 

6. Use the Options tab to specify download options: 

 Check the Clear Data Cache check box to have ASAP clear its cache before 
performing the download. If you do not check this, download data is mixed with 
existing data in ASAP. 

 Check the Stop Automatic Updates check box to suspend automatic host 
updates while you are analyzing performance for the specified analysis 
interval. When you close the Download Wizard dialog box, ASAP asks whether 
you want to resume automatic updates. 

7. Click the Download button to start the download. The download time depends on 
the size of your NonStop™  OS network, the number of samples you specified, 
and the number of entities enabled under the Entity property sheet in the ASAP 
Properties window. 

Rotate Graph Toolbar Button 
 

Click the Rotate Graph toolbar button to rotate the viewing angle of the Graph in the 
Browse window slightly each time you click it. Repeatedly click this button to show the 
graph at a variety of angles, retracing prior viewing angles at the end of each complete 
rotation. 
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Save EDL Button 
 

Click the Save EDL toolbar button to save your current environment in an EDL file. 

When you click the Save EDL button, entity, attribute, and data statements that 
describe your environment are saved in an ASAP Custom EDL file. 

You can exchange EDL files between different copies of the ASAP Client. Thus, you 
can copy a saved EDL file to another workstation so others can see the information 
displayed in your ASAP environment. 

To view information contained in an EDL file, double-click the EDL file from Microsoft 
Explorer. For more information on EDL, see Section 6: Entity Definition Language 
(EDL). 

 

Sort View Toolbar Button 
 

Use the Sort View toolbar button to obtain sorted views of ASAP performance 
information. In Sort View, you can sort nodes, entities, objects, and their property 
attribute values by clicking a heading for that attribute column. 

Normally ASAP displays Browse window information in Grid View. You can tell which 
mode you are in because the word Grid or Sort always appears in the upper-right 
corner of the Browse window data area. In Sort View, to obtain sorted reports, click on 
column headings. In Grid View, right-click to display pop-up menus containing context- 
sensitive reports on selected objects. 

To toggle between the Sort and Grid views, click the Sort ListView toolbar button. You 
can toggle Sort View on and off by clicking on Grid or Sort in the upper-right corner of 
the Browse window. 

Use Sort View to determine which nodes, entities, and objects in your NonStop™  
server network are the most or least busy. To do so, select Sort View and the All 
Nodes toolbar buttons. You can then display the most or least used node-entity 
attributes by clicking attribute column headings. 

 

Command Wizard Toolbar Button 
 

Use the Command Wizard to obtain detailed host reports: 

1. Click the Command Wizard button labeled with the Binoculars icon. 

2. From the Command To Execute drop-down list, choose the command to execute. 

3. From the Node drop-down list, change the node. 
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4. From the Font drop-down list, specify the font. 

5. Use the Log command to display a list of recent performance monitor host log 

events for the specified node. 

6. Use the Status Monitor command to display the status of the ASAP subsystems 

on the specified node. 

7. Click the Save As toolbar button on the Command Wizard window to save the 

contents of the window to disk. 

To display help for the command wizard window, use the Help toolbar. 
 

Object State Change Toolbar Button 
 

You can use the Object State Change (OSC) window to obtain a history of object state 
changes. The OSC view provides both a high-level graphical overview of object state 
changes, as well as a detailed log of state changes. The OSC window provides two 
areas for both high-level and detailed state change information. For more information 
on this window, see OSC Window on page 68. 

 

OEM Toolbar Button 
 

Click the OEM toolbar button to enable or disable ASAP access to the Open Enterprise 
Management (OEM) gateway. This is a two-state button. When the button is clicked, 
ASAP access to the OEM is enabled. When the button is not clicked, ASAP access to 
the OEM is disabled. 

The OEM and OIL buttons are mutually exclusive. When one is enabled, the other is 
disabled. Therefore, when the OEM is enabled, the OEM adapter interface can use the 
OIL. 

To specify additional options that control how ASAP accesses the OEM, use the OEM 
property sheet in the ASAP Properties window. 

OIL Toolbar Button 
 

Click the OIL toolbar button to enable or disable ASAP access to the Object Integration 
Layer (OIL). When the button is clicked, ASAP access to OIL is enabled. When the 
button is not clicked, ASAP access to OIL is disabled. 

The OIL and OEM buttons are mutually exclusive. When one is enabled, the other is 
disabled. When the OIL is enabled, the OEM does not mix objects from other clients 
with the OIL via the OEM adapter interface. 
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To specify additional options that control how ASAP accesses the OIL, use the OIL 
property sheet in the ASAP Properties window. 

 

Selecting Grid Rows and Columns 

You can select grid rows, columns, or cells in a Browse window. You can graph or 
copy selected cells to the clipboard using context-sensitive pop-up menus. 

 

To select a grid row, click the first element of the row; the entire row is highlighted. 
 

To select a grid column, click the heading of the column; the entire column is 

highlighted. 
 

To select a grid cell, click the cell of interest; the cell is outlined. 
 

To select a range of cells, click and drag the range of cells, rows, or columns; the 

range is highlighted. 

Sizing Grid Rows and Columns 

You can manually resize grid rows or columns in the Browse window. 
 

To resize a grid column: 

1. Move the cursor over the column heading dividing line that you want to resize. 

2. Click and drag the line until the column is the preferred width. 
 

To resize a grid row: 

1. Move the cursor over the row label dividing line that you want to resize. 

2. Click and drag the line until the row is the preferred height. 
 

Sizing Grid Height 

You can resize the height of the entire grid portion of the Browse window. 
 

To resize the grid height: 

1. Move the cursor over the area between the grid and graph portions of the Browse 
window. The cursor changes to a resize up and down cursor. 

2. Click and drag until the height of the grid is the preferred size. 
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Sizing Sort View Columns 

Sort View column widths are automatically sized. To change the column sizing 
algorithm: 

1. Select Sort View by selecting the View… Sort-Grid View menu item in the Browse 
window. 

2. Move the mouse cursor over the area above the column headings and single-click. 

3. A popup menu appears with these options: 
 

Size Columns To Contents + Headings–width is max of heading + contents 
 

Size Columns To Contents Only– sizes width to text width of contents only 
 

Size Columns To Window–stretches/shrinks columns to fit within window 
 

Size Columns To Default–sizes column width based on best fit algorithm 
 

Browse Window Pop-Up Menus 

You can display context-sensitive pop-up menus in the Browse window graph and grid 
areas. 

 

To open a context-sensitive pop-up menu in a Browse window: 

1. Right-click a grid row, column, or cell. 

2. Left-click a function from the menu to select it. 
 

To open a context-sensitive pop-up menu for a Browse window graph 
element: 

1. Click a graph element. 

2. Click the graph element label. 

3. Choose the function from the pop-up menu. 
 

Browse window pop-up menus include these common functions: 
 
 

Show Object 
Details 

Displays a graph and a list of object details, or opens a report 
window with detail information. The EDL Entity statement Detail 
property controls the behavior of this menu item. For more 
information, see Detail - EDL Entity Property on page 136. 
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Show Object 
History 

Displays the recent history of object performance. The EDL Entity 
statement History property controls the behavior of this menu item. 
For more information, see History - EDL Entity Property on page 
138. 

Graph Object 
History 

Graphs recent history of selected object 

Show Related 
Apps 

Shows applications related to the selected object 

Show Related 
Disks 

Shows disks related to the selected object 

Show Related 
Processes 

Shows processes related to the selected object 

Show Related 
Expand Lines 

Shows Expand lines related to the selected object 

Show Related 
Measurement 

Starts a measurement and provides in-depth reports about the 
busiest files and processes associated with the selected object. For 
example, if you select a disk volume, and then select Show Related 
Measurement, a report will appear showing the busiest files and 
processes associated with the selected disk. 

Show Related 
Objectives 

Shows objectives for selected application domain. This menu 
cascades to allow display of either objectives from the ASAP 
Objectives Database, or from the ASAP Statistics Gathering 
Processes. 

Refresh Refreshes the current Browse window 

Properties Opens the ASAP Properties window 
 

Grid pop-up menus also include these menu items: 
 
 

Copy Copies selected grid cells to the clipboard 

New Graph Creates a new Graph window for selected rows 

Graph 
Row/Column 

Graphs the selected grid row or column in the graph area of the 
Browse window 

States Displays a legend showing ASAP state icons and their meanings 

Suppress States Suppresses state reporting for selected objects 

Browse Window Pull-Down Menus 

The Browse window includes various pull-down menu functions. 

You can use pull-down menus to: 

Create new instances of the Browse windows 
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Save grid data to a file in comma-separated-values format 
 

Copy grid data to the clipboard 
 

Clear the history for a particular object 
 

View the Host Session window 
 

Open the ASAP Properties window 
 

Create new instances of graphs for each node 
 

Arrange and tile Graph windows 
 

Minimize and restore Graph windows 
 

Open Help 
 

File Menu Items 
 

Menu Items Description 

New Creates a new instance of a Browse window. The new Browse window is 
created with node, entity, and object settings that match the current 
window. Once the new window is created, you can change node, entity, 
and object settings, and the new window provides an independent view 
that updates automatically in real time. 

Export EDL Exports the entity, attribute, and data settings for your current ASAP 
environment. 

A dialog box prompts you for the environment properties you want to 
export. When you click OK, ASAP generates EDL source for your current 
environment and displays that source in the EDL ADE window. You can 
then save the EDL so you or another person on another workstation can 
use it later. For more information, see Section 6: Entity Definition 
Language (EDL). 

Compile Server 
EDL 

Downloads and compiles server EDL files. 

When you select Compile Server EDL, a dialog box prompts you to 
download and compile various EDL files from your server. This menu item 
is enabled by default unless the Enable FILE… Compile Server EDL… 
menu item check box on the EDL Properties window is not checked. To 
download and compile EDL from the server: 

1. Select File… Compile Server EDL… from the ASAP Browse window 

2. Select the file to download, and click the Download button to initiate 
download and compile files such as the ASAPnSYS, ASAPnAPP, and 
ASAPUSER EDLs. If your primary interest is to download only USER 
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 entity definitions, you can select the file ASAPUSER in the dialog box, and 
then only user-defined EDL files will be downloaded. The EDL file name 
input field in the EDL download dialog box is a drop-down list of file 
names. 

Import EDL Imports additional entity and attribute settings from an EDL file. 

When you select this menu item, the EDL ADE source window appears. 
You then use this window to browse various EDL files. For more 
information, see Section 6: Entity Definition Language (EDL). 

Save EDL and 
Save EDL As 

Saves entity, attribute, and data settings for the current ASAP 
environment. 

You can exchange EDL files between different copies of the ASAP Client. 
Thus, you can copy a saved EDL file to another workstation so others can 
see the information displayed in your ASAP environment. 

To view information contained in an EDL file, double-click the EDL file 
from Microsoft Explorer. For more information on EDL, see Section 6: 
Entity Definition Language (EDL). 

Save Data and 
Save Data As 

Select Save Data or Save Data As to save all of the grid data or list view 
for the current window to a disk file in a comma-separated-values (CSV) 
file format. 

Once the file is saved, the contents of the file are displayed in a text 
viewer such as Note Pad. 

If you want to remove the comma delimiters, select Search… Replace… 
enter comma, and click Replace. All CSV delimiters will be removed. CSV 
format is suitable for analysis with Microsoft Excel. The Save HTML menu 
item can also be used with Excel. 

Save HTML or 
Save HTML As 

 
Save HTML as 
Entity Icon- 
Graph 

 
Save HTML as 
Multi-Entity 
Icon-Graph 

Select Save HTML or Save HTML As to save just the grid or list view data 

for the current window to a disk file in HTML file format. 
 

Select Save HTML as Entity Icon-Graph, or Save HTML as Multi-Entity 
Icon-Graph to save the data, icons, and graphs to a disk file in HTML 
format. To control report format, see Notify control panel Notify Content. 

Once the file is saved, the contents of the file are displayed in your 
Internet browser. To copy plain text HTML to the clipboard, select Edit... 
Copy HTML. 

To e-mail saved HTML using your browser, select Send … Page by e- 
mail. 

Print Prints the Browse window. 

Exit Leaves the current Browse window. If the current Browse window is the 
last one, a dialog box asks whether you want to shut down ASAP. To shut 
down ASAP, click OK. To continue using ASAP and leave the view 
unchanged, click Cancel. 
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Edit Menu Items 
 

Menu 
Items 

Description 

Copy Copies selected grid rows, columns, or cells to the clipboard. Copy 
delimits data columns with commas. You can then paste clipboard 
information into a text window. 

From the File menu, select Save Data to save all of the information in the 
grid to a disk file. 

Copy HTML Select Copy to copy selected grid rows, columns, or cells to the clipboard 
in HTML text format. Copy HTML delimits data with color-coded state 
information. Data is also formatted in HTML table format. Clipboard 
information can then be pasted into a window. This function deliberately 
does not declare the text as HTML. See Save HTML and Save HTML As... 
for WYSIWYG treatment of HTML. 

Select Save Data from the File menu to save all of the information in the 
grid to a disk file and display it in an internet browser. (You can have 
ASAP data automatically update web pages. For more information, see 
Notify control panel File property. 

Copy 
Special 

Copies data from selected grid rows, columns, or cells to the clipboard. 
Copy Special delimits data columns with tab characters. 

You can paste Copy Special clipboard information into a Microsoft Excel 
spreadsheet. 

Select All Selects all data grid rows and columns. To copy selected cells to the 
clipboard, select Copy or Copy Special from the Edit menu. 

You can also select Save Data or Save Data As from the File menu to 
save all of the information in the grid to a disk file. 

Clear 
Object 
History 

Clears the history in the ASAP data cache for the selected object. 
Selecting this item clears the history only for the selected object. The most 
recent data sample is retained. 

Use this option when you want to clear a series of backfilled graphs that 
you generated using the Graph Related function in the Object State 
Change view. 

Clear Data Clears all ASAP data. When you select this menu item, a dialog box asks 
if you are sure you want to clear all ASAP data. To clear all data, click OK. 
To continue using ASAP and leave the view unchanged, click Cancel. 

Use this command to clear ASAP data prior to downloading data for a 
different time of day. For more information on how to download data, see 
Download Wizard Toolbar Button on page 56. 



 
Page 65 of 161 HPE NonStop ASAP Client Manual                     

 
Test Data Generates a set of random test data for the ASAP Client. When you select 

this menu item, a dialog box asks if you are sure you want to clear all 
ASAP data and generate a set of pseudo-data. To clear all data and 
generate a set of pseudo-data, click OK. To continue using ASAP leaving 
the view unchanged, click Cancel. Test data is defined by the EDL DATA 
statement. For more information, see EDL - DATA Statement on page 
154. 

 

View Menu Items 
 

Menu 
Items 

Description 

Session Opens the ASAP Host Session window. 

Graph 
Nodes 

Creates a new Graph window for each host node monitored. Each Graph 
window then updates in real time as data is received from your host 
system. 

Use this menu item to view the overall performance of your network. If you 
monitor a small number of nodes, you can repeatedly select an entity and 
then select Graph Nodes to obtain a mixed set of Graphs on different 
entities. You can also create a node graph manually for selected nodes in 
your network by using the New Graph menu item in menus for the grid 
portion of the Browse window. 

Dashboard Select Dashboard from the View menu in the Browse window to save or 
display a user-defined dashboard consisting of one or more graphics 
representing various aspects of your system. This menu item allows you 
to name, save, and display graphic dashboards consisting of a variety of 
graphic types representing various nodes, entity, and object information. 
Dashboard allows you to name and save Application, CPU, Disk, Expand, 
File, Process, ProcessBusy, RDF, Spooler, Tape, TMF, and related 
graphics. You can name, save, and redisplay dashboards whenever you 
want to graphically review particular areas of your system. As you define 
more dashboards, this cascading menu grows dynamically, retaining each 
of your named dashboards. 

You can create and add new graphs to the dashboard in a variety of ways. 
One sequence follows: 

1. Compose the view you want to create in the Browse window 
using the Node, Entity, Object, Samples, and MinState menus. 

2. Optionally use Graph Object History to define the amount of 
history desired. For example, if you want history on CPU 0, right- 
click CPU 0 in the grid portion of the browse window and then 
select Graph Object History from the menu. 

3. Double-click the NodeName column heading in the grid area of 
browse window to create a new graph window. 

4. Repeat Steps 1 through 3 for each element you want to add to 
the dashboard. 
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 Dashboard graphic properties are all saved whenever you select Save 
Dashboard As… or when the client is shutdown. Properties saved include 
Node, Entity, Object, Samples, and MinState, as well as each window 
location, size, and Graph Type. When the client is started, all graphic 
elements and associated properties are restored and become active once 
again. 

Graph Type is a new cascade menu item on Dashboard graphic windows. 
To select Graph Type, right mouse an existing dashboard graph and then 
select Graph Type to display a list of different graph types. Selecting one 
of these graph types changes the display accordingly. Graph type is then 
retained along with all other dashboard node, entity, and object properties. 
Different dashboard graphs can have different graph types. 

Tile Graph 
Windows 

Automatically tiles the region to the right of the Browse window with the 
existing Graph windows. 

The Tile Graph Windows function automatically resizes the Graph 
windows to fit equally into the area to the right of the Browse window. The 
Arrange Graph Windows function arranges Graph windows based on the 
size of the last Graph window that you resized. 

By comparison, the Arrange Graph Windows function resizes Graph 
windows based on the size of the last Graph window that you resized. 

Delete 
Graph 
Windows 

Deletes all Graph windows. 

Arrange 
Graph 
Windows 

Arranges all existing Graph windows so they appear to the right of the 
Browse window. Arrangement is based on the size of the last Graph 
window that you resized. To control the appearance of the Graph 
windows, repeatedly resize a Graph window and then select Arrange 
Graph Windows. 

By comparison, the Tile Graph Windows function resizes the Graph 
windows to fit equally into the area to the right of the Browse window. 

Minimize 
Graphs 

Minimizes all Graph windows. 

Restore 
Graphs 

Select Restore Graphs to restore all Graph windows that you minimized. 

Tile Grid 
Windows 

Tiles the screen with Browse windows. This function is enabled only when 
more than one Browse window exists. If the OIL tree view currently 
appears, the area to the right of the OIL is tiled with Browse windows. 

Tile Report 
Windows 

Automatically tiles the region to the right of the Browse window with the 
current Report windows. This function is enabled only when more than 
one Report window exists. 

Delete 

Report 
Windows 

Deletes all Report windows. 



 
Page 67 of 161 HPE NonStop ASAP Client Manual                     

 
Download 
Wizard 

Downloads statistics for analysis. The Download Wizard lets you 
download data for a selected date, time, and sample interval. 

Normally, ASAP retrieves the most recent data in your host database. The 
Download Wizard lets you analyze data in the database for a different time 
or day, provided the database contains data for the specified date and 
time. 

Command 
Wizard 

Displays the Command Wizard window. Use the Command Wizard to 
display host logs and subsystem status. 

Sort-Grid 
View 

Toggles the viewing mode displayed in the data area of the Browse 
window. In Sort View, you can sort nodes, entities, objects, and their 
property attribute values by clicking a heading for that attribute column. In 
Grid View, you can click a graph element to display a menu for generating 
context-sensitive reports on the selected object. 

Thresholds Displays the Utilization Thresholds control panel. 

States Displays the Minimum State menu for the Browse window. The state you 
select in the Minimum State menu determines which objects appear in the 
Browse window. When you select a minimum state, the only objects 
displayed have a state equal to or greater than the state you selected in 
the Minimum State menu. 

State 
Changes 

Displays the Object State Change window. You can also access this 
function via the State Change toolbar button. For more information on the 
OSC view, see OSC Window on page 68. 

Suppress 
States 

Suppresses state reporting for the selected objects. To select a single 
object, click any cell in the row associated with the object. To select a 
range of objects, click and drag a range of rows; the range is highlighted. 

Once you select the objects for state suppression, click the Suppress 
States toolbar button. You can also select Suppress States from the 
View menu. The State Suppression dialog box appears. 

To add Selected Objects to the Suppressed Object State List, click Add. 

To remove Selected Objects from the Suppressed Object State List, click 
Remove. 

To remove all objects from the Suppressed Object State List, click Clear 
All. 

To save the Suppressed Object State List, click Save. This list is reapplied 
to existing objects when the ASAP client is started. If you do not click 
Save after changing your Suppressed Object State List, your changes are 
only temporary. 

To close the State Suppression dialog box, click Close. 

To get help for the State Suppression dialog box, click Help. 

Back << Browses backward through the view history. 

The Browse window retains the last two dozen view settings. You change 
these settings by selecting items in the drop-down lists along the top of the 
Browse window. Each time you select a different view, ASAP retains the 
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 node, entity, object, samples, and minimum state settings for that view. 

This menu item serves the same purpose as the up arrow on the View 
Back/Next toolbar button. 

Next >> Browses forward through the view history. 

The Browse window retains the last two dozen view settings. You change 
these settings by selecting items in the drop-down lists along the top of the 
Browse window. Each time you select a different view, ASAP retains the 
node, entity, object, samples, and minimum state settings for that view. 

This menu item serves the same purpose as the down arrow on the View 
Back/Next toolbar button. 

Refresh Updates the Browse window grid and graph. 

Options Opens the ASAP Properties window. 
 

Help Menu Items 
 

Menu 
Items 

Description 

Contents Displays the Help Contents for the ASAP product. 

Read Me Displays the ReadMe softdoc for the ASAP product. 

Architecture Displays an architectural overview discussion of the ASAP products. 

Change 
History 

Displays a summary of internal changes made to ASAP. 

About Displays product release version and copyright information about ASAP. 

OSC Window 

You can use the Object State Change (OSC) window to obtain a history of object state 
changes. The OSC view provides both a high-level graphical overview of object state 
changes and a detailed log of state changes. The OSC window consists of two areas, 
so you can obtain both high-level and detailed state change information. 

The upper portion of the OSC window provides a scoreboard with an annotated matrix 
of the number and type of state changes that have occurred. 

Each row of the scoreboard represents the different entity types monitored; for 
example CPU, Disk, and Expand entities. 

Each column of the scoreboard represents different possible object states; for example 
Up, Down, and Warning states. 

Selecting a cell in the scoreboard causes an analysis of the OSC log in the lower part 
of the window. All object state changes that match the selected entity and state are 
selected. For example, clicking the cell for the Disk row, and the Down column selects 
all Down Disk items in the OSC log. 
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OSC Window Toolbar Button Summary 
 

 Find all items in change log related to the currently selected object 

 Graph all items in change log related to the currently selected object 
 Graph the most recently selected item in the log 

 Acknowledge selected items in log 
 Remove selected items from log 

 Tile or dock window with Browse window 
 Copy scoreboard and log information to clipboard 

 Magnify or shrink scoreboard 
 

 Display or hide date in state change log 

 Show or hide scoreboard 

 Show or hide statistics tips 
 

 Show or hide current object state counts 
 

 Show State thresholds dialog box 
 

Show ASAP properties window 

 Refresh OSC window 

OSC Window Functions 

The Object State Change window provides functions that allow you to analyze object 
state changes. The upper part of the window provides a summary of state changes, 
and the lower part of the window provides a detailed log of each object state change. 
The OSC tab of the ASAP Properties window lets you configure which states are 
monitored in the OSC view, and which states generate audible alerts. 

You can analyze state changes using functions provided by the OSC window. You can 
access the functions in any of these ways: 

 

Choose View... menu-item. 
 

Right-click various objects in the OSC window. 
 

Click a Toolbar button. 

To analyze state changes, select any of these functions: 
 

OSC Find Related 
 

Use the Find Related function to find all items in the change log related to the currently 
selected object. 
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When you select a log item in the OSC change log and select Find Related, ASAP 
finds all state change instances in the OSC log for the object you selected. Each of 
these state changes is then also selected. You can then examine all state changes 
related to a given object and perform other operations on these items such as 
Acknowledge or Remove. 

OSC Graph Related 
 

Use the Graph Related function to analyze state changes related to the currently 
selected object. 

When you select a log item in the OSC change log and select Graph Related, ASAP 
finds all state changes in the OSC log for the object you selected. Each of these state 
changes is selected in the OSC log, and these selected items are analyzed and 
graphed in the ASAP Browse window. 

The Graph Related function lets you examine all state changes related to a given 
object, then perform subsequent operations on these selected log items such as 
Acknowledge or Remove. 

You can use the Graph Related function to automatically perform all necessary 
analysis and client server I/O to locate all details related to the history of an object's 
state changes. For example, sometimes information for an object state change might 
be in the ASAP Client cache, and sometimes it is no longer in cache. In either case, 
ASAP retrieves the information and displays it in the ASAP browse window. If the 
object's statistics are no longer in cache, the graph backfills with information as 
additional queries complete the picture of the object's state change history. 

 

OSC Graph Selected 
 

 

Use the Graph Selected function to obtain a detailed graphical history of selected log 
items in the state change log. 

You can manually select a series of log items. For example, if these ProcessBusy log 
entries exist in the state change log: 

 

11:00 \Chicago\ProcessBusy\0 Low > High Busy 85.5% 

11:10 \Chicago\ProcessBusy\0 Low > High Busy 87.8% 

11:20 \Chicago\ProcessBusy\0 Low > High Busy 81.2% 

11:30 \Chicago\ProcessBusy\0 Low > High Busy 89.3% 

11:40 \Chicago\ProcessBusy\0 Low > High Busy 89.3% 

11:50 \Chicago\ProcessBusy\0 Low > High Busy 89.3% 
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To manually select multiple log items, for example the first three above at 11:00, 11:10, 
and 11:20, control-click them. To control-click multiple items in the log, hold down the 
control key while you click the log items you want to add to the selection list. To graph 
these items, select the Graph Selected menu item or toolbar button. 

If you select multiple log items and use the Graph Selected function, the selected items 
should all be log items for the same object. Otherwise, confusing nonorthogonal 
graphical information is generated. To avoid confusion if you accidentally select 
multiple items for different objects, the Graph Selected function automatically graphs 
selected log items for the last selected object in the log. 

You can also use the Graph Selected function for a single log item by double-clicking 
the item in the OSC log. This is useful when you want to quickly obtain statistics 
information for a single log item that appears in the OSC log. 

 

OSC Ack Selected 
 

Use the Ack Selected function to acknowledge items you have selected in the log. 

When you select one or more items on the OSC log and select Ack Selected, each 
selected log item is marked as having been acknowledged. Acknowledged items are 
marked so that when you leave your workstation and return, you can tell which items 
are new in the OSC view. 

You can also mark positions of interest in the log without acknowledging log items. For 
example, if you select the last log entry in the log, when you return to your workstation, 
you can see which log items were added to the log while you were away. Even when 
new items are added to the log, ASAP remembers which log items you selected. 

OSC Remove Selected 
 

Use the Remove Selected function to remove items you have selected from the log. 

When you select one or more items on the OSC log and select Remove Selected, 
each selected log item is permanently removed from the OSC log. Removed items no 
longer appear in the OSC log, or in the scoreboard portion of the OSC window. 
Removing log items let you perform housekeeping on state changes that are no longer 
relevant. OSC removal lets you leave your workstation and focus only on new items 
that appear in the OSC view when you return. 

OSC Tile 
 

Use the Tile OSC function to tile or dock the OSC window with Browse window. This is 
useful for placing the Browse and OSC windows in a side-by-side arrangement. 
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OSC Copy 
 

Use the Copy OSC function to copy scoreboard and log information to clipboard. This 
function is useful when you want to include information from the OSC view in a 
Microsoft Word document or Excel spreadsheet. Copied information is delimited with 
tabs and carriage-return line-feeds so that you can paste it into an Excel spreadsheet. 

 

OSC Magnify 
 

Use the Magnify OSC function to magnify or shrink OSC window contents. This 
function is useful when you want information displayed with larger or smaller fonts and 
icons. 

 

OSC Show Date 
 

Use the Date function to display or hide the date in the object state change log. When 
you initially start ASAP, date information in the OSC log is redundant. However, after 
several days, depending on how you use the OSC view, you might want to display 
both the date and time of state changes. 

OSC Show Score Board 
 

Use the Show Scoreboard function to display or hide the scoreboard in the OSC 
window. 

This view helps you track the number of state changes that occur over long periods of 
time. You can clear selected state change counts for selected object types and states 
by using the Remove Selected, Remove Above, or Remove All functions. 

When the scoreboard is enabled, an annotated matrix summarizes the number of state 
changes that have occurred for each entity type and state. If Show Tips is enabled, 
color-coded hypertext appears as you move your mouse over various regions of the 
scoreboard. 

The scoreboard contains a row for each type of entity monitored and a column for each 
state monitored. The minimum state monitored in the OSC scoreboard is controlled by 
the Minimum State Change Monitored option on the OSC tab of the ASAP Properties 
window. The Entity Tab of the ASAP Properties window controls entities that appear in 
the OSC scoreboard. 

When you select an element in the scoreboard, the OSC log is searched for all Object 
State Changes that match the selected Entity type and state. For example, if you click 
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the cell that intersects the Disk row and the Down column, ASAP automatically selects 
all Down object state changes that have occurred on all disk drives. 

To select all state changes for a given entity, click the entity icon in the first column of 
the scoreboard. For example, if you click the CPU icon, all state changes for the CPU 
entity are selected. You can then use the Ack and Remove functions on the selected 
items. 

To select all items in the OSC log for a given type of state change, click the state- 
heading name in the scoreboard. For example, if you click the heading labeled Down, 
all log items are selected that represent down state changes. 

OSC Show Tips 
 

Use the Show Tips function to show or hide tips that appear as you move your mouse 
over elements of the scoreboard and state change log. 

As you move your mouse over elements in the scoreboard, color-coded statistical tips 
appear describing both the number of state changes, and the total number of objects in 
a given state. 

As you move your mouse over state change entries in the log, ASAP continuously 
searches for other items in the log that match the object under the mouse. If more 
items are in the log for the object under the mouse, a tip appears indicating the number 
of times that object appears in the log. For example, if "17 x" appears as you move 
your mouse over a log item, there are 17 items in the log for that object. You can use 
this feature to quickly determine which objects occur frequently in the log. Another way 
to do this is by sorting items in the log. You can sort items in the log by clicking log 
headings. For example, to sort by object name, click the heading labeled Domain 
Name. 

 

OSC Show State Counts 
 

 

Use the Show State Counts function to display or hide current object state counts in 
the state change scoreboard. 

Normally, only state change counts appear in the scoreboard. However, when Show 
State Counts is enabled, the number of objects currently in each state also appears in 
parentheses to the right of the number of state changes. If no state changes have 
occurred, only the current object state count appears in parentheses. 

For example, if (3) appears in the CPU Down cell of the scoreboard, no CPU state 
changes occurred since you started your monitoring session. But the (3) indicates that 
three CPUs are currently down. The implication is that these CPUs were already down 
when you started monitoring, so these are less likely to be of interest. Cells that have 
no state changes are not annotated with state icons. Typically you are less interested 
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in entity-state cells that do not represent state changes. As a result, only cells that 
represent state changes are annotated with colored state icons. 

When Show State Counts is enabled, and you click a cell in the scoreboard, the ASAP 
Browse window displays all objects that have a state greater than or equal to the 
selected state and entity. If you click a row icon in the scoreboard, all objects for that 
entity type appear regardless of their state. 

If "3 (1)" appears in the CPU Down cell in the scoreboard, three CPU Down state 
changes occurred since you started your monitoring session, and one (1) CPU is 
currently down. Because three state changes occurred, the same CPU might have 
gone down multiple times, or three separate CPUs might have gone down. In either 
case, multiple CPU reloads were performed. Clicking the CPU Down cell automatically 
selects and displays all CPU Down log entries so you can determine which sequence 
occurred. Also, when Show State Counts is enabled and you click the CPU Down cell, 
the current down CPU is also displayed in the Browse window. 

When Show State Counts is enabled and you click a cell in the scoreboard: 
 

All objects that have a state greater than or equal to the state you clicked appear in 

the Browse window 
 

All log entries for the entity-state combination you clicked are automatically 

selected 

When Show State Counts is not enabled and you click a cell in the scoreboard, only 
log entries are selected. 

OSC Thresholds 
 

Use the Thresholds function to display the Utilization Thresholds control panel. 
 

OSC Properties 
 

Use the Properties function to open the ASAP Properties window. 
 

OSC Refresh 
 

 

Use the Refresh function to refresh the scoreboard and log in the OSC window. 
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Graph Window 

A Graph window provides a compact graphical performance view that is useful for 
maintaining multiple status-orientated views of various node-entity-object 
combinations. Each Graph window contains only one graph and can be made small 
enough to maintain numerous views at once. 

Graph windows update in real-time. Many Graph windows can be created from a 
Browse window, and can be automatically tiled or arranged. 

 

To create a Graph window: 
 

From the View menu of the main Browse window, choose Graph Nodes, or 
 

In the main Browse window, double-click the Grid NodeName column heading, or 
 

In the main Browse window, select a range of grid rows, right-click on the selected 

row or rows to open the pop-up menu, then choose New Graph. 

Graph Window Status Messages 

The Status bar at the base of a Graph window shows the date, time, and number of 
samples displayed in the Graph window. Graph windows update in real time, so this 
information helps you determine the timeliness of the data in the graph. When multiple 
samples are displayed in the Graph window, status messages end with an x N 
notation, where N indicates the number of samples. 

Graph Window Rotate Control 

The Graph window includes a Rotate Graph Control to change the rotation and 
elevation angles of a graph for optimal viewing. 

 

To use the Rotate Graph control: 

1. Click the control, and hold down the mouse button. 

2. Drag in the direction you want to rotate the graph. 

Change the rotation of the graph by dragging the mouse to the left or right. 

Change the elevation of a graph by dragging the mouse up or down. 



 
Page 76 of 161 HPE NonStop ASAP Client Manual                     

Graph Window Pop-Up Menus 
 

Function Description 

Show Object Details Displays a graph and a list view of object details or opens a 
report window with detail information 

Show Object History Displays the recent history of object performance 

Graph Object History Displays recent object history of selected object 

Show Related Apps Shows applications related to the selected object 

Show Related Disks Shows disks related to the selected object 

Show Related Processes Shows processes related to the selected object 

Show Related Expand 
Lines 

Shows Expand lines related to the selected object 

Refresh Refreshes the current Browse window 

Properties Opens the ASAP Properties window 

Graph Type Displays a list of graph types such as 2D-Bar, 3D-Bar, 
Surface, Tape and so on. 

To open a context-sensitive pop-up menu in a Graph window: 

1. Click a graph element. 

2. Click the graph element label. 

3. Choose the function in the pop-up menu. 

Report Window 

You can get detailed reports about selected nodes, entities, and objects in Browse or 
Graph windows through pop-up menus. 

 

To view context-sensitive reports for grid elements: 

1. Select the graph element by clicking the mouse. 

2. Right-click the highlighted text to display the pop-up menu. 

3. Select the report type. 
 

To view context-sensitive reports for graph elements: 

1. Select the element. 

2. Click the label to display the pop-up menu. 

3. Select the report type. 
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To copy and paste report window contents: 

1. Select either no text to imply all text, or select only the desired text. 

2. Select either the Copy menu item from the popup menu to copy all text. 

3. Select the Copy Special menu item to copy text without headings and carriage 

returns. 

This subsection describes the available reports. 

Report windows contain reports that are either static or updated automatically over 
time. For more information, see Reports Auto Refresh Check Box on page 93. 

Show Object Details 

To display all performance properties and values for the selected object, or to open a 
detail report window for the selected object, select Show Object Details. The Report 
window displays a graph of the user-defined graph attributes. Below the graph is a 
scrollable list view of all ASAP performance properties for that object and their values. 
The EDL Entity statement Detail property controls the behavior of this menu item. 

If the EDL DETAIL option is not used, the detail report window displays a graph of the 
user-defined graph attributes. Below the graph is a scrollable list view of all ASAP 
performance properties for that object and their values. If the EDL DETAIL option is 
used, the report window displays the object with detail information. For more 
information, see Detail - EDL Entity Property on page 136. 

 

Show Object History 

To display a detailed recent history report for the selected object, select Show Object 
History. This report is generated by posting a query to your host system, then 
displaying the response in a scrollable history view of information for the selected 
object. When the entity type is a Process, the report is a Busiest Process History report 
for the selected CPU. The EDL Entity statement History property controls the behavior 
of this menu item. For more information, see History - EDL Entity Property on page 
138. 

 

Graph Object History 

To display a graph of recent history for the selected object, select Graph Object 
History. This graph is generated by making the view in the Browse window match the 
object name of the selected object, then posting a query to your host system for more 
history about that object. When the query completes, the query response is 
automatically displayed in that Browse window. 

This function lets you extend the history information for any object that appears in the 
Browse window. Select the object, then select Graph Object History in the popup 
menu. ASAP automatically back fills the object history in the Browse window. 
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Show Related Apps 

To display a report of applications related to the selected object, select Show Related 
Apps. When this report is generated, a query is first posted to your host system, and 
then the response appears in a scrollable view of application statistics information 
related to the selected object. 

If the selected object is a CPU or a Process, the report shows the application 
processes running in that CPU. If the selected object is not a CPU or a Process, the 
report covers all applications on the specified system. 

Show Related Disks 

To display a report of disk volumes related to the selected object, select Show Related 
Disks. When this report is generated, a query is first posted to your host system, and 
then the response appears in a scrollable view of disk volume performance information 
related to the selected object. 

If the selected object is a CPU or a Process, the report shows the disk processes 
running in that CPU and a detailed listing of related performance statistics. If the 
selected object is not a CPU or a Process, the report covers all disks on the specified 
system. 

Show Related Processes 

Select Show Related Processes to display a report of processes related to the 
selected object. When this report is generated, a query is first posted to your host 
system, and then the response appears in a scrollable view of busiest process 
performance information related to the selected object. 

If the selected object is a CPU or a Process, the report shows the busiest processes 
running in that object's CPU. If the selected object is not a CPU or a Process, the 
report is a Busiest Process report for all CPUs on the specified system. 

Show Related Expand Lines 

To display a report of Expand lines related to the selected object, select Show Related 
Expand Lines. When this report is generated, a query is first posted to your host 
system, and then the response appears in a scrollable view of Expand performance 
information related to the selected object. 

For example, if the selected object is a CPU or a Process, the report contains a report 
on the Expand line handlers running in that CPU. If the selected object is not a CPU or 
a Process, the report is an Expand Line statistics report for all Expand lines on the 
specified system. 
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Show Related Measurement 

Select Show Related Measurement to configure and display detailed measurement on 
demand reports. 

When you select an object in a grid or graph and then select Show Related 
Measurement, an ASAP Measurement control panel is displayed with the options 
shown below. This allows a detailed measurement to be configured and started. Upon 
completion, it provides a series of in-depth reports that are automatically displayed in a 
report window. An explanation of the Show Related Measurement control panel 
options follows: 

Node dropdown controls the Node name to be analyzed. 

Entity dropdown controls the Entity to be analyzed. 

Object dropdown controls the Object to be analyzed. The initial node, entity, object 

values are for the object you initially selected. 

TopN dropdown controls the number of busiest components displayed for the selected 
object. For example, if you select a value of 10 for the TopN dropdown and the object 
is a disk, the 10 busiest files on that volume and the 10 busiest processes for that 
volume are displayed in sorted order from most busy to least busy. 

Seconds dropdown controls the measurement interval in seconds. If you are 
comparing data to ASAP you should use the same sample interval as ASAP, which is 
the default. Otherwise you can pick a shorter or longer interval. (You are limited to one 
measurement at a time to protect use of system resources). 

Sync checkbox synchronizes the measurement to start-stop in sync with the ASAP 

sample interval. This option can used for comparative analysis of stats. 

Raw checkbox displays raw output, most likely not desired. 

Start button starts the measurement and analysis. 

Cancel cancels the Show Related Measurement dialog. 

Help button displays online help 

To display advanced options select the down arrow. It is strongly recommended you 
not change any of the values for the advanced ASAP Measure settings. 

Reports appear in a normal ASAP report window, which are tiled along with other 
report windows. The progress bar at the bottom shows measurement status and 
details. 

Correlate as... you can click on the Status Bar portion of a Show Related 
Measurement report window and menu items named… Correlate as… . Select one of 
these to display a correlation analysis between the measurement and ASAP data. 
Correlate as… is an advanced feature primarily intended for ASAP quality assurance 
and development purposes. 



 
Page 80 of 161 HPE NonStop ASAP Client Manual                     

Show Related Objectives 

To display a report of high and low objectives for the selected application domain, 
select Show Related Objectives. When this report is generated, a query is posted to 
your host system, then the response appears in a scrollable view of Application 
domain objectives related to the selected object. 

Session Window 

ASAP obtains object status and performance information via an active Host session to 
a NonStop™  Server. Using the Session window, you can view, start, stop, and track 
the progress of your Host Session. You can also synchronize the time and date 
between your workstation and the server. 

To open the Session window, choose Session from the View menu of the Browse 
window, or click the Host icon in the PC-Host Session Status display. 

Session Log 

You can view the progress of your ASAP Host Session from the Session window. All 
Host Session establishment and I/O activities appear in the log area of the Session 
window. 

The Session log is useful for checking the status of your Host Session. If you are 
having difficulty with your Host Session, view the Session log to determine the cause. 
The log always contains the latest information about your host dialog, including version 
information about the CSG, SSG, and SeeView products. 

To save the Session log to disk, select Save from the File menu of the Session 
window. 

Session Window Pull-Down Menus 

File Menu Items 

Menu 
Item 

Description 

Start 
Session 

Starts your Host Session and enables the state of the Client Server Gateway 
check box on the SSG property sheet 

Stop 
Session 

Stops your Host Session and disables the state of the Client Server Gateway 
check box on the SSG property sheet 

Save Log 
and Save 
Log As 

Saves the current Session log to disk. Choose Save Log As to specify the 
name of the log file before saving the disk file. 

Close Closes the Session window. This does not stop your Host Session. 
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View Menu Items 
 

Menu 
Item 

Description 

Statistics Displays host I/O statistics for your session. These statistics are used 
primarily for diagnostic purposes. 

Clear Log Clears the contents of the Session log. This is used primarily for diagnostic 
purposes. 

Version 
Info 

Displays version information for the CSGDLL, CSG, SSG, and SeeView 
products. This is used primarily for diagnostic purposes. 

Data 
Window 

Opens or gives focus to a Browse window. 

Time 
Sync 

Displays the Time Sync window, which lets you determine the time 

difference between your workstation and your NonStop
™  server, and lets 

you synchronize the date and time between them to within one second of 
each other. 

You can either synchronize your workstation to your NonStop
™  

server session, or vice versa if you have super group access: 

1. Select Set PC time from HOST time (to synchronize your 

workstation to your NonStop
™  server) or Set HOST time from 

PC time (to synchronize your NonStop
™  server to your 

workstation). 

2. To view the time difference between your workstation and the 
server, click Check Times. ASAP displays the date and time of the 
host and the PC in real time. 

3. Click the down-arrow button to display the log window. Click the up- 
arrow button to hide the log window. 

4. To eliminate a time difference between the PC and Host, check the 
Set Time check box. 

The Check Times button changes to SET PC TIME or SET HOST 
TIME. 

5. To initiate the time sync operation, click that button. 

6. To confirm the new time difference between the PC and Host, 
uncheck the Set Time button, then click the Check Times button. 

7. To temporarily suspend normal ASAP data collection between the 
ASAP client and server, check the Suspend I/O check box. This is 
useful when data collection causes excessive queuing that could 
interfere with time synchronization (if you see messages "Round 
Trip too long…", select it). 

8. To close the Time Sync window, select the Close button. When 
you close the Time Sync window, ASAP sampling automatically 
resumes if the Suspend I/O check box is checked. 

Options Opens the ASAP Properties window, where you can customize your 
environment by specifying which entities and performance attributes the 
Browse and Graph windows display. 
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Session Window Toolbar Buttons 

Start/Stop Session Toolbar Button 

 

Click the Start/Stop Session toolbar button to start and stop your Host Session. To 
start or stop your Host Session, click the button with the Tandem logo on it. 

The Start/Stop Session button appears pressed when ASAP is in session, and not 
pressed when ASAP is not in session. 

Save Session Log Toolbar Button 

Click the Save Session Log toolbar button to save the current Session log to disk. 
 

Clear Session Log Toolbar Button 
 

Click the Clear Session Log toolbar button to delete the contents of the current 
Session log. 

Time Synchronization Toolbar Button 
 

For details, see Time Sync under View Menu Items on page 81. 
 

Properties Window Toolbar Button 
 

Click the Properties Window toolbar button to display the ASAP Properties window. 
Use the ASAP Properties window to customize your environment by specifying which 
entities and performance attributes appear in the Browse and Graph windows, and to 
specify session properties. 
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Section 5: Configuring ASAP 
The ASAP Properties window gives you many options for customizing the ASAP 
environment, including the ability to specify which entities are retrieved from 
NonStop™  OS host systems, the attributes to display for each entity, the state 
determination algorithm for each attribute, and the font, graphing options, and host 
retrieval options to use. 

1. Open the ASAP Properties window by doing any of: 
 

In the Browse window, select View>Options. 
 

In the Session window, select View>Options. 
 

In the Browse window, click the Properties toolbar button. 
 

In the Session window, click the Properties toolbar button. 
 

In the PC-Host Status icon area of the Browse window, select the PC icon. 
 

In a Browse or Graph window, select Properties from a context-sensitive pop- 

up menu. 

The ASAP Properties window appears. 

2. Click a property sheet tab to bring it to the front. (This section describes all the 
property sheets and their functions.) 

3. Change the settings on the sheet. 

To discard your changes and leave the Properties window at any time, click 
Cancel. 

4. Click OK or Apply. 

The changes you made are permanently saved and applied to your environment. 
 

Property 
Sheet 

Controls Page 

Attribute Which entity attributes are displayed in grids and graphs 84 

Entity Which entities are retrieved from the host 89 

Font Name, size, and style of font in the Browse window 91 

General General ASAP properties 91 

Graph Graph properties for Browse and Graph windows 95 

OEM Open Enterprise Management properties 98 

OIL Object Integration Layer properties 100 
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OSC Object State Change properties 103 

SSG Host Session properties for the Client Server and SeeView Server 116 
 

Attribute Property Sheet 

The Attribute property sheet controls which entity attributes are displayed in grids and 
graphs, and their state determination algorithm. Entity attributes are the properties of 
an entity such as status, date, time, and busy. 

Use this dialog to: 
 

Control which attributes are displayed in the data grid of Browse windows 
 

Control which attributes are displayed in the graphs of Browse and Graph windows 
 

Set the normalization value for attributes 
 

Set the state determination algorithm for attributes 
 

Find the exact meaning of a specific entity attribute 

1. Change the current entity properties displayed in the Attribute property sheet: 

a. Click the Entity down arrow. 

b. Select the entity you want. 

The attributes of the selected entity appear in the list box below the entity name. 

2. Select an attribute from the Attributes list. 

A technical description of the selected performance attribute appears in the 
Selected Attribute text area to the right of the Attributes list. 

Getting Help for an Entity Attribute 

To find information about a specific performance attribute: 

1. Scroll through the Attributes list. 

2. Select the name of the attribute. 
 

Show Attribute in Grid Check Box 

To display or suppress an attribute in the data grid of the Browse window: 

1. Select the attribute from the Attribute property sheet. 
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2. Check the Show Attribute in Grid check box, or double-click the first column of 
the selected attribute. 

Show Attribute in Graph Check Box 

To display or suppress an attribute in the graph portion of Graph and Browse windows: 

1. Select the attribute from the Attribute property sheet. 

2. Click the Show in Graph check box, or double-click the second column of the 

selected attribute. 

When an object's data attribute has its Show in Graph Check Box enabled, ASAP 
analyzes the attribute and assigns a state to the attribute. 

When the Show in Graph property of an attribute is enabled, the attribute state 
appears in the form of color-coded graph elements and in annotated-state icons in the 
OIL, OEM, and data grids. 

The rule used to determine the state of a data attribute is based on the State 
Determination setting for the attribute. For more information, see State Determination, 
below. 

When an object’s time attribute has its Show in Graph Check Box and Use Thresholds 
options selected, ASAP performs a series of automatic timestamp checks to ensure 
that the time has a reasonable value. If the time is not reasonable, ASAP raises the 
state of the time to an alert level. 

To disable Late Data time checks for all entities, select the No Check option of the Late 
Data Integrity Check drop-down menu in the OSC Property Sheet. For example, to 
disable Late Time time checking for a specific entity, uncheck Show in Graph for its 
Time property from the Attribute property sheet. To disable Late Data time checks for 
all entities, select the No Check option from the OSC Property Sheet. 

 

Graph-Max Field 

When an attribute has its Show in Graph property set, you can specify the Graph-Max 
normalization value for that attribute. The Graph-Max field is the unlabeled field 
immediately to the right of the Show in Graph check box. This value determines the 
maximum graph amplitude or normalization value for the attribute. 

For example, if the attribute Queue has a Graph-Max value of 10, and the value of the 
Queue attribute is 5, the Queue value appears in the graph at one-half of the maximum 
graph height. 

Graph-Max values are used when the Graph Percent check box is selected on the 
Graph property sheet. 
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State Determination 

You can specify how the state of each attribute is determined when an attribute has its 
Show in Graph property set. For more information, see StateRule - EDL Attribute 
Property on page 153. 

In ASAP, each data attribute has a state associated with it when the attribute has its 
Show in Graph property set. ASAP assigns the state to that attribute based on the 
State Determination Option for each attribute. If more than one attribute has its Show 
in Graph property enabled for a given object, the attribute with the highest state is said 
to be the state of the object. Thus each object can have a state associated with it. 

When an object has a state associated with it, the graph for each object is color-coded 
according to the state of the object, and the corresponding data value in the grid 
portion of the ASAP Browse window is annotated with the state icon. The Browse 
window lets you selectively display objects based on their states. To selectively display 
objects in the browse window based on their states, select the States menu item from 
the Browse window View menu. This table summarizes ASAP states and their 
associated icons: 

Icon State Description 

 

 Existence Object exists. 
 

 Up or OK Object is up or meets objectives. 
 

 Low Object utilization is low. 
 

 Medium Object utilization is medium. 
 

 High Object utilization is high. 
 

 Warning Object is at Warning level. 
 

 Critical Object is at Critical level. 
 

 Down Object is down or not operational. 
 

 Questionable Object state is Questionable. 

To customize object and state icons, use the Icon Server Control Panel. If you do, state icons in your ASAP 
environment might appear different than shown here. For more information, see Icons Button on page 92. 

State Determination ALL Button 

The State Determination ALL button is an advanced feature that selects a range of 
attributes from the first attribute that has a state attribute associated with it, through the 
last attribute for the current entity. 

This button lets you quickly select a range of attributes starting with the first attribute 

that has a state associated with it, also known as a value,state StatePair. Once you 

select these attributes using the ALL button, you can set the State Determination rule 
for all StatePair attributes all at once, rather than individually. 
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For example, to set the State Determination rule for all StatePairs to 
UseStateGraphState, click the ALL button, then select the State Determination Rule 
labelled Use State...Graph State. 

Conversely, to set the State Determination rule for all StatePairs to UseThresholds, 
click the ALL button, then select the State Determination Rule labelled Use 
Thresholds. The Status attribute for the entity is not set to UseThresholds. By 
definition, its state determination rule is UseStateGraphState. 

 

State Determination Options 
 

Icon Option Description 
 

 Use 
Thresholds 

The state of an attribute is determined by the values specified in 
the ASAP Utilization Thresholds dialog box. 

 

 Use Value 
Graph Value 

Attribute state information is determined directly by the 
value of that attribute. 

 

 Use State 
Graph Value 

Attribute state information is determined by the state 
variable associated with that attribute. The attribute value is 
graphed. 

 

 Use State 
Graph State 

Attribute state information is determined by the state 
variable associated with that attribute. The state value is 
graphed. 

Use Thresholds Option 
 
 

The Use Thresholds option indicates that the state of an attribute is determined by the 
values specified in the ASAP Utilization Thresholds dialog box. When you set this 
property for a given attribute, state determination for the attribute is based entirely on 
ASAP utilization thresholds. For more information, see Utilization Thresholds 
Control Panel on page 102. 

When an object's Time attribute has its Show in Graph Check Box and Use Thresholds 
options selected, ASAP performs a series of automatic time checks to ensure that the 
time has a reasonable value. If the time is not reasonable, ASAP raises the state of the 
time to an alert level. 

For example, if the time for statistics received from ASAP is not recent, the Time state 
for that object is reported as down and a Red or Yellow Icon appears next to the time. 
You should enable ASAP time checks because this mechanism helps in the analysis of 
a variety of problems, including: server and database errors, down nodes, down 
communication paths, and incorrect system time settings. To disable Late Data time 
checks for all entities, select the No Check option of the Late Data Integrity Check 

drop-down menu on the OSC Property Sheet. 
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Use Value Graph Value Option 
 
 

The Use Value Graph Value option indicates that attribute state information is 
determined directly by the value of that attribute. This value is graphed. 

Entities such as App have user-defined metrics that provide both value and state 
information in ordered pairs of numbers; for example, Busy and BusyState. The metric 
portion is the actual value of the attribute, and the state portion is the entity agent’s 
state determination objective associated with the metric. When you select the Use 
Value Graph Value option, the metric value is graphed, and that value is also used to 
directly specify the state of the object. The state variable associated with the metric is 
ignored. 

This option lets applications using the ASAP Extension directly set the state of an 
attribute from their application program. 

 

Use State Graph Value Option 
 
 

The Use State Graph Value option indicates that attribute state information is 
determined by the state variable associated with that attribute. The attribute value is 
graphed. 

Entities such as App have user-defined metrics that provide both value and state 
information in ordered pairs of numbers; for example, Busy and BusyState. The metric 
portion is the actual value of the attribute, and the state portion is the entity agent’s 
state determination objective associated with the metric. When you select the Use 
State Graph Value option, the actual metric value is graphed, but the objective state of 
the value is determined by the state variable associated with the metric value. 

This option lets you use the ASAP Extension to configure host-defined performance 
state objectives and to see a graphical representation of these states in the ASAP 
Client GUI, the OEM/OIL, and any OEM adapter-enabled Enterprise Management 
framework. 

 

Use State Graph State Option 
 
 

The Use State Graph State option indicates that attribute state information is 
determined by the state variable associated with that attribute, and that state value 
should also be graphed. Because larger state values indicate higher alert levels, this 
option is useful for graphically drawing your attention to the most significant alerts. 

Entities such as App have user-defined metrics that provide value and state 
information in ordered pairs of numbers; for example, Busy and BusyState. The metric 
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portion is the actual value of the performance attribute. The state portion is the entity 
agent’s state determination objective associated with the metric. When you select the 
Use State Graph State option, the state value is graphed and used to determine the 
state of the metric. 

When you choose this option, although the value of the state is graphed, the actual 
metric value appears in all numeric fields such as the grid portion of the Browse 
window, pop-up captions in the graph, and the OEM context fields. This option is 
useful if you want the relative size of graph elements to indicate alert levels. For 
example, larger graph elements can indicate larger or higher alert levels. 

You can use this option in several ways: 
 

It lets system and application entities associate host-defined availability objectives 

with metrics, and see a graphical representation of these states in the ASAP 

Client, the OEM/OIL, and any OEM adapter-enabled Enterprise Management 

framework. 
 

It can display the state of an attribute as determined by the ASAP RANK 
command. When you specify Use State Graph State, the state of the attribute is 
determined by the RANK command. All StatePair attributes for entities such as 
App, CPU, Disk, Expand, File, Node, Process, Processbusy, RDF, Spooler, 
System, Tape, and TMF can have availability objectives defined using the ASAP 
RANK command. 

 

It is used for System entities that have a Status attribute representing the 
operational state of the object. Each Status attribute has a state named Op 
associated with it. The value of Op represents the numeric state of the object; for 
example, 2 (up), 6 (warning), 7 (critical), and 8 (down). When the Status attribute is 
graphed and the Use State Graph State option is chosen, the operational state of 
the object is graphed and that state icon appears next to the Status attribute in the 
data grid. 

Entity Property Sheet 

Use the Entity property sheet to control which entities have their availability information 
analyzed. The ASAP Client automatically retrieves the selected entities from your host 
systems for real-time analysis and display. 

The list of entities that appears in the Entity property sheet is determined by the 
entities defined in the Entity Definition Language (EDL) file. For more information about 
adding entities, see Section 6: Entity Definition Language (EDL). 

You do not need to enable all of the entities on the Entity property sheet to obtain 
context-sensitive menu reports about these entities. This dialog controls which entities 
are retrieved from the host and displayed in various grids and graphs. Try setting only 
one entity, such as the CPU entity, to see if this setting provides enough data. 
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The time required for data retrieval depends on the size of your NonStop™  OS 
network, the number of entities you select, the number of application objects, and the 
speed of your host connection: 

 

For a medium-size network (5 to 10-node), data retrieval for a few key entities 

takes up to 15 seconds. 
 

Retrieving the data for a 30-node network with many entities enabled can take 

several minutes. 

When only a few entities are enabled, the download interval is typically less than 
15 seconds, and you still get detailed progressive reports on CPU, Disk, Expand, 
and Process entities. 

To enable information retrieval for an entity, check the check box for that entity on the 
Entity property sheet: 

 

Check 
Box 

Downloaded Status and Performance Attributes 

App Application domain name, date, time, CPU, PIN, user-defined metric count, 
error number, total downtime, number of no acknowledgements (NAKs), 
undefined metrics, and all application-defined metrics 

CPU CPU number, date, time, busy, queue, dispatch, disk I/O, cache hits, swaps, 
memory queue, and pages locked 

Disk Disk name, operational status, date, time, CPU, PIN, capacity, space used, 
requests, overall busy, write busy, read busy, cache hits, swaps, queue, and 
input and output kilobytes per second 

Expand Line name, operational status, date, time, next system, time factor, pool use, 
fail, no buffer, BCC, modem errors, packets, NAKs, and passthrough packets 
sent and received 

File File name, date, time, operational status, errors, percent full, file code, TMF 
audit state, format, file type, SQL type, partitions, last open, and last 
modification 

Node Source node, destination node, date, time, hops, links, and packets sent and 
received 

Process CPU number, date, time, rank, busy, PIN, program filename, name, priority, 
security group.user, receive queue, messages sent and received, and pages 
used 

Process 
Busy 

CPU number, date, time, rank, busy, PIN, program filename, name, priority, 
security group.user, receive queue, messages sent and received, and pages 
used 

RDF Date, time, op status of extractor, monitor, purger, receiver, and updater 
components, round trip delay time, primary and backup CPUs, execution 
priority, audit, sequence number, and relative byte address information 
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Spooler Date, time, operational status of collectors, devices, print processes, 

supervisor processes, jobs, fonts, full, and primary and backup CPUs 

System Date, time, busy, queue, dispatch, disk I/O, cache hits, swaps, memory 
queue, and pages locked 

Tape Date, time, operational status of tape drive, drive subtype, label processing 
status, mount status, mount wait time, status of physical tape, tape label; 
process name, user ID, program filename of process using tape drive, and 
primary and backup CPU numbers 

TMF Date, time, operational status audit dump, audit trail, audit hold, audit errors, 
percent audit trail full, transactions, transactions per second, hung 
transactions, and duration of transactions 

 

Font Property Sheet 

The Font property sheet controls the grid font name, size, and style properties for 
Browse windows. 

Changing Font Name 

1. Select the font name in the Font Name list box. 

2. Click Apply. You see the results immediately. 
 

Changing Font Style 

1. Click the Font Style down arrow. 

2. Select a style from the list. 

3. Click Apply. You see the results immediately. 
 

Changing Font Size 

1. Click the Font Size down arrow. 

2. Select a style from the list. 

3. Click Apply. You see the results immediately. 
 

General Property Sheet 

The General property sheet controls the display of toolbars, object and state icons, 
default double-click actions, and automatic grid formatting. 
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Annotate Grid With States Check Box 

To display state icons in the grid portion of all Browse Windows, check the Annotate 
Grid with States check box. 

When this check box is checked, a state icon appears next to the attribute with the 
highest alert state for each object graphed in the Browse window. 

The state icon that appears in the Browse window is the same icon that appears in the 
OEM, OIL, and any optional Enterprise Management Frameworks. 

Clear Registry Button 

To clear all of your registry settings, click the Clear Registry button. Because all 
existing settings are lost, a confirmation dialog box appears. Your custom EDL settings 
are also lost, and ASAP reverts to factory EDL settings. If you click Yes, all settings are 
cleared, the ASAP Client terminates, and you must restart your ASAP session. You 
can configure your new settings when the session is restarted. Click No to close the 
confirmation dialog box and leave your settings unchanged. 

 

Data Query Tool Bar Enable Check Box 

To display the toolbar in the main Browse window, check the Data Query Tool Bar 
Enable check box. 

Icons Button 

Click the Icons button on the General property sheet to configure the icons and colors 
you want to represent objects and states in ASAP, OIL, and OEM windows. 

When you click the Icons button, the Icon Server control panel appears. The Icon 
Server lets you configure your icons and colors. For information on using this control 
panel, see Icon Server Control Panel on page 97. 

 

New Graph on Data Grid Double Click Check Box 

To change the default double-click behavior in the grid portion of the main Browse 
window, select the New Graph on Data Grid Double Click check box. 

When you select this check box, double-clicking selected rows in the grid portion of a 
Browse window opens a new Graph window view of the selected object or objects. 

When this check box is not selected, double-clicking the grid portion causes the 
selected row or column to be graphed in the same window as the grid. Use this option 
to isolate the graphic properties of the selected row or column. 

You can also access these functions through the grid menu by right-clicking a grid row, 
column, or cell and then selecting either New Graph to display a new graph in a new 
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window or Graph Row/Column to display the selected row or column in the graph 
portion of the same window. 

 

Reports Auto Refresh Check Box 

To automatically refresh the contents of Report windows whenever ASAP performs a 
host sample update, select the Reports Auto Refresh check box. 

When this check box is not selected, Report windows are static, displaying data for the 
specific request that initially created the Report window. This data is not updated. 

Clicking the Auto Refresh Indicator in the lower left corner of a Report window also 
controls the Auto Refresh property for that window. When you click the Auto Refresh 
Indicator, a menu appears so that you can specify the setting of the Auto Refresh 
property. You can also manually update the window using the menu. 

Set Password Button 

Click the Set Password button to protect ASAP property sheets with a password. The 
Set Password dialog is used to protect settings for your environment with a password. 
Click the Set Password button on the General property sheet to display the Set 
Password dialog box. 

When the Set Password dialog box appears, you can protect property sheets by 
selecting check boxes for each property sheet that you want protected. Once you enter 
a password and click the Set Password button, the property sheets you selected are 
protected. You can set a Password Reminder, which is provided if someone cannot 
remember the password. 

To access protected property sheets: 

1. Display the ASAP properties window, and select property sheets as you would 
normally. 

2. You will be prompted for a password to unlock the protected property sheet. If you 
do not have the password, you will be unable to modify protected property sheets. 

3. If you enter the correct password, all property sheets will be unlocked until the 
ASAP Properties window is closed. If someone opens the ASAP Properties 
window at a later time, they will be prompted once again for the password. This 
approach allows you to protect your property sheet settings in environments that 
are not physically secure. 

 

Considerations 

If you specify a password with no property sheets protected, then you "own" the Set 
Password dialog box even though no tabs are protected. Thus other users can have 
access to all property sheet settings, but they are prevented from setting the property 
sheet password. 
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If you specify no password and no property sheets are protected, then you have reset 
property sheet protection. Other users can then enable property sheet protection. 

If you select the ALL checkbox, all property are selected. If you clear the ALL 

checkbox, all property sheets will be cleared. 

Show Help in Grid Check Box 

To display context-sensitive definitions of attributes when you move the mouse over 
data in the grid portion of the Browse window, select the Show Help in Grid check box. 
If you do not want definitions displayed, do not select this check box. 

Show Splash Screen Check Box 

To display the splash screen at startup, select the Show Splash Screen check box. 
Clear the check box to suppress display at startup. 

Show Removed Objects Check Box 

Select the Show Removed Objects check box to display objects that have been 
removed. Some entities such as the App, Disk, File, or Process entity can have 
transient objects, where a transient object is an object that previously existed but has 
been removed. For example, application objects or processes are added when an 
application is started. When a program shuts down, monitored objects may be 
removed. By selecting this option, you can monitor the completion status of objects 
that have been removed. The Delete Removed drop-down controls how long removed 
objects are displayed. 

Delete Removed Drop-Down 

Select the Delete Removed drop-down to control when removed objects are deleted. 
These options are available: 

Never–Select this option if you want removed objects to be indefinitely retained by 
your client session. This setting means the client will never delete removed objects 
from the client data cache. You can, however, manually delete objects in cache using 
the Edit… Clear Data menu item on the main browse window. 

Immediately–Select this option if you want to always immediately delete removed 
objects from cache. This setting causes the client to immediately delete removed 
objects from the client data cache. When this option is set, removed objects will never 
appear. 

After N minutes–Select this option to control how long objects will be displayed after 
they are removed. For example, if you select Delete Removed After 5 minutes, the 
client displays an object that has been removed for 5 minutes and then the removed 
object is deleted from the client. The value of N controls how long an object is 
displayed in the client. It is not necessarily the time since was removed. 



 
Page 95 of 161 HPE NonStop ASAP Client Manual                     

Depending on server behavior, a removed object may reappear after it has been 
removed because some server entities continue to redisplay a removed object, or 
because the object may actually be re-created (for example, a process $name that 
comes back). If so, the object reappears in the client. 

If After N minutes is specified, and if the EDL Command associated with an entity 
supports an AGE N option, the value of N in the Delete Removed After N minutes 
dropdown should be greater than the value of AGE N. 

 

Stretch/Compress Grid Columns to Fit Window Check Box 

Select the Stretch/Compress Grid Columns to Fit Window check box to automatically 
stretch or compress the grid column width automatically. 

When this check box is selected and the Browse window is resized, the grid column 
width for each column is apportioned automatically based on its relative width. 
Columns with more text are wider, and columns with less text are narrower. 

When this check box is not selected and the Browse window is resized, the grid 
column width for each column remains a constant width unless the window size is too 
small. In that case, the column width is sized automatically according to the 
apportionment method. 

Graph Property Sheet 

The Graph property sheet in the ASAP Properties window controls various Graph 
properties. Graph properties include graph type or style, format, label positioning, and 
whether graph rotation angles are saved. 

You can use this dialog to control: 
 

Whether a Graph appears in the Browse window 
 

Whether Graph rotation angles are saved in the registry 
 

Whether Graph rows are labeled with corresponding objects 
 

Which Graph normalization method is used 
 

Whether Graph colors are synchronized to thresholds 
 

Graph Type Drop-Down List 

To change the type of graph displayed in Browse and Graph windows, click the Graph 
Type down arrow and then select a graph type. 
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Graph Color Sync Check Box 

To synchronize the color of graph elements to ASAP Utilization Threshold colors, 
select the Graph Color Sync check box. When you select this check box, graph 
elements that exceed utilization thresholds match the utilization threshold color for the 
object. Object colors in ASAP, OEM, and OIL are synchronized, indicating the relative 
utilization state of each object. 

 

Graph Color Toggle Check Box 

To alternate the color of repeating rows of graph colors between a light and dark shade 
of the same color, select the Graph Color Toggle check box. 

Graph in Grid Window Check Box 

To display a graph in the Browse window, select the Graph in Grid Window check box. 
If you do not want the graph displayed in the Browse window, do not check this check 
box. 

When you select an item in the graph, the corresponding data in the grid is 
automatically selected and highlighted. This tight coupling lets you work in either the 
graph or the grid and have both a graphical and a numerical view of the entity available 
simultaneously. 

 

Label Rows with Names Check Box 

To have object row labels appear at the base of the graph, check the Label Rows with 
Names check box. If you prefer the object rows to be identified with a legend, do not 
check is option. 

 

Label Names Compressed Check Box 

To display object row labels in condensed form, select the Label Names Compressed 
check box. To display the object rows with their fully expanded name, do not check this 
check box. 

 

Graph Percent Check Box 

If you want the data in graphs to be normalized, check the Graph Percent = 

value/Graph-Max*100 check box. Use the Attribute property sheet tab to set the 

Graph-Max normalization value for each entity attribute. 

Pop-up Offset Drop-Down List 

The Pop-up Offset controls the horizontal offset of pop-up labels in graphs when you 
click graph elements. 
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Max Graph Rows Drop-Down List 

The Max Graph Rows property lets you limit the maximum number of rows that appear 
in the Browse window graph and associated grid or list view. 

The primary purpose of this function is to avoid displaying too much information in the 
Browse window. 

Select ALL to remove the limit altogether. However, selecting ALL can lead to 
performance degradation when you display a large number of objects or rows. 

High Contrast Check Box 

Select the High Contrast check box if you want to maximize color contrast between 
graph elements and the graph background. If you prefer more muted contrast, do not 
check this check box. 

Show Wall Check Box 

If you want contrast between the graph wall and the graph background, check the 
Show Wall check box. If you prefer less contrast, do not check this check box. 

Save Rotate Angles Check Box 

To permanently save graph rotation and elevation angles each time you rotate the 
graph in the main Browse window, check the Save Rotate Angles check box. 

Icon Server Control Panel 

The Icon Server control panel lets you configure the icons and colors that appear in 
ASAP, OIL, and OEM windows. 

To display the Icon Server control panel, click the Icons button on the General Property 
Sheet. 

You can also use this control panel to configure your own customized icons and colors 
for the ASAP environment. 

To select a set of icons and colors, select New Icon Directory? to change your icon 
directory. 

OK or Apply buttons are enabled when the directory you select is a valid icon-color 
directory. To apply the changes to your ASAP environment, click OK or Apply. If you 
do not want to change anything, click Cancel. 

To change the color associated with a state, select the colored state name in the 
colored states area on the right side of the control panel. A color palette for the 
selected state appears. Select the color you want to associate with the state. To apply 
icon and color changes, click OK or Apply. 
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For more information about configuring your own icons and colors, click the Help 
button on the Icon Server control panel. 

 

OEM Property Sheet 

The OEM property sheet controls how ASAP nodes, entities, and objects are displayed 
in the Open Enterprise Management (OEM) gateway. Also use this property sheet to 
control the display of availability and performance icons. 

Enable the OEM gateway when you want an enterprise management gateway view of 
nodes, entities, and objects known to ASAP. When you select an entity or object in the 
OEM framework, ASAP reports on the selected node, entity, or object. 

Performance utilization and alert icons representing the relative state of nodes, 
entities, and objects can also be displayed in the OEM. Icons are automatically 
propagated upward through the OEM hierarchy. This propagation algorithm ensures 
that even when the OEM hierarchy is collapsed, the highest alerts for nodes, entities, 
or objects are visible. 

Open Enterprise Management Check Box 

The Open Enterprise Management check box lets you display ASAP node, entity, and 
object performance information in the OEM gateway. 

To enable the ASAP interface to the enterprise management gateway, check the Open 
Enterprise Management check box. When the OEM interface is active, you can access 
ASAP information from the OEM framework. 

When you request information about an entity or object in the OEM framework, ASAP 
displays detailed information for the selected entity or object. 

Show Context Values as Percentage Check Box 

Select the Show Context Values as Percent of Graph-Max check box to display values 
as a percentage in the OEM Context field. 

When this option is selected, statistics are displayed in the OEM Context field as a 
percent of the Graph-Max value for the most used attribute of each object. You can 
control Graph-Max values by selecting the Attribute Tab of the ASAP Properties 
window. 

If this check box is not checked, Context values are displayed as raw values. 

For example, if the Queue attribute of the CPU entity has a Graph-Max value setting of 
10, and a CPU has a Queue of 10, ASAP reports the OEM Context for that CPU as 
Queue 100% in the OEM Context field. If the Show Context Values as Percent option 
is not checked, the threshold utilization alert is still reported as 100%, but the value 
that appears in the OEM Context field is Queue 10 instead of Queue 100%. 
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The Show Context Values as Percent of Graph-Max option has no effect on the 
utilization threshold state reported for OEM objects. It simply controls how the value 
appears in the OEM Context field. 

Report on Objects in Related OEM Subdomain Check Box 

On the OEM property sheet, the Report on Objects in Related Subdomain check box 
controls how ASAP behaves when objects are selected in the OEM gateway. 

When this check box is checked, a selected object and all objects in the same 
subdomain are graphed. 

If this check box is not checked, only the selected object is graphed. 

For example, if the check box is checked and \Chicago\Cpu\0 is selected in the OEM, 
all CPUs in \Chicago are graphed in the ASAP Browse window. If the check box is not 
checked, only CPU 0 is graphed. 

 

Show Utilization in OEM Check Box 

To display state icons representing alert levels of nodes, entities, and objects in the 
OEM, check the Show Utilization in OEM check box. 

When this check box is checked, icons are automatically propagated upward through 
the OEM hierarchy based on the state determination algorithms you specify. You can 
specify utilization thresholds using the Thresholds button on the OEM property sheet. 
You can also access thresholds through the Browse window Thresholds toolbar 
button. 

You can also specify objectives from your NonStop™  servers with the ASAP 
RANK command. 

If you do not select this option, performance utilization icons do not appear in the OEM, 
but you can still get performance information for objects in the OEM by right-clicking 
the object, then choosing the Performance pop-up menu item. 

OEM Full Context Drop-Down List 

The OEM Full Context drop-down list controls the amount of object-state information 

passed to the OEM. Normal Context is the default and provides limited information, 

other options are Full Context as XML and Full Context as CSV format. The 

following is an explanation of each OEM context option. 

Normal Context –When you select this setting, the ASAP client context string for each 

object contains only the name and value of the attribute with the highest alert state. 
This is the default context string. 

Full Context as XML–When you select this setting, ASAP client appends XML 
<name> <value> pairs for each entity attribute name and value that has its Show in 
Graph property enabled. The XML tag <name> will be the same as the Attribute 
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heading property; for example, <busy> 98 <full> 66. Prior to <name> value pairs, a 
context sting similar to Normal context appears. For example: 

\Chicago\Cpu\01:6:"Busy% 72 <Status> Up <Time> 10:01 <Busy%> 72 

<Queue> 4 <Disk> 28 <Chit> 85 <Swap> 4", 

\Chicago\Disk\$Asap:2:"Status Up <Status> Up <Time> 17:17 

<Full%> 36 <Busy%> 17.5 <Write%> 8.4 <Read%> 9 <Fragment> 

23241.2", 

\Chicago\File\Home\Sales\Pricing.db:2:"Status Up <Status> Up 

<Time> 09:10 <Full%> 0 <Owner> 255 <Rwep> nnnn <Files> 1" 

Full Context as CSV–When you select this setting, ASAP Client appends CSVs 
(comma separated values) for each entity attribute name and value that has its Show 
in Graph property enabled. The name will be the same as the attribute heading 
property. 

 

OEM Thresholds Button 

The Thresholds button opens the Utilization Thresholds control panel. Use this control 
panel to set performance utilization thresholds used by ASAP to alert the OEM 
framework of node, entity, and object performance. 

You can also access the Utilization Thresholds control panel by clicking the Thresholds 
toolbar button in the Browse window or by choosing the Thresholds menu item from 
the View menu in the Browse window. 

OIL Property Sheet 

The OIL property sheet controls whether the Object Integration Layer (OIL) tree view is 
displayed, how it is populated with ASAP objects, and whether performance utilization 
thresholds and alert icons are shown in the OIL. 

Use the OIL to obtain a hierarchical tree view of nodes, entities, and objects known to 
ASAP. Selecting an entity or object in the OIL causes the Browse window to report on 
that entity or object. 

Icons representing the relative alert levels of nodes, entities, and objects can be 
displayed in the OIL. Alert icons are automatically propagated upward through the OIL 
tree hierarchy. This propagation algorithm assures that even when the OIL tree is 
collapsed, the highest utilization of nodes, entities, or objects is visible. 

Object Integration Layer Check Box 

The OIL provides a hierarchical tree view of nodes, entities and, optionally, objects. To 
display the OIL, check the Object Integration Layer check box. When the OIL is active, 
you can browse multiple NonStop™  OS nodes, entities, and objects from a Microsoft 
Explorer tree view. 
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When you click an entity or object in the OIL tree, the main Browse window to the right 
of the OIL displays availability and performance information for the selected object or 
objects. 

When you use ASAP with the OIL, the main ASAP Browse window is positioned to the 
right of the OIL window and resized to match the OIL window's size. You can then 
display Graph and Report windows to the right of the main Browse window. 

Populate OIL with Objects Check Box 

The Populate OIL with Objects check box controls whether the OIL view is populated 
with the objects known to ASAP. 

If you check the Populate OIL with Objects check box, entities in the OIL tree are 
expanded to display all of the objects under an entity when you double-click an entity 
in the OIL. 

If you do not check this check box, node names and corresponding entity names 
appear in the OIL, but the objects under an entity do not appear in the OIL when you 
double-click an entity name. 

When you click an entity name in the OIL, the main Browse window displays the 
performance information for that entity regardless of how this option is set. In very 
large networks with thousands of objects, the performance of slower workstations 
improves if you do not select this option. 

 

Report on Objects in Related OIL Subdomain Check Box 

On the OIL property sheet, the Report on Objects in Related Subdomain check box 
controls how ASAP behaves when objects are selected in the OIL. 

When this check box is checked, a selected object and all objects in the same 
subdomain are graphed. 

If this check box is not checked, only the selected object is graphed. 

For example, if the check box is checked and \Chicago\Cpu\0 is selected in the OIL, all 
CPUs in \Chicago are graphed in the ASAP Browse window. If the check box is not 
checked, only CPU 0 is graphed. 

Show Utilization in OIL Check Box 

To display performance utilization icons representing the performance of nodes, 
entities, and objects in the OIL, check the Show Utilization in OIL check box. When this 
check box is checked, performance utilization icons are automatically propagated 
upward through the OIL tree hierarchy based on the utilization thresholds you specify. 
You can specify utilization thresholds using the Thresholds button on the OIL property 
sheet or the Browse window toolbar. 



 
Page 102 of 161 HPE NonStop ASAP Client Manual                     

If you do not check this check box, availability and performance utilization icons are not 
displayed in the OIL. 

 

OIL Thresholds Button 

Click the Thresholds button to open the Utilization Thresholds control panel. You can 
use this control panel to set performance utilization thresholds for your ASAP 
environment. You can also access the Utilization Thresholds control panel by clicking 
the Thresholds toolbar button in the Browse window or by selecting Thresholds from 
the View menu in the Browse window. 

 

Utilization Thresholds Control Panel 

Status and performance alerts for nodes, entities, and objects are displayed in: 
 

Color-coded graphs 
 

Icon annotated data grids 
 

The OIL when the Show Utilization in OIL check box is checked 
 

The OEM when the Show Utilization in OEM check box is checked 

Both status and performance icons are propagated upward through the OIL or OEM 
hierarchy for the highest alert levels. Even when the ASAP OIL or OEM OIL tree view 
is collapsed, the highest alert level of nodes, entities, or objects is apparent from the 
color-coded status and performance icons. 

For example, if the performance utilization threshold is set to 80 percent and has a red 
Critical alert icon, any object with a graphed performance attribute of 80 percent or 
more utilization has a red critical alert icon propagated upward through the hierarchy 
for that object. 

 

Utilization Threshold Sliders 

The five Utilization Threshold sliders control the performance utilization thresholds of 
up to five performance indicator icons. The sliders set the corresponding performance 
threshold values of icons that are to appear in the OIL or OEM. When a performance 
attribute reaches a specified utilization threshold, the icon for that threshold appears in 
the OIL or OEM next to the object. 

Threshold values to the right of a slider are always greater than or equal to that slider's 
value because they represent higher utilization indicators. Threshold values to the left 
of a slider are always less than or equal to that slider's value because they represent 
lower performance utilization indicators. 
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Setting an icon threshold value to 0 (zero) disables the display of an icon and all icons 
to its left. Setting an icon threshold value exactly equal to the slider on its right nullifies 
that icon because icons to the right have higher priority. 

Each slider controls the percent utilization threshold level where its icon appears in the 
OIL or OEM. For example, if the performance utilization threshold is set to 80 percent 
for the red Critical alert icon, any object with a graphed performance attribute at 80 
percent or more utilization has the red icon propagated upward through the hierarchy 
for that object. Thus, the node and entity for that object also appears red. 

When ASAP receives new data from the Host Session, each object is analyzed to see 
if it has any graphed attributes that have alert states or that exceed the configured 
utilization thresholds. If an object has one or more attributes that exceed thresholds, 
the highest alert icon is displayed for that object. The alert icon for the object with the 
highest alert is propagated upward through the object hierarchy so that you can easily 
see the objects with the highest alerts, even when a collapsed tree view of your system 
is displayed. 

You can control which attributes have utilization thresholds by indicating whether an 
attribute is graphed. Use the Attribute property sheet. By changing which attributes are 
graphed, you control which attributes are used to determine when an object exceeds 
utilization thresholds. Attributes that are not graphed are not used to determine alerts. 

To change the utilization threshold percentage for graphed attributes that have Use 
Thresholds State Determination enabled, move a Utilization Threshold slider. To 
change the normalization value for a specific attribute, change the Graph-Max value 
for that attribute on the Attribute property sheet. Attributes with their State 
Determination property set to a value other than Use Thresholds have their alert state 
determined by an associated state, and are not affected by the Utilization Thresholds 
sliders. 

 

Utilization Threshold Preset Buttons 

The Utilization Thresholds control panel contains a set of threshold preset buttons so 
that you can quickly set Utilization Threshold sliders to predetermined values. 

OSC Property Sheet 

The OSC property sheet controls whether Object State Changes are monitored and 
how they are displayed. OSC monitoring provides both high-level graphical overviews 
of object state changes, and a detailed log of state changes. 

You can use this dialog to: 
 

Control whether Object State Change monitoring is enabled 
 

Control whether the OSC window is displayed 
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Specify whether state change upgrades are monitored 
 

Specify whether state change downgrades are monitored 
 

Specify the minimum state change monitored 
 

Specify the maximum number of changes to be retained 
 

Specify how late data integrity checks are performed 
 

Specify an audible alert state change threshold 
 

To configure e-mail, wireless phone, and pager alerts and report notifications 
 

Monitor Object State Changes Check Box 

The Monitor Object State Changes check box controls whether ASAP performs object 
state change monitoring. 

When you check this check box and click the Apply button, ASAP monitors object state 
changes based on the settings of other options in this dialog. If you do not select this 
check box, no state change monitoring occurs. 

 

Display Log Window Check Box 

The Display Log Window check box controls whether the OSC window is displayed. 

When you check this check box and click the Apply button, ASAP creates the Object 
State Change window. You can use the OSC window to monitor and analyze object 
state changes. If you do not check this check box, the OSC window does not appear, 
but OSC monitoring can continue in the background, if you checked the Monitor Object 
State Changes check box. 

You can display the OSC window at any time from the Browse window by selecting 
View… State Changes… or by clicking the State Change toolbar button on the Browse 
window. 

State Upgrades Monitored Check Box 

The State Upgrades Monitored check box controls whether to monitor state upgrades. 

When you check this check box and click the Apply button, ASAP monitors state 
upgrades. If you do not check this box, state upgrades are not logged in the OSC log. 

State upgrades occur when the state of an object improves. For example, when an 
object's state changes from Down to Up, the state of the object is said to have 
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improved. When the state of an object changes from Warning to Up, its state has 
improved. 

For operations management purposes, state upgrades are not always monitored. 
Operations management functions are typically concerned with tracking when things 
degrade. Downgrades occur when the state of an object has degraded. For example, 
when an object's state changes from Up to Down, the state of the object has degraded. 

For performance analysis purposes, both state upgrades and downgrades are 
sometimes monitored. For example, by monitoring both performance state upgrades 
and downgrades, an analyst can determine not only when an object's utilization 
increased, but also when it decreased. From a performance perspective, it might be 
important to know that a disk such as $DATA, went from the Up state to the High 
utilization state at 8:05. It might be equally important to know that $DATA went from 
High utilization to the Up state at 8:08. 

If you want to track state degradation, see State Downgrades Monitored Check Box. 
 

Notify Button 

The Notify button displays the Notify Control Panel. This control panel allows you to 
configure ASAP so that it will notify you either at periodic intervals or when certain 
conditions occur. 

The value of the Minimum State Change drop-down list on the OSC Property sheet 
determines the minimum state that is monitored for alert notification purposes. For 
example if the minimum state change monitored is Critical then only objects with state 
changes to the Critical or Down state will cause alert notifications to occur. The Notify 
button is located on the OSC property sheet because its actions are directly related to 
the Minimum State Change setting. 

Notifications can occur: 
 

At regular intervals during the day such as every 1, 2, 3, 4, 8, 12 … hours 
 

At specific times such as 7:30, 10:00, 12:45, 15:27 … 
 

When objects change state 
 

When new sampling activity occurs 

To control notification rule as well as the content of what is reported, use the Notify 
control panel. 

For details about how to enable ASAP to notify you via e-mail, pager, phone, or an 
internet browser, see Notify Control Panel on page 108. 
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State Downgrades Monitored Check Box 

The State Downgrades Monitored check box controls whether state downgrades are 
monitored. 

When you select this check box and click the Apply button, ASAP monitors state 
downgrades. If you do not select this check box, state downgrades are not logged in 
the OSC log. 

State downgrades occur when the state of an object degrades. For example, when an 
object's state changes from Up to Down, the state of the object is said to have 
degraded. When the state of an object changes from Warning to Critical, its state has 
degraded. 

Typically, state downgrades are always monitored. Users focus on tracking when 
things degrade but are not always concerned with when they improve. 

If you want to track state improvements, see State Upgrades Monitored Check Box 
on page 104. 

 

Minimum State Change Monitored List 

The Minimum State Change Monitored list specifies the minimum state to be 
monitored. When you select a minimum state, you are specifying the minimum state 
change that ASAP monitors. 

For example, if you select Warning as the minimum state change monitored, changes 
into states less significant than Warning are not logged in the OSC log. In this case, 
state changes to Up, Low, Medium, or High alert are not logged in the OSC log. 

Maximum Change History Retained in Log List 

The Maximum Change History Retained in Log list specifies the maximum number of 
state changes that the OSC log retains. 

When you select the maximum change history, you specify how much history is 
retained in the OSC log. 

For example, if you select 200 as the maximum, up to 200 of the most recent state 
changes are retained in the OSC log. 

The OSC log is retained in workstation memory for fast access. 

Because detailed statistics are stored in the ASAP server, the OSC log is small, and 
uses little workstation memory. 
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Late Data Integrity Check Drop-Down List 

The Late Data Integrity Check drop-down list controls whether late data integrity 
checking is performed and, if so, how early or late data can be before it is flagged as a 
down time. 

When you select Automatic, ASAP automatically determines whether data received 
from each node, entity, and object is arriving in a timely manner. If not, ASAP flags the 
time for the object as down time. 

When you select a Late Data time, ASAP delays its Automatic late data check by that 
amount. For example, if you select 30 seconds, ASAP delays its late data alert by an 
additional 30 seconds. During this delay, data might arrive from the nonresponding 
object. Manually specifying this value lets you account for marginal queuing delays in 
your system or network. 

If you select No Check, late data integrity checks are disabled. This option overrides 
any Graph Time settings for individual entity Time attributes shown on the Attribute 
Tab of the ASAP Property sheet. To globally disable late data checks, select this 
option. 

HPE does not recommend that you disable this option. Late Data integrity checks 
performed by the ASAP client are one of the key features performed by ASAP. By 
checking for late or early data, ASAP can detect many types of serious availability 
outages. Anomalies detected when Late Data checks are enabled include: 

 

Excessive queuing delays affecting availability 
 

Down or nonresponding CPUs 
 

Down or nonresponding subsystems 
 

Down or nonresponding network nodes 
 

Nonresponding or hung devices 
 

Nonresponding or hung applications 
 

Audible Alert State Threshold Drop-Down List 

The Audible Alert State Threshold drop-down list controls whether an audible alert is 
sounded when a certain state threshold is reached. 

When you select No Audio, audible alert thresholds are disabled. 

When you select an audible alert state threshold, an audible alert is sounded if an 
object changes to that state. For example, if you set the audible alert state threshold to 
the Down state, an audible alert is sounded if any object changes to Down. State 
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change transitions below that state do not sound an audible alert but are still logged in 
the OSC log and appear in the OSC scoreboard. 

You can configure the audible alert sound. If you select Audible Alert State Threshold, 
a simple code string of dots and dashes appears. By specifying your own set of dots 
and dashes, you can create a unique code. For example, you might specify …---… to 
sound the morse code for SOS. 

Notify Control Panel 

The Notify control panel allows you to configure ASAP to automatically generate 
reports and send them to your e-mail, pager, phone, or an internet browser. 

Alerts and reports can be sent either when certain critical conditions occur (for 
example, a device goes down or becomes busy) or for periodic reporting purposes at 
certain times of the day. Reports can also be automatically stored for use as web 
content at the end of each ASAP analysis update. 

Report content can vary from short text messages to rich color-coded HTML content. 
Notifications can contain single or multiple reports. 

Notify Profile 

The Profile portion of the Notify control panel allows you to customize notification rules. 

Profile list - allows you to configure multiple notification profiles (each with different 
SMTP server, Recipients, Notify Rule, Content, and report styles). To create a new 
profile, simply type a new profile name in the Profile list, and click Apply, and then fill in 
the fields as described below. 

Profile check box - allows you to enable or disable notify profiles that you have 
configured. For example, you could disable the Alerts profile while on vacation or 
enable a Report profile while traveling on business so that you periodically receive 
reports via e-mail. 

The content of a profile can range from color-coded HTML e-mail reports to plain text 
reports or abbreviated short-text message reports suitable for use with 161 character 
short messaging wireless devices (cell phones via SMTP to wireless gateway). 

Examples 

Alerts profile - You can configure a profile named Alerts to send an alert to your 
wireless phone notifying you whenever Critical or Down object state changes occur. 

Report profile - You can configure additional profiles such as the built-in Report profile 
to periodically send high-level or detailed reports to systems management personnel at 
various user-defined times of the day. For example, you can specify one profile to 
report hourly, another to report semi-hourly with a different set of report criteria, and 
yet another at specific time intervals with varying degrees of report detail. You can also 
configure a profile to automatically update pages on your Web site. 
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Test Button - allows you to test the current profile configuration. 

Show check box - indicates whether notifications should appear on your workstation. 
For example, if you select Show, and select a content style of HTML, whenever a 
notification occurs, a report will also appear on your workstation in an internet browser. 
If the content style is text, the report appears in a text file viewer; for example, Note 
Pad. If you select the Show check box, and you specify an SMTP server and 
recipients, the ASAP Mailer status is also displayed whenever a notification occurs. 

Log button - allows you to view a log of notifications. If you do not select the Trace 
check box, a high-level log of each notification date, time, and recipient list is 
displayed. If you select the Trace check box and you click the Log button, you are 
prompted with a list of trace files. Selecting one of these displays the corresponding 
trace file. 

Trace check box - indicates whether a detailed trace file should be created for each e- 
mail send attempt. If you select the check box, a trace file is created each time an e- 
mail is sent. If you click the Log button, you can view these trace files. This option is 
intended for debugging purposes only and should not be enabled unless you are 
attempting to diagnose a problem with notifications. 

Cleanup button - allows you to delete all user-defined profiles except the built-in 

Alerts and Report profiles. 

Website button – sets options on the Profile and Content portions of the Notify control 

panel suitable to host or proxy a website. 

To add ASAP statistics to a website, do the following: 
a) Click the Website button on Notify control panel. 
b) Select desired content: Score, Alerts, Detail, Entity, .. 
c) Select customization options: Graphs, Icons, Border, Shade, .. 
d) If SIM website, check SIM checkbox on the ASAP Notify control panel. 
e) Click OK or APPLY to commit your website into production. 

Settings for a Website profile can also be used for notifications and when the profile is 
named "WEBSITE" the settings are also used by the FILE… SAVE HTML as Entity 
Icon-Graph… menu items and the current Entity HTML toolbar button. **Note** the 
Website button only sets options on the Profile and Content portions of the Notify 
Control panel, it does not save settings. 

Summary, to establish a new Website profile and then save settings, you would first 
click the Website button, then adjust the Profile name and Content settings as 
needed, then click Ok or Apply to save your profile settings. 

 

Notify Content 

The Content portion of the Notify control panel defines the notification rule, the type of 
reports to be included, the amount of detail, the style of the content, and whether short 
text messages suitable for wireless pagers or phones should be sent. 
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Notify Rule menu - ASAP determines when to send reports to you based on the 
Notify Rule setting. 

This menu allows you to control what conditions will cause a profile to send a 
notification. Notifications can occur: 

 

At periodic time intervals such as Every 1, 2, 3, 4, 6, 8, 12 ... Hours; 
 

At user-defined times such as 6:17, 7:30, 9:45, 11:00, 12:55, 15:05, … 
 

When object-state changes occur - OnStateChange 
 

When new sampling analysis activity occurs - OnEachSample 

Score Check Box - if selected, a color-coded score-board matrix of object types 
versus object-state counts is generated whenever a notification occurs for this profile. 
This report is useful for providing reports about the overall health of system, 
subsystem, and application objects. 

Alerts Drop-Down - if the value selected is zero, this drop-down disables the display 
of an Alerts report for this profile. If the value selected is not zero, the value indicates 
the number of color-coded recent object-state changes that should be displayed for the 
alerts portion of this report. Alerts are reported with most recent state changes listed 
first, followed by less recent changes. 

Detail Drop-Down - if the value selected is zero, this menu disables the display of a 
Detail report for this profile. If the value selected is not zero, the value defines the 
number of most critical objects to be displayed in the object-state report. The Detail 
report shows offending objects sorted from the highest, most-critical state to the 
lowest, least-critical state. 

Entity-Attribute Grid reports Check Box – if this option is checked then email, 
phone, website notifications will include highly detailed HTML color-encoded entity- 
attribute grid-graph reports for each enabled entity. Objects that appear in the Entity- 
attribute grid-graph reports must meet Minimum State Change Monitored drop-down 
settings on the OSC tab of the ASAP Properties window. Entity-attribute grid-graph 
reports have a number of additional reporting options including: Graphs, Icons, Border, 
Color-Gray, Color-Max, Color-Each, Shade, SIM, Style, and Refresh properties. The 
following is an explanation of each of these options: 

Graphs check box - enables color-coded, embedded, scaled, horizontal graphs. 

Icons check box - enables display of state icons in entity-attribute grid reports. 

Border check box - enables display of borders around entity-attribute grid cells. 

Color options - control how graphs are color-coded as explained below. 

Color Graph - indicates all graphs should be colored gray. 
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Color Max - indicates the color of all graphs in each row match the highest attribute 
state color for that row. 

Color Each - indicates the color of each graph for each attribute in a row is set to the 

state color of each attribute. 

Shade check box - alternately shade the background of every other row. 

Pages check box - reserved for future use. 

Shell Show check box - show shell launch window each time Shell file is shelled. 
This option is primarily for Shell debugging purposes. It typically should not be turned 
in your "production" environment. 

Shell File - defines an optional file to be executed (shelled) at the end of each 
notification. If specified, a shell file allows a wide variety of optional post processing. 
These include custom local/remote website live updates, real-time e-mail, FTP push 
for website proxy, or post sample analysis code to do post notification processing. 
Clicking the [..] button after the Shell File name displays a shell file dialog wizard 
allowing you to create example shell files suitable for updating local or remote web 
sites. Double clicking the shell file name displays contents of the shell file, for 
example: 

 

ShellBAT.bat 
rem 
=================================================== 
rem = ASAP Created this file 3/11/08 03:54 PM 
rem = Example shell FTP PUT <rootfile> to <website> 
=================================================== 
FTP -s:ShellIN.txt 
rem PAUSE to debug 

 
ShellIN.txt 
OPEN <website>.com 21 
<username-here> 
<password-here> 
STATUS 
CD Asaplive 

PUT Asaplive.htm 
CLOSE 
QUIT 

 

Root File - if this field specifies a valid path and file name, the report content for this 
profile is stored in the file. If this field is blank, the report notification is not stored on 
disk. If Style is HTML, the contents (and the extension) of the file are formatted as 
HTML. This field provides a wide range of uses. For example, if content style is 
HTML, and the Root File field specifies a valid file, then that file can represent the root 
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ASAP file in a website directory. This path can be in an ASAP directory, or a customer 
website directory, or an HPE SIM directory. 

 

 
One use of this option is as a dynamically updating web page. For example: 

1. Specify Notify Rule - OnEachSample. 

2. Specify desired Alerts, Scoreboard, Detail, Entity, Graphs, Icons, ... reports. 

3. Specify Style - HTML. (Do not select Short) 

4. Specify File such as …/inetpub/wwwroot/Alerts. 

5. Specify Refresh - 30 Seconds. 

These settings allow ASAP alert and report analysis to be incorporated into web sites 
and to dynamically update on each sample (note that meta refresh allows the page to 
continuously update). Configuring multiple profiles with different Notify Rules and 
report options allows for a variety of web pages. Also note that you do not necessarily 
need a web server to view this web page. For example other workstations can refer to 
network name of Root File, example: \\ASAP-PC\C\Asap\Website\Root\Asaplive.htm. 

 
SIM check box - sets the ASAP Root File path to be in the default HPE Systems 
Insight Manager webapps directory allowing you to integrate ASAP reports into SIM. 
When you check the SIM check box you will be asked whether you want to run the 
ASAP SIM Install script, if you select YES, ASAP will install itself into SIM. Or, if you 
select NO, you can manually install ASAP into SIM. 

Steps to manually install ASAP into SIM. If you prefer to install ASAP manually into 
your SIM environment, select no when prompted by ASAP if you want to run its SIM 
INSTALL script. If you select no, the following manual procedure can be used to install 
ASAP into SIM. From the main HPE SIM screen select the Tools menu as follows: 

A) Tools... Custom Tools... New Custom Tool.... the following prompt should 

appear: 

Step 1: Select the tool to create 
Select the CMS Tool option as shown below: 

(*) CMS Tool - A tool that runs on the central management server (CMS). 

 

B) The following new custom tool CMS options dialog will appear: 
Step 2: Describe how the new custom tool will work. 
Tool Parameters: 

 

C) For: Name of tool, enter preferred descriptive text such as ASAP 

Name of the tool, e.g. My Custom Tool: [ ASAP ] 
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D) For: Description, enter some descriptive text such as shown below 

Description, eg this is my custom tool [ ASAP home page ] 

 
E) For: Help comment, enter some text such as shown below 

Help comment, eg to use this tool type [ To access ASAP select this tool ] 

 

F) For: Menu placement, enter desired menu name as shown below 

Menu placement: help on menu place [ ASAP ] 

 
G) For: User account on target system that will be used, select Logged-in user as 
shown 

(*) Logged-in user 

 

H) For: Maximum number of targets the tool can select, enter None as shown below 

(Note: ASAP always automatically selects all objects in all nodes) 

(*) None 

 

I) For: URL to the site or application to launch, enter /Asaplive/Asap.htm as shown 
below (or the path to the website if different than the default) 

URL to the site or application to launch [/Asaplive/Asap.htm ] 

 

J) For: The format of how target systems are passed to the url, leave blank as shown 
below 

The format of how target systems are passed to the url [ ] 

 

To change your custom tool configuration at a later time: 

Select - Tools... Custom Tools... Manage Custom Tools... 

 
 

To install ASAP into SIM using the AsapSim.BAT and AsapSim.XML files run 
AsapSim.bat. AsapSim.Bat runs SIM MXTOOL which uses AsapSim XML tool 
definitions. Style HTML Option - indicates reports should be formatted in HTML. 

Style TEXT Option - indicates reports should be formatted in plain text. 
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Style Short Check Box - indicates reports should be extremely abbreviated. Select 
this check box if you want only brief Alerts, Score, and Details reports. This is 
especially useful if you are sending a report to a short text message device (for 
example, a wireless pager or a cell phone). 

Suggestion: To send notifications via a short message service such as an SMTP 
gateway, create a different profile for each report type, (Alerts, Score, and Detail), each 
with Short Text selected. That way you will receive three different abbreviated reports 
when an alert occurs. 

Refresh Drop-Down - indicates the HTML refresh rate in seconds. If this field is not 
zero, the value specifies how often a web browser automatically updates the web page 
for this profile. That is, the Notify Rule defines when a web page file is updated on the 
web server, and the Refresh menu defines how often a web browser should pull that 
page. The web page file is defined in the File text box. 

Considerations 

The value of the Minimum State Change menu on the OSC Property sheet determines 
the minimum state that is monitored for alert notification purposes. For example, if the 
minimum state change monitored is Critical, only objects with state changes to the 
Critical or Down state will cause alert notifications. The Notify button is located on the 
OSC property sheet because its actions are directly related to the Minimum State 
Change menu setting. 

Notify Recipients 

To, CC, BCC fields - define the recipients who will receive electronic mail (e-mail) 
notifications. These fields all accept comma-separated lists of e-mail addresses to 
whom notifications will be mailed, courtesy copied, or blind copied. For example, To 
field recipients can be specified as: 

To: John.Doe@Mye-mail.com, 8885551234@Mobile.Att.Net 

If you do not want to receive e-mail notifications but would like notification reports to 
automatically appear on your workstation when notify rule conditions are satisfied, 
leave the To, CC, and BCC fields blank. 

From field - defines the return e-mail address shown in the e-mail or phone alert. If 

you are using short messaging, you might want to keep this field short. 

Subject field - defines the subject sent with the e-mail or phone alert. If you are using 
short text messages, you might want to leave this field blank or keep the subject short. 

Priority Drop-Down - defines the priority of the notification message. Standard RFC 
821 priorities are used: Normal, Urgent, Non-Urgent. If your notification is an alert, you 
probably will want to set the priority to Urgent. (Urgent can expedite transmission, and 
mail or wireless viewers might also pay special attention to messages marked Urgent.) 

mailto:John.Doe@Mye-mail.com
mailto:John.Doe@Mye-mail.com
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Importance Menu - defines the relative importance of the message. Standard levels of 
importance are Low, Medium, and High. If your notification is an alert, you probably will 
want to set the importance to High. 

Append check box - if selected, indicates text will be appended to the end of the 
message. If Style HTML is specified, appended text can be HTML. Otherwise it should 
be plain text. 

Mail Alerts to Wireless Phones and Pagers 

There are hundreds of simple mail transfer protocol (SMTP) servers on the internet 
that provide a variety of text messaging functions for wireless phones, pagers, and e- 
mail services. 

These servers allow you to send e-mail text messages to wireless phones, pagers, 
Blackberry, PDA, and cellular devices. A short list of some of the more common SMTP 
servers follows: 

AT&T - 10digitPhoneNumber@mobile.att.net 
Bell Canada - Phonenumber@txt.bellmobility.ca 
Bell South - Phonenumber@sms.bellsouth.com 
Cellular One - Phonenumber@cellularone.textmsg.com 
MCI - Phonenumber@pagemci.com 
Mobistar Belgium - PhoneNumber@mobistar.be 
Mumbai Orange - PhoneNumber@orange-mail.co.in 
Nextel - 10digitPhoneNumber@messaging.nextel.com 
Qwest - 10digitPhoneNumber@qwestmp.com 
SBC Ameritech Paging - 10digitPagerNumber@paging.acswireless.com 
Skytel Pagers - 7digitPinNumber@skytel.com 
Skytel Pagers - Number@e-mail.skytel.com 
T-Mobile - 10digitPhoneNumber@voicestream.net 
T-Mobile UK - PhoneNumber@t-mobile.uk.net 
Verizon Pagers - 10digitPagerNumber@myairmail.com 
Verizon PCS - 10digitPhoneNumber@vtext.com 

For current information about text messaging server addresses and conventions, 
contact your wireless network provider. 

Once you determine your wireless provider's SMTP addressing convention, enter that 
address along with your wireless address in the To, CC, or Bcc field of the Recipients 
property sheet on the Notify control panel. 

Notify Server 

The Server portion of the Notify control panel defines what SMTP server is used for 
notifications. Contact your system administrator for assistance if you are not familiar 
with how to configure a SMTP server (for outgoing mail) or a POP server (for incoming 
mail). Many SMTP servers are available for use on the internet, and each has its own 
specific configuration and user or password rules. 

mailto:10digitPhoneNumber@mobile.att.net
mailto:Phonenumber@txt.bellmobility.ca
mailto:Phonenumber@sms.bellsouth.com
mailto:Phonenumber@cellularone.textmsg.com
mailto:Phonenumber@pagemci.com
mailto:PhoneNumber@mobistar.be
mailto:PhoneNumber@orange-mail.co.in
mailto:10digitPhoneNumber@messaging.nextel.com
mailto:10digitPhoneNumber@qwestmp.com
mailto:10digitPagerNumber@paging.acswireless.com
mailto:7digitPinNumber@skytel.com
mailto:Number@e-mail.skytel.com
mailto:10digitPhoneNumber@voicestream.net
mailto:PhoneNumber@t-mobile.uk.net
mailto:10digitPagerNumber@myairmail.com
mailto:10digitPhoneNumber@vtext.com
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Valid options for configuring access to intranet and or internet mail servers follow. You 
should contact your system administrator for assistance if you are not familiar with 
configuring access to e-mail servers. Three configuration possibilities: 

1. POP and SMTP Server fields blank - leaving both the POP and SMTP fields 
blank allows you to use the ASAP notification mechanism locally, without sending 
e-mail or pager notifications. For example, if you select Style HTML and select the 
Show check box on the Content property sheet, notification reports automatically 
appears on your workstation web browser whenever the notify rule condition is 
satisfied (that is, when a critical state change occurs or at periodic intervals). 

2. SMTP field supplied, POP field blank - leaving a blank POP field in conjunction 
with a valid SMTP server is allowed in server environments where POP 
authentication is not required. The SMTP user and password fields might or be 
required not depending on your server configuration. If you supply a user and 
optionally a password, you must SELECT the Logon check box. 

3. SMTP and POP fields supplied - Use this combination when POP authentication 
is required to use the SMTP server. Some SMTP servers cross-validate that a 
given user has first logged on to the POP server. If this is the case, you must 
supply your POP user and password. If you supply a user and optionally a 
password, you must select the Logon check box. 

SMTP and POP fields - can be the name of either an SMTP or POP server. Typically 

these addresses begin with SMTP or POP. For example: 

SMTP.SBCGlobal.Net 

POP.SBCGlobal.Net 

You can also specify server addresses as the IP address of your server. 

If you want to send ASAP notifications via e-mail, wireless phone, or pager, you must 
supply the SMTP field. 

User and Pass fields - are required if your POP or SMTP server requires a user or 
password. If your SMTP or POP servers require a user or optionally a password, you 
must select the Logon check box of the corresponding POP or SMTP server field. 

Send Timeout Drop-Down - indicates the number of minutes that e-mail notifications 

will be retried if the SMTP server cannot be accessed. 

SSG Property Sheet 

The SSG property sheet controls Host Session properties. These SSG/CSG properties 
include session options such as enabling your Host Session, specifying the host 
retrieval method, and indicating the amount of history to retain in your ASAP 
hierarchical cache. 

Use this dialog to: 
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Control whether the Client Server Gateway (CSG) is enabled 
 

Control the type of host retrieval option 
 

Control whether session tracing is enabled 
 

Specify the amount of object history to retain 
 

Access advanced properties 
 

Client Server Gateway Check Box 

The Client Server Gateway check box controls whether ASAP is in session with your 
host system. If this check box is not checked, there is no Host Session. 

When you check this check box and click the Apply button, ASAP starts a session with 
the NonStop™  OS host system through the Client Server Gateway (CSG). 

When you enable the CSG for the first time, you might need to go to the Client Server 
Gateway Options window to configure your TCP/IP or Async transport communication 
settings. For general information, see Starting and Configuring the CSG on page 36. 
For detailed information about establishing a Host Session, see the Csguser.doc file in 
the ASAP install directory. 

If you cannot establish a Host Session using the ASAP Client, use the ASAP Session 
log and the CSG terminal window to inspect your Host Session dialog. Also review 
your CSG Options to confirm host communication settings. 

Retrieval Options 

The None, Automatic (recommended), and Fixed Interval retrieval options control the 
host data retrieval algorithm that ASAP uses. 

None 

To manually control host data retrieval, select the None option. The None option 
specifies that ASAP does not automatically retrieve host data on a periodic basis, even 
when the Host Session is enabled. 

This option is useful when you are doing manual specific performance downloads 
using the Download toolbar button on the main Browse window to view data at a 
specific time of day. 

Automatic 

To have ASAP automatically synchronize its hierarchical database cache with the 
database on your host computer, select the Automatic option. The Automatic option 
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also specifies that ASAP performs synchronized updates based on the host data 
arrival rate from your remote host nodes (specified by the ASAP SET RATE 
command). 

When you select Automatic and a Host Session is in progress, the update interval 
automatically appears in parentheses next to the Automatic option. 

Automatic is the recommended setting. 

Fixed Interval 

To manually specify the ASAP update interval in seconds, select the Fixed Interval 
option. 

This value is used as the periodic update interval instead of the value automatically 
determined when you select the Automatic option. Use the Automatic option unless 
you are manually forcing the update interval for a special reason, such as mixed host 
data arrival times. 

Sample Delay Options 

The Computed (recommended) and Manual sample delay options control the number 
of seconds added to the ASAP Client host data retrieval time. This option gives the 
host network and disk I/O enough time to finish before ASAP starts a new host 
retrieval sample. 

 

Computed 

To automatically determine the ASAP Client host data retrieval time, select the 
Computed option. HPE recommends the Computed option; however, if chronic 
and spurious queuing is occurring on host servers, you might want to use the 
Manual option. 

 

Manual 

To manually control the number of seconds added to the ASAP Client host data 
retrieval time, select the Manual option. Use this advanced function only if chronic 
queuing is occurring on host servers. If you experience excessive host queuing, 
configure the Manual setting equal to the peak number of seconds that it takes for all 
host I/O to settle against the host server. 

 

Trace Requests Check Box 

To have requests to the host system traced in the ASAP Session window, check the 
Trace Requests check box. Select Session from the View menu of the Browse window 
to view this trace. Because ASAP performance is degraded while tracing, you should 
usually disable tracing. 
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Trace Replies Check Box 

To have replies from the host system traced in the ASAP Session window, check the 
Trace Replies check box. To view this trace, choose Session from the View menu of 
the Browse window. Because ASAP performance is degraded while tracing, you 
should usually disable tracing. 

Trace Audits Check Box 

To trace each entity sample in the ASAP Session window, check the Trace Audits 
check box. To view this trace, choose Session from the View menu of the Browse 
window. 

Show CSG Until Connected Check Box 

To display the CSG when ASAP requests a connection to your NonStop™  OS 
host computer, check the Show CSG Until Connected check box. Once 
connected, the CSG is minimized. This option lets you view the progress of the 
connect sequence during ASAP startup. 

Auto Connect to CSG at Startup Check Box 

To let ASAP automatically connect to your host system during startup, check the Auto 
Connect to CSG at Startup check box. If you do not check this check box, ASAP 
prompts you at startup to select what you want to do: Setup, Connect, or Cancel. 

If you enable this option then put ASAP in your Windows Startup Folder, ASAP 
automatically starts when your workstation is powered on, and ASAP automatically 
connects to your host system. 

You can also set up the CSG for automatic operation. For more information, see the 
CSG Common Logon option in the CSG documentation. 

Auto Restart Session Check Box 

The Auto Restart Session check box controls client behavior in the event of a host 
session communications failure. 

If this check box has is selected, the ASAP Client automatically attempts to restart 
failed host session communication. If you do not select this option, the client does not 
restart failed host sessions. This option is enabled by default and is most effective 
when the CSG is configured to use SSGCOM as a Host Service Name. 

For more information about how to configure a SSGCOM host service, enter SSGCOM 
HELP SET VERIFYUSER from a TACL prompt. 
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For more information about how to configure the CSG Host Service Name property, 
run the CSG, select View... Options..., click Help, and view information on the Host 
Service Name field. 

Max Rows/Object Field 

ASAP maintains a hierarchical real-time data cache to minimize the amount of host I/O 
required for standard real-time displays and to provide improved response times for 
specific interactive queries. The Max Rows/Object field specifies the maximum number 
of data rows that ASAP retains for each host object. Some example host objects are 
CPUs, Disks, Line handlers, and Processes. 

The Max Rows/Object field setting controls the amount of history retained for each 
object. Too large of a setting, such as 100, can cause too much data to be retained 
needlessly for each object and a lot of virtual memory cache to be consumed. Too 
small of a setting, such as two, might not let you view enough history for a given 
object. 

For example, if your ASAP SET RATE is five minutes, setting Max Rows/Object to 12 
lets you retain up to one hour's worth of information for each object in the ASAP 
hierarchical cache. 

SSG/CSG Advanced Button 

The Advanced button displays the SSG/CSG Advanced control panel. HPE 
recommends that you not change these settings. 

SSG/CSG Advanced Control Panel 

The SSG/CSG Advanced control panel manages advanced property settings for the 
ASAP session. 

HPE recommends that you not change these settings because client/server settings 
are automatically determined by the ASAP Client. However, advanced users might 
want to use the ASAP Client to analyze nondefault ASAP configurations. 

 

To open the SSG Advanced control panel: 

1. Choose Options from the View menu or click the Properties toolbar button. 

The ASAP Properties window appears. 

2. Click the SSG tab. 

The SSG property sheet appears. 

3. Click the Advanced button. 

The SSG/CSG Advanced dialog box appears. 
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CI Startup Vol Field 

The CI Startup Vol field specifies the default startup volume for the ASAP Server 
configuration. 

The default value when the field is blank is the $SYSTEM.SYSTEM subvolume. By 
default, the ASAP Client and Server normally use the configuration settings contained 
in $SYSTEM.SYSTEM.ASAPCONF. The default database used by the ASAP Client is 
specified in the $SYSTEM.SYSTEM.ASAPCONF file. 

If you want your ASAP client/server session to use another ASAPCONF file, specify 
the subvolume for that ASAPCONF file in this field; for example, 
$MYVOL.MYSUBVOL. 

 

CI Object File Field 

The CI Object File field specifies the name of the ASAP Server command interpreter 
object filename. 

The default object file is ASAP in the $SYSTEM.SYSTEM subvolume. The ASAP 
Client normally uses $SYSTEM.SYSTEM.ASAP as the ASAP Server. 

If you want your ASAP Client Server session to use another ASAP Server command 
interpreter, specify the name of that command interpreter in this field. 

DB Filename Field 

The DB Filename field specifies the name of the ASAP database prefix. The database 
prefix format specifies the volume, subvolume, and DB prefix in the form of 
$Volume.Subvol.DB. 

The default database used by the ASAP Client is the one specified in the ASAPCONF 
file in the default CI Startup Vol. 

If you want your ASAP Client Server session to use another database, specify the 
database prefix in this field; for example, $DATA.ASAPDATA.DB. 

Exit Shutdown Check Box 

When you check the Exit Shutdown check box, the ASAP Client attempts to exit the 
command interpreter on the host server whenever the ASAP Client is shut down. If this 
option is not checked, the Client does not attempt to shut down the server command 
interpreter when the Client is shut down. 

Use this check box to have the ASAP Client clean up the old command interpreter 
when ASAP is shut down and start a new command interpreter each time you start the 
Client. 

HPE recommends that you always check this checkbox because it ensures that the 
client always cleans up on shutdown and creates a fresh copy of its associated ASAP 
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server on the host on startup. If you do not check the Exit Shutdown check box, the 
Client reuses the same command interpreter each time the ASAP client is started. 

 

Data Cache Check Box 

When you check the Data Cache check box, the object-state data cache contained in 
the ASAP Client is cleared when you click OK. Checking this check box erases and 
reinitializes all object-state data in the OIL, OEM, and ASAP. 

If you do not check this check box, all pre-existing object information is retained in the 
ASAP cache, the OIL, and the OEM. 

Check this check box if you do not want object-state information from the previous 
session to be retained, or combined with object-state information from your new client 
server session. Do not check this check box if you want to combine object-state 
information from both the prior session and the new session. 

 

SSG Cache Field 

The SSG Cache field specifies the number of cache pages allocated to your ASAP 
command interpreter in the SeeView Server Gateway. HPE does not recommend 
changing this setting. 

 

Enable Flow Control Option 

The Enable Flow Control option specifies the value of the ASAP Server IOCONTROL 
option for your ASAP Client. This controls the maximum number of output records the 
ASAP Server outputs before waiting for your ASAP Client to ask for more output. 

The I/O Control option controls the maximum amount of system I/O that occurs in each 
client/server request. If your ASAP Server database contains a large number of system 
and application objects, you can greatly reduce memory, I/O, and service times in the 
ASAP Client and Server by enabling this option. If you are experiencing excessive 
ASAP Server loading, set the Enable Flow control option with IOCONTROL equal to 
64. For more information about IOCONTROL, see the ASAP Server HELP SET 
IOCONTROL. 

Disable Flow Control Option 

The Disable Flow Control option disables I/O Flow Control for your ASAP Client 
regardless of your ASAP Server IOCONTROL settings. HPE recommends this option 
only for advanced users. Its purpose is to disable flow control for this client when the 
ASAP Server might be initiating flow control on behalf of other clients. For more 
information about IOCONTROL, see the ASAP Server HELP SET IOCONTROL. 
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Accept Server Initiated Flow Control Option 

The Accept Server Initiated Flow Control option lets the ASAP Server initiate I/O Flow 
Control to your ASAP Client if the ASAP Server SET IOCONTROL option is set. If you 
add this line to your ASAP Server ASAPCONF file, the ASAP Server globally initiates 
I/O Flow Control to all clients from the Server: 

SET IOCONTROL 64 

For more information about this option, see the ASAP Server HELP SET IOCONTROL 
documentation. 

Term Name Check Box 

The Term Name check box controls whether your ASAP client/server session uses 
your fixed workstation name or a dynamic name. When you check the check box, the 
session name is the same as your workstation machine name. When you do not check 
the check box, a dynamic name is created each time a session is started. Avoid 
dynamic names because they create needless reconnect overhead when a new 
session is established. HPE recommends not changing this setting. 

User Name Field 

The User Name field displays the user ID currently logged on to the Client Server 
Gateway. You cannot change this setting. 

Defaults Button 

The Defaults button resets the SSG/CSG Advanced dialog settings to their default 
values. 
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Section 6: Entity Definition 
Language (EDL) 

ASAP provides an Entity Definition Language (EDL) that you can use to define 
abstract entities and their associated properties. To define entities, use ENTITY, 
ATTRIBUTE, DATA, and INCLUDE statements. 

The EDL lets you define system entities, customer application domains, and third party 
entities outside of the ASAP environment. 

Entities defined using the EDL are those entities for which ASAP provides monitoring 
services. After an entity is defined to the ASAP Client, you can monitor its availability, 
statistics, and performance characteristics. 

The notion of entity and attribute are somewhat synonymous with the notion of table 
and column in the SQL data model. You can think of an entity as a table, and an 
attribute as a column in a table. 

 
 

Statement Description Page 

ENTITY Defines an entity and the properties associated with that entity. 
Entity property definitions include information such as the 
command used to retrieve statistics from the host for a given 
entity. 

132 

ATTRIBUTE Associates user-defined attributes with the most recently 
declared entity. Subsequent attribute statements define 
additional attributes of an entity. An attribute of an entity is a 
user-defined property such as a performance or state property. 

 
143 

DATA Facilitates prototyping, testing, and demonstration of entities 
defined in the EDL. The DATA statement lets data be included 
as part of the EDL source file for a given entity. The DATA 
statement lets you associate data with an entity declaration. 

 
154 

INCLUDE Allows inclusion of multiple EDL files. This statement lets you 
distribute EDL information across multiple files and thus share 
entity definitions among various organizations. 

 
155 

RELATION Defines relationships between entities defined with ENTITY 
statements. The RELATION statement allows you to define 
hierarchical relationships between EDL entities and container 
names. 

 
158 

MAP Assigns a relationship between an ObjectID and an Entity. An 
Abstract ObjectID is used as a "handle" to declare hierarchical 
relationships using the RELATION statement. 

161 

 
To get help for EDL source from the EDL Compiler window, position the cursor on a 
syntactical element and press the F1 key. 
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EDL Features and Terminology 

An EDL file is a text file with an EDL file extension. EDL files contain one or more EDL 
statements. 

EDL files provide a portable container for ASAP Client properties and data 
representing the client environment. When an ASAP Client is configured, users and 
developers can decide to share the EDL with other users or workstations. To share 
files, copy and mail the EDL file to another user or workstation. 

The ASAP Browse window FILE menu includes these menu items for exporting, 
importing, and saving EDL files: 

 

FILE… EXPORT EDL 
 

FILE… IMPORT EDL 
 

FILE... COMPILE SERVER EDL 
 

FILE… SAVE EDL 

These functions allow you to export your environment, to import EDL from your 
NonStop™  server, or to open the ASAP EDL IDE (Interactive Development 
Environment) window and export or import entity definitions and associated data. 

The EDL menu items on the ASAP Browse window are not enabled by default. These 
menu items are disabled since access to the EDL IDE is considered to be a somewhat 
advanced feature. The EDL IDE is typically used by application and system 
programmers, not end-users or operators. 

You can enable access to EDL menu items from the ASAP Browse window: 

1. From the ASAP Browse window, select View… Options… 

2. Select the Entity tab of the ASAP Properties window. 

3. Click the EDL file name at the bottom of the Entity Property sheet. 

4. Select one of the following Include Data Statements in EDL options to control 
whether DATA statements appear in Exported EDL: 

 

On Explicit Saves - DATA statements will be included only on explicit SAVE EDL 

actions. 
 

Never - DATA statements are never be included in an exported EDL file. Consider 
this option if you are monitoring a large number of objects (for example, more than 
1000 objects). 
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Always - DATA statements will always be included in an exported EDL file. You 
might not want to select this option if you are monitoring a large number of objects. 

5. Check the Entity Definition Language - Interactive Development Environment 
checkbox to enable the EDL menu items that appear under the File menu of the 
ASAP Browse window. 

6. Check the Enable FILE... Compile Server EDL… menu item check box to enable 
server EDL download and compile. If you do not want this feature enabled, 
uncheck both this check box and the EDL - IDE check box described in the 
previous step. 

7. In the drop-down list labeled On EDL Compile, select either: 
 

- On EDL Compile - Inherit prior entity enabled property 
- On EDL Compile - Do not inherit prior entity properties 

 
These choices indicate whether you want the client to keep previously defined 
entity-enabled properties, or whether the client should use entity enabled 
properties as defined in the EDL file. (Inherit prior entity enabled property... is 
typically preferred). 

8. Click OK. 

The EDL IDE window lets you view EDL source code. The EDL IDE Compiler window 
also lets you edit EDL source and perform interactive EDL compiles and debugging 
actions. Use this window to interactively define and compile ENTITY, ATTRIBUTE, and 
DATA statements. 

To get syntactical Help for EDL source from the EDL Compiler window, position the 
cursor on a syntactical element and either press the F1 key, or click the Help toolbar 
button. 

The ASAP Client setup installs the standard entity definitions for all system entities. 
EDLs installed include ASAP V1 and V2 EDL files. Because the ASAP Client is driven 
from EDL files, the ASAP 2.0 Client can connect to an ASAP 1.0 Server using V1 EDL 
definitions. 

An EDL DATA statement lets you prototype and demo ENTITY and ATTRIBUTE 
definitions using your own custom entity data. The FILE… EXPORT function lets you 
save the ASAP Client session and the Data retrieved from host servers to an EDL file. 
You can then mail the EDL file to any other ASAP Client user for viewing. 

To view EDL files, double-click the EDL file from Microsoft Explorer. This launches 
ASAP, which then compiles the EDL file and graphically displays entities, attributes, 
and data contained in the EDL file. 

To extend the scope of the ASAP environment, use the FILE... IMPORT function. You 
can import HPE System, Customer Application, and Third Party entity definitions into 
the ASAP environment using the FILE… IMPORT function. The IMPORT function lets 
ASAP integrate disjoint, and disparate entity information. 
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EDL Term Description 

Entity Defines a class of objects such as a CPU, Disk, Expand, or Application 
domain. ENTITY statements are used to define entities to the ASAP 
environment. 

Attribute Defines a user-defined property of an entity. Use an ATTRIBUTE 
statement to define an entity attribute in EDL. Attributes include 
properties such as NodeName, CPU Number, CPU Busy, CPU Queue, 
and Transactions. 

Data 
statement 

Optionally defines a simple table of data to associate with an entity. 

 

Factory EDL Files 

The ASAP Client installs factory EDL files when the client is installed. Factory EDL file 
names have the form: 

ASAPn Factory.EDL 

This special EDL file contains the default startup settings for your ASAP environment. 
The ASAP Client compiles the EDL in this file when you first start the client. You 
should not modify factory EDL files. To customize your environment, store your custom 
settings in a custom EDL file. For more information, see Custom EDL Files. 

The factory EDL file name includes the ASAP version number. This version number is 
the ASAP release major version that the EDL represents. For example, in release 2.0 
of ASAP, two factory EDL files are included in the installation: 

 

ASAP1 Factory.EDL 
 

ASAP2 Factory.EDL 

When the ASAP Client connects to the ASAP server, the client determines the version 
of the server. If the server is ASAP V1, the ASAP1 Factory.EDL file is compiled. If the 
server is V2.0, V2.1, V2.2 ... the ASAP2 Factory.EDL file is compiled. 

Custom EDL Files 

The ASAP Client saves your customized entity-attribute settings in EDL files named: 

ASAPn Custom.EDL 

This special EDL file contains custom entity attribute definition settings for your ASAP 
environment. The ASAP Client compiles the EDL statements in a custom EDL file 
when you first start the client. 

The custom EDL file name includes the ASAP version number. This version number is 
the ASAP release major version that the EDL represents. For example, when you 
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customize your ASAP environment, your customized settings are stored in file names 
such as: 

 

ASAP1 Custom.EDL 
 

ASAP2 Custom.EDL 

If you are communicating with the V1 ASAP server, the custom EDL file is named 
ASAP1 Custom.EDL. If you are connected to an ASAP V2 server, the EDL is named 
ASAP2 Custom.EDL. 

You can modify (and share) ASAP Custom EDL files. In fact, custom EDL files are 
automatically modified every time you change any of your property settings on the 
Entity or Attribute Property sheet Tabs in the ASAP Properties window. 

You can copy EDL files among different workstations. Thus the EDL file provides a 
portable container for ASAP Client properties and data representing the client 
environment. Once a given ASAP Client is configured as desired, users and 
developers can share the EDL with other users or workstations. To share, copy or mail 
the EDL file to another user or workstation, and place it in the EDL directory in the 
same path as the ASAP executable. 

EDL IDE Window 

The EDL Interactive Development Environment (IDE) lets you interactively browse, 
open, design, develop, compile, modify, and save entity definition files for your ASAP 
environment. 

The IDE window is your primary interface for developing entity definitions. It includes a 
text area for you to work with EDL source. It also has a built-in EDL file browser that 
lets you quickly open, edit, compile, and save EDL source. The top of the IDE window 
includes toolbar buttons for the most common IDE functions. Pull-down menus provide 
more advanced functions. 

When you successfully compile an entity definition in the EDL environment, that 
definition is automatically added immediately to your ASAP Client environment. If your 
host session is enabled and that same entity was already defined to ASAP Server, 
data for that entity also appears in your ASAP Client windows. The entity also appears 
on the Entity Tab of the ASAP Property sheet. All information about the compiled entity 
is also retained in the ASAP Custom.EDL file so the entity is still there next time you 
run the ASAP Client. 

The ASAP Client, Server, and Extension require EDL files. EDL files let ASAP 
components know about properties of system and application entities as they relate to 
the ASAP environment. 

Entities are defined to ASAP in EDL source files so that Client, Server, and Extension 
components can share entity definitions. ASAP server components and EDL files are 
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distributed across different NonStop™  servers, and Client components and EDL files are 
also distributed across different Microsoft Windows workstations. 

ASAP Client EDL files do not have to include all entities known to the ASAP Server 
and Extension. You can choose to not define various entities, or to define only subsets 
of objects for an entity using the Command Entity property. For more information, see 
Command - EDL Entity Property on page 134. As a result, you can limit which 
entities and objects users normally view from their workstations. 

 

EDL - IDE Access 

To access the EDL IDE window, select either Import EDL or Export EDL from the File 
menu in the main ASAP Browse window. 

The EDL IDE is an advanced feature of the ASAP environment. The IDE is typically 
only used by application and system programmers, not end-users or operations 
personnel. 

Because of this, the environment is not enabled by default. To enable the EDL IDE, 
see EDL Features and Terminology on page 125 Once you enable the IDE, you can 
open the EDL IDE as described here. 

 

Export EDL 

To display the EDL IDE to review or modify the entity, attribute, and data definitions for 
the current ASAP environment, choose Export EDL from the Browse window File 
menu. A dialog box appears prompting you for the type of information you want to 
export into the IDE window. 

When you click OK, ASAP generates EDL source for your current environment and 
displays that source in the EDL IDE window. You can then save or modify EDL files, 
which can contain data from your ASAP session, for later use. You can also e-mail 
EDL files to other users for their use on other workstations. 

 

Import EDL 

To open, design, develop, modify, or display entity and attribute definitions for an EDL 
file, choose Import EDL from the Browse window File menu. An empty EDL IDE source 
window appears, which you can use to create or browse EDL files. 

When you import an EDL entity definition, you can edit and compile it. When you 
successfully compile the definition, it is automatically added immediately to the ASAP 
Client environment. You do not have to exit the Client. 

When you import an EDL entity known to ASAP Server, and your host session is 
enabled, data for that entity appears in the ASAP Client. An imported entity also 
appears on the Entity Tab of the ASAP Property sheet, so it can be enabled or 
disabled later without recompiling the entity. 
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All information about a compiled entity is saved in the ASAPn Custom.EDL file. When 
you later run the ASAP Client, it retains all imported entities and their property settings. 

EDL - IDE Toolbar Buttons 

The most common EDL IDE functions have toolbar buttons: 

 Save text in IDE window 

 Download EDL from server 

 Print text in IDE window 

 Copy text in IDE window to clipboard 

 Cut text in IDE window and save in clipboard 
 

 Paste text into IDE window from clipboard 

 Find or Replace text in IDE window 

 Compile EDL source in IDE window 

 Stop EDL compile 
 

 Step EDL compile one statement at a time 
 

 Display context sensitive help for selected text in EDL window 

Interactive help is available for any EDL statement or reserved word. To get help, 
select the word or token, then click the Help toolbar button. You can also get help by 
moving the cursor over the word or token in question, then press the F1 key. 

The FIND or REPLACE dialog box Time/Date check boxes allow searching for Time in 
the form of hh:mm or Date of the form of yyyy/mm/dd. These check boxes allow 
searching and/or replacing dates and times in EDL source via the EDL IDE window. 

EDL - IDE Pull-Down Menus 

File Menu 

Menu Item Description 

File New Saves and clears IDE window so you can create a new 
EDL file 

New 
Window 

Creates an additional IDE window 

Open Opens File browse view in IDE window 

Download 
EDL 

Download EDL from server 

Save Saves text currently in IDE window 

Save As Displays Save As dialog so you can specify a save file 
name 

Print Prints contents of IDE window 
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Exit Closes IDE window. 
 

Edit Menu 
 

Menu Item Description 

Cut Cut selected text from the IDE window and save it in the clipboard 

Copy Copy selected text from the IDE window and save it in the clipboard 

Paste Paste text into the IDE window from the clipboard 

Select All Select all text in the IDE window 

Find Prompt for target string to search in the IDE window 

Replace Replace selected text in the IDE window 

Cut Line Cut whole line from the IDE window 

View Menu 
 

Menu Item Description 

Font Display font dialog so you can set the default font, style, and 
size 

Browse If checked, display directory-file view in the IDE window 

Control Blocks* If checked, display EDL control blocks during compile 

Control Block to 
Statement* 

If checked, emit source from control blocks during compile 

Show All Files If checked, directory-file view includes all files 

Statements If checked, display statements as they are compiled 

StatusBar If checked, display status bar at bottom of window 

ToolBar If checked, display IDE toolbar 

* Expert features reserved for advanced debugging only. They have a negative impact on EDL compiler 
performance when enabled. 

Run Menu 
 

Menu 
Item 

Description 

Start Compiles source text in the EDL window 

Step Single-steps through the EDL source one statement at a time, for 
debugging. If you step through an EDL file, the entity is not added to the 
environment until all associated attribute statements are successfully 
compiled. 

End Stops an EDL compile started by the Start or Step functions 

The Start EDL Compile function compiles the source text in the IDE window. As the 
compile progresses, the blue progress bar shows the status of the compile. 
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If there are syntax errors, the progress bar turns red and the source statement or token 
in error is automatically selected. Error messages appear in red below the source text. 

When you successfully compile entity definitions in the EDL environment, the progress 
bar turns green, and the definitions are automatically added to your ASAP Client 
environment. Once a compile completes, you can use the ASAP Client immediately to 
analyze data for that entity. 

If you set the enabled attribute to true for a compiled entity known to ASAP Server, and 
your host session is enabled, the ASAP Client displays data for that entity. If the host 
session is not enabled, and there is a Data statement for that entity in the EDL source, 
data for that entity is available for analysis in the ASAP Client. 

To learn to develop in EDL, experiment with Entity, Attribute, and Data statements 
from the IDE window. 

Successfully compiled entities appear with factory entities on the Entity Tab of the 
ASAP Property sheet. Information about the compiled entity is also retained in the 

ASAPn Custom.EDL file, so your entity and property settings are retained for the next 

time you start the ASAP Client. 

To clear all custom settings and non-factory entities, click the Clear Registry button on 
the General property sheet of the ASAP Properties window. To delete an individual 
entity, double-click it on the Entity sheet of the ASAP Properties window and then 
select Delete Entity from the File menu. 

Help Menu 
 

Menu Item Description 

Contents Displays the online help table of contents 

EDL Overview Displays the online help topic EDL Overview 

Syntax Displays low-level grammar for AsapEDLL.DLL 

About Displays the ASAP About box 

EDL - ENTITY Statement 

The ASAP EDL Entity statement lets you define entities and the properties associated 
with an entity. Entity property definitions include information such as the command 
used to retrieve statistics from the host for that entity. 

In ASAP, an entity is a class of objects such as a CPU, Disk, Expand, or Application 
domain. The purpose of the entity statement is to let HPE system entities, customer 
application domains, and third-party entities be defined without modifying ASAP 
internally. 

ENTITY entity-name 
 

CI <String> 134 
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Command <String> 134 

DataItems <String> 135 

Detail <String> 136 

Enabled <Boolean> 136 

ErrorStateName <String> 137 

Help <String> 138 

History <String> 138 

KeyForNode <String> 139 

KeyForObject <String> 139 

KeyForRow <String> 140 

MaxObjectives <Number> 140 

Rate <Number> 140 

Reserved <Boolean> 141 

SGPFile <Filename> 141 

SGPManaged <Boolean> 142 

SGPSuffix <Alpha> 142 

Version <Number> 142 
 

 

Example 

This example defines EDL properties of the CPU entity. These properties determine 
how ASAP retrieves CPU entity information. 

ENTITY CPU CI  ASAP 

COMMAND "CPU\*,RAW,TAB" 

ENABLED YES 

HELP "Central Processor Unit"; 

Entities have different characteristics. For example, the CI property is the Command 
Interpreter used to retrieve information for that entity. The Command entity property 
defines the command that is sent to the command interpreter to retrieve statistics for 
that entity. The Enabled entity property indicates whether the entity is enabled by 
default. The Help entity property defines the descriptive text that appears next to the 
entity name on the Entity Tab of the ASAP Properties window. 

General Syntax Rules 

This list defines general rules of syntax for EDL. To maintain extensibility in the EDL 
grammar, entity and attribute variant values are limited to these elements: 

 

<Alpha> ::= Alpha characters, such as ABC 
 

<AlphaNumeric> ::= AlphaNumeric characters, such as ABC123 
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<Boolean> ::= YES | NO | TRUE | FALSE 
 

<Number> ::= Numeric characters, such as 123 
 

<Quoted-String> ::= Any Chars between double quotes, such as "Any Text, 123" 
 

<String> ::= <Alpha> | <AlphaNumeric> | <Numeric> | <Quoted-String> 
 

Ci - EDL Entity Property 

Ci string 

The Ci entity property defines the name of the command interpreter that provides 
information for this entity. The default value is ASAP; use of other values is not 
supported. 

Applies to: Client and Server 

Default: ASAP 

Example 

CI ASAP 

 

Command - EDL Entity Property 

Command string 

The Command entity property defines one or more commands that are sent to the 
ASAP Server command interpreter. These commands are used to retrieve statistics for 
a given entity. 

A Command must include the "RAW, TAB" formatting options. In most cases, the 
ASAP Client requires the data to be formatted in RAW, TAB format. For example, 
RAW does not zero suppress numeric values, and the TAB option formats output in 
tab delimited columns. App commands should also include the STATE option; for 
example, “RAW, TAB, STATE”. 

Multiple commands can be associated with a given entity. This permits a wide variety 
of possibilities for abstract domains. For example, these commands let subsets of 
objects be associated with an abstract domain: 

 
ENTITY AtmFacet 

CI ASAP 

Command "APP\* ATM\FACET\BEST,RAW,TAB,STATE" -- ATM\FACET\BEST 

Command "APP\* ATM\FACET\ZEIST,RAW,TAB,STATE" -- ATM\FACET\ZEIST 

ENABLED YES; 
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ENTITY CpuSpecial 

CI ASAP 

Command "CPU \Chicago,RAW,TAB" -- Chicago Cpus 

Command "CPU \Newyork,RAW,TAB" -- Newyork Cpus 

Command "CPU \Tuson.0,RAW,TAB" -- Tuson.0 Cpus 

Command "CPU \Tuson.1,RAW,TAB" -- Tuson.1 Cpus 

ENABLED YES; 

 

Applies to: Client and Server 

Default: COMMAND "" 

Examples 

COMMAND "CPU\*,RAW,TAB" -- Cpu Command 

COMMAND "DISK\*,RAW,TAB" -– Disk Command 

COMMAND "LH\*,RAW,TAB" –- Expand Command 

DataItems - EDL Entity Property 

DataItems string 

The DataItems entity property applies only to the entities that are derived from the 
Application Entity. You must define this property for all user-defined application 
entities. 

The DataItems property defines a list of DataItem number base pairs. 

number is a value from 0 through 11. base defines the data item base type. 
 

Base type Description 

C constant 

I integer 

S time units stored as 
seconds 

M time units stored as 
milliseconds 

U time units stored as 
microseconds 

T 8-byte ASCII string 

For more information, see the ASAP Extension Manual. 

Applies to: Server 

Default: DATAITEMS "" 

Example 
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DATAITEMS "0 I, 1 I, 2 M, 3 C" 

 

Detail - EDL Entity Property 

Detail string 

The Detail entity property controls how the Show Object Details popup menu item 
behaves. This property is optional. 

 

When a Detail string is not specified, the ASAP Client automatically displays a 

graph and a list view of object details. 
 

When a Detail string is specified, the contents of string are used to form a 

database query that is sent to the ASAP Server, and the result appears in an 
ASAP Report Window. 

If string contains the “^” character, the name of the object you selected in the Grid or 
Graph area of the ASAP Browse window is substituted. 

For example, if the Detail string for the CPU entity is specified as: 

DETAIL “CPU ^, TAB, SAMPLES 12” 

If you right-click an element in the Browse window graph that corresponds to CPU 
\Chicago.0, then select Show Object Details, an ASAP Report Window displays: 

CPU \CHICAGO.0, TAB, SAMPLES 12 

Applies to: Client and Server 

Default: DETAIL ““ - null 

Examples 

DETAIL “CPU ^, TAB, SAMPLES, 12” 

DETAIL “DISK ^, AVG, TAB, SAMPLES 12” 

Enabled - EDL Entity Property 

Enabled Boolean 

The Enabled entity property defines whether the entity is enabled or disabled by 
default. This property can be set independently within the ASAP Client or Server. The 
option determines the initial default value for the Enabled property. 

Applies to: Client and Server 

Default: ENABLED FALSE 
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Examples 

ENABLED TRUE 

ENABLED FALSE 

ErrorStateName - EDL Entity Property 

ErrorStateName string 

The ErrorStateName entity property defines the name of the attribute that defines the 
error state for this entity. 

Entities are not required to have an error state attribute. But if they do, the error state 
attribute must have values equal to these OEM state values: 

1 - Exists 
2 - Up 
3 - Low 
4 - Medium 
5 - High 
6 - Warning 
7 - Critical 
8 - Down 

 
0 - Remove 

If the property defined by ErrorStateName has a value of 0, the object is marked as 
Removed and does not appear in the ASAP Client unless "Show Removed Objects" is 
checked on the General tab of the ASAP Properties windows. 

Applies to: Client and Server 

Default: ErrorStateName "" -– null 

Example 

ERRORSTATENAME ErrorState –- Note Implies user-defined 

-- attribute named "ErrorState" 

-- exists for current entity. 
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Help - EDL Entity Property 

Help string 

The Help entity property defines the help text associated with the specified entity. This 
text appears to the right of the entity name check box on the Entity Tab of the ASAP 
Properties window. 

Applies to: Client 

Default: HELP "" -– null 

Examples 

HELP "Central Processor Unit" 

HELP "Disk Volumes" 

History - EDL Entity Property 

History string 

The History entity property controls how the Show Object History popup menu item 
behaves. This property is optional. 

 

When a History string is not specified, the ASAP Client automatically tries to 

display a report window on the object. 
 

When a History string is specified, the contents of string are used to form a 

database query that is sent to the ASAP Server, and the result is displayed in an 
ASAP Report Window. 

If the string contains the “ ”̂ character, the name of the object you selected in the 

Grid or Graph area of the ASAP Browse window is substituted. 

For example, if the History string for the Process entity is specified as: 

HISTORY “PROCESS ^, TAB, SAMPLE 12” 

If you right-click an element in the Browse window graph that corresponds to Process 
\Chicago.$MyApp and then select Show Object History, an ASAP Report window 
displays: 

PROCESS \CHICAGO.$MYAPP, TAB, SAMPLES 12 

Applies to: Client and Server 

Default: HISTORY ““ -- null 

Examples 
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HISTORY “CPU ^, TAB, SAMPLES 12” 

HISTORY “DISK ^, AVG, TAB, SAMPLES 12” 

KeyForNode - EDL Entity Property 

KeyForNode string 

The KeyForNode entity property is a string that defines a list of one or more data 

attribute names representing the column attribute names that define the node primary 

key for each object instance of this entity. 

For the CPU entity, the Node Key is the NodeName data attribute. That data attribute 
contains a string that represents the name of the node for each CPU entity instance. 

Applies to: Client 

Default: KeyForNode "" –- null 
 

Example 

KeyForNode "NodeName" -- NodeName contains Node key 

 

KeyForObject - EDL Entity Property 

KeyForObject string 

The KeyForObject entity property is a string that defines a list of one or more data 

attribute names representing the columns that uniquely define the object primary key 

for each object instance of this entity. 

For example for the CPU entity, the Object Key is the CPU data attribute. This attribute 
contains a value that uniquely represents each object instance of this entity. 

Applies to: Client 

Default: KeyForObject "" -- null 
 

Example 

KeyForObject "Cpu" –- Cpu is attribute name of object key 
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KeyForRow - EDL Entity Property 

KeyForRow string 

The KeyForRow entity property is a string that defines a list of one or more data 

attribute names that represent the columns that uniquely define the row primary key 

for each object instance of this entity. 

For example for the CPU entity, the Row Key consists of the Date Time data attributes. 
These attributes contain values that, when concatenated together, uniquely define 
each row instance of this entity. 

Applies to: Client 

Default: KeyForRow "" -- null 

Example 

KeyForRow "Date Time" –- Indicates Date and Time 

-- data attribute contents 

-- are concatenated together to 

-- define each data Row's key. 

 

MaxObjectives - EDL Entity Property 

MaxObjectives Number 

The MaxObjectives property defines the maximum number of objective records that 
can be loaded into memory for the entity. ASAP Server uses this to pre-allocate shared 
memory to hold objective records. The number of objectives varies depending on the 
type of entity. For example, for CPU expect a maximum of 17 objective records (1 for 

CPU entity, and 1 each for CPU\n). For a file, the number could be much larger. 

Applies to: Server 

Default: MaxObjectives 0 

Examples 

MAXOBJECTIVES 17 

 

Rate - EDL Entity Property 

Rate Number 

The Rate entity property defines the update interval expected for a given entity. The 
interval value is specified in minutes. 
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If the Rate property is not specified for a given entity, the entity sampling rate is 
determined by the global ASAP server SET RATE value. The ASAP Client uses a 
nonzero RATE associated with an entity to determine whether data for that entity is too 
late (or too early). Late data provides an overall health indicator for a given entity or 
subsystem because late data can indicate that an entity is down, hung, or that time of 
day is not synchronized between different nodes. 

If the Time attribute property for an entity has state determination enabled for it by 
setting Graph True, the Rate entity property is used to determine whether data for this 
entity is late. 

If a Rate entity is not specified for a given entity, the global ASAP server SET RATE 
value is used to determine whether the sample time for an entity is too late or too early. 
This property is used for early or late detection, but does not affect the client if the time 
property for an entity is not graphed. 

Applies to: Client 

Default: RATE 0 

Examples 

SET RATE 1 -- One minute update expected 

 

Reserved - EDL Entity Property 

Reserved Boolean 

The Reserved entity property defines whether the entity is treated as a reserved entity. 
Reserved entities are defined by HPE. If reserved is not true, it is assumed to be 
externally defined by a user or third party application. 

Applies to: Client and Server 

Default: Reserved FALSE 

Example 

RESERVED FALSE 

 

SGPFile - EDL Entity Property 

SGPFile Filename 

The SGPFile entity property defines the object code filename of the SGP program that 
is responsible for this entity. If the entity's SGPMANAGED property is not TRUE, this 
property has no meaning. 

Applies to: Server 
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Default: SGPFile "" 

Examples 

SGPFile "$SYSTEM.SYSTEM.ASAPDSK" -- Disk SGP code file 

SGPFile "$SYSTEM.SYSTEM.ASAPEXP" -- Expand SGP 

SGPFile "$SYSTEM.SYSTEM.ASAPXSGP" -- App SGP 

 

SGPManaged - EDL Entity Property 

SGPManaged Boolean 

The SGPManaged entity property indicates whether the Statistics Gathering Process is 
to be managed by the ASAP subsystem. A managed SGP is one that can be started, 
get status, and shutdown via the ASAP STARTUP, STATUS, and SHUTDOWN 
commands. 

Applies to: Server 

Default: SGPManaged FALSE 

Examples 

SGPMANAGED YES -- YES and TRUE mean the same thing 

SGPMANAGED TRUE 

SGPSuffix - EDL Entity Property 

SGPSuffix Alpha 

The SGPSuffix entity property defines the alpha character that is appended to the end 
of the ASAP ID suffix in order to form a unique process ID for the given entity SGP. For 
more information, see the ASAP Server SET ID command. 

Applies to: Server 

Default: SGPSuffix "" 

Examples 

SGPSUFFIX J -- DISK SGP's process ID would be $ZOOJ 

SGPSUFFIX H -- APP SGP's process ID would be $ZOOH 

Version - EDL Entity Property 

Version number 
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The Version entity property defines the version number of the Entity definition. 

The version number is used by the ASAP Client and Server to validate that they are 
both using the same version of the Entity definition. Providing a version number on 
both the Client and Server lets the ASAP Client verify that the Entity definition on the 
Client matches the Entity definition on the Server. 

Although the Version property is optional, HPE recommends that you always specify 
an entity version. 

When a Version number is not defined in either the Client or Server Entity definition, no 
version checks are performed by either the Client or the Server (in other words, the 
Entity definitions are assumed to match). This implies that removing the version option 
from an Entity can force the client to use the current entity definition, even if that 
definition does not match the server’s definition of the entity. For this reason, 
HPE recommends you always provide or update the version number when 
creating or updating an Entity definition. 

When a Version number is associated with both the Client and Server Entity 
definitions, the ASAP Client validates that the two versions match on every query. If 
they do not match, the Client issues a warning. 

For ASAP System entities, this convention is used for Version numbers: 

N.ymmdd 

Where N represents the major version of the Entity, y represents the last digit of the 

year, mm represents the month, and dd represents the day of the month that the entity 

definition was last modified. For example, a system entity with a Version 2.01027 was 
updated on 2000/10/27. 

Applies to: Client and Server 

Default: VERSION ““ - null 

Examples 

VERSION 2.01027 

VERSION 2.001 

 

EDL - ATTRIBUTE Statement 

The attribute statement associates user-defined attributes with the most recently 
defined entity. Since attribute statements are associated with an entity they must be 
proceeded by an entity statement. Subsequent attribute statements define additional 
attributes of an entity. 
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The notion of entity and attribute are synonymous with table and column in the SQL 
data model. An entity can be thought of as a table. An attribute can be thought of as a 
column in a given table. 

An attribute is a user-defined property of an entity such as Node Name, or CPU 
number. An attribute can also be a performance or state property such as a Status 
string attribute or its associated Operational State property. 

The Attribute statement syntax is: 

ATTRIBUTE attribute-name 
 

Align LEFT | RIGHT 145 

Format <String> 146 

Graph <Boolean> 147 

GraphMax <Number> 147 

Grid <Boolean> 148 

Heading <String> 148 

HeadPickup <Boolean> 149 

Help <String> 150 

MetricRule <String> 150 

StatePair <Boolean> 151 

StateIsOp <Boolean> 152 

StateRule <String> 153 

TypeData INT | INT32 | INT64 | REAL64 | CHARnn 154 

 

Attribute definition keywords 

These attribute definition keywords are keywords in EDL that define characteristics of 
user-defined attributes for an entity. These characteristics let ASAP provide specific 
availability monitoring services for user-defined attributes. 

Example 

This example shows user-defined attributes for the CPU entity. These attributes 
determine how the ASAP Client displays and analyzes CPU attribute properties such 
as CPU Number, Busy, Queue, and Swap rate. 

ENTITY Cpu 

CI ASAP 

Command "CPU \*,RAW,TAB" 

Enabled YES 

Help "Central Processor Units" 

KeyForNode NodeName 

KeyForObj Cpu 

KeyForRow "Date Time" 

Reserved YES; 
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AT NodeName GRID YES GRAPH NO GRAPHMAX 0 HELP "NSK System Name"; 

AT Sysnum GRID NO GRAPH NO GRAPHMAX 0 HELP "System Number"; 

AT Cpu GRID YES GRAPH NO GRAPHMAX 0 HELP "CPU Number"; 

 

AT Status GRID YES GRAPH YES GRAPHMAX 0 HELP "Operational Status" 

STATEPAIR YES STATEISOP YES 

STATERULE UseStateGraphState 

TYPE CHAR5; 

AT OpState GRID NO GRAPH NO GRAPHMAX 9 HELP "Operational State"; 

AT Date GRID NO GRAPH NO GRAPHMAX 0 HELP "Date of Stats"; 

AT Time GRID YES GRAPH YES GRAPHMAX 0 HELP "Time of Stats"; 

AT Valid GRID NO GRAPH NO GRAPHMAX 0 HELP "Validity Flag"; 

AT CpuType GRID NO GRAPH NO GRAPHMAX 0 HELP "Processor Type"; 

AT ET GRID NO GRAPH NO GRAPHMAX 0 HELP "Elapsed Minutes"; 

AT Busy GRID YES GRAPH YES GRAPHMAX 100 HELP "Percent Cpu Busy" 

HEADING "Busy%"; 

AT Queue GRID YES GRAPH YES GRAPHMAX 10 HELP "Cpu Queue Length"; 

AT Disp GRID YES GRAPH YES GRAPHMAX 5000 HELP "Dispatch rate"; 

AT Disk GRID YES GRAPH YES GRAPHMAX 100 HELP "Disk I/O rate"; 

AT Chit GRID YES GRAPH YES GRAPHMAX 100 HELP "Disk Cache Hit rate"; 

AT Swap GRID YES GRAPH YES GRAPHMAX 10 HELP "Memory Swap rate"; 

 

In this example, the NodeName attribute has its Show GRID attribute property set to 
YES and GRAPH attribute property set to NO. The GRAPH property is not enabled 
because it does not make sense to graph a node name. 

Also, the user-defined CPU attribute defines the CPU number and has HELP text 
"CPU Number". 

The Status attribute has both the GRID and GRAPH properties set to YES. Setting 
GRAPH to YES implies the status of the CPU entity will be analyzed. In the example, 
the Status attribute is paired with an attribute called OpState. 

When an attribute has a state associated with it, as does the Status attribute, the 
STATEPAIR YES and STATERULE UseStateGraphState properties are set. In this 
case, the status property is special in that its associated state is earmarked as the 
operational state of the object, as indicated by STATEISOP YES. 

The user-defined Busy attribute has its GRID and GRAPH properties enabled, so the 
busy value has a state assigned to it by the ASAP Client. The Busy value is 
normalized with its GraphMax property. Because Busy is a value from 0 through 100 
percent, the correct GraphMax value is 100. 

 

Align - EDL Attribute Property 

Align Left | Right | "" 

 

The Align attribute property defines how the ASAP Client aligns the display of defined 
attributes. If no align option is specified, the client uses its own set of rules to 



HPE NonStop ASAP Client Manual Page 146 of 161  

determine how best to align attribute data. The Align attribute property might not affect 
certain user defined attributes. 

Align Left causes the Client to left align data for the associated attribute. 

Align Right causes the Client to right align data for the associated attribute. 

Align “” causes the client to align data based on internal best-fit client rules. 

Applies to: Client 

Default: ALIGN "" 

Examples 

ALIGN LEFT 

ALIGN RIGHT 

ALIGN "" 

 

Format - EDL Attribute Property 

Format Fw.d | Iw | Sw | String 

The Format attribute property defines how the ASAP Server should format a user- 
defined attribute. The format options are: 

 

Fw.d Display decimal, w = total width, and d = digits to right of decimal point. 

Iw Display data as integer, w = total width of display right justified. 

Sw Display data as string, w = total width of display left justified. 

String Any other Format option known to the ASAP Command Interpreter, such as 

hh:mm:ss. If format string is not a simple AlphaNumeric token, then it must be enclosed 

in quotes. 

Applies to: Server and Client 

This property determines how the ASAP Server formats the attribute value. Although 
the ASAP Client interprets the data, the Client does not modify the way the Server 
displays the data. 

The FORMAT should match the TYPEDATA of the attribute. For example, you must 
use a string format ("S8") if TYPEDATA is defined as a character string (CHAR8). 

A decimal format, such as "F6.2", is normally used only with a TYPEDATA of REAL64. 
However, if you define a decimal format and a TYPEDATA of INT, INT32 or INT64, 
ASAP stores the value using an implied decimal point. For example, a value of 123.45 
is stored as 12345 if FORMAT is "F6.2" and TYPEDATA is INT, INT32, or INT64. 
Implied decimal points are used in both the Process and TMF entities, and they can 
also be used in any application entity. 

Default: Null 
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Examples 

Format “F5.2” -- 12.45 

Format I8 -- 12345678 

Format S8 -- PathDown 

 

Graph - EDL Attribute Property 

Graph Boolean 

The Graph attribute property determines whether a user-defined attribute has state 
analysis performed on it by the ASAP Client. If the Graph attribute property is enabled 
(TRUE or YES), the attribute has a state assigned to it (either directly through client 

numerical analysis, or indirectly through an associated data, state pair). 

This property controls whether the ASAP Client analyzes an attribute and assigns a 
state to it. The Client assigns a state to each graphed attribute based on the attribute's 
StateRule setting. For more details, see the StateRule section. 

If more than one attribute has its Graph property enabled, the attribute with the highest 
state is said to be the state of the object. In this manner, each object has a state 
assigned to it. 

When an object has a state assigned to it, the graph for that object is color-coded 
according to the state of the object. The corresponding value in the grid portion of the 
ASAP Client Browse window is also annotated with the state icon. 

Applies to: Client 

This property appears on the Attribute Tab of the ASAP Client Properties Window and 
is documented as the Show In Graph property. 

Default: False 

Examples 

AT Busy GRAPH YES GRID YES GRAPHMAX 100 HELP "Percent Cpu Busy" 

HEADING "Busy%"; 

AT Status GRAPH YES GRID YES GRAPHMAX 9 HELP "Operational Status" 

STATEPAIR YES, STATERULE UseStateGraphState, STATEISOP YES; 

 

GraphMax - EDL Attribute Property 

GraphMax Number 

The GraphMax attribute property defines the maximum value used to normalize a 
user-defined attribute. When an attribute has its Graph property enabled (TRUE or 
YES), the Graph-Max value is used to normalize the value of that attribute. 
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The Graph-Max value appears in the ASAP Client as the unlabeled field immediately 
to the right of the Show in Graph check box. This value determines the maximum 
graph amplitude or normalization value for the attribute. For example, if the attribute 
Queue has a Graph-Max value of 10, and the value of the Queue attribute is 5, the 
Queue value appears in the graph at one-half of the maximum graph height. 

Graph-Max values are used when StateRule is UseThresholds, and the Graph Percent 
check box is selected on the Graph property sheet. 

Applies to: Client 

This property appears on the Attribute tab of the ASAP Client Properties window. 

Default: False 

Examples 

AT Busy GRAPH YES GRID YES GRAPHMAX 100 HELP "Percent Cpu Busy" 

HEADING "Busy%"; 

AT Status GRAPH YES GRID YES GRAPHMAX 9 HELP "Operational Status" 

STATEPAIR YES, STATERULE UseStateGraphState, STATEISOP YES; 

 

Grid - EDL Attribute Property 

Grid Boolean 

The Grid attribute property indicates whether a user-defined attribute is displayed in 
the Grid portion of the Browse window of the ASAP Client. If the Grid attribute property 
is enabled (TRUE or YES), the attribute value appears in the Grid. 

Applies to: Client 

This property appears on the Attribute tab of the ASAP Client Properties window and is 
documented as the Show In Grid property. 

Default: False 
 

Examples  

AT NodeName GRID YES GRAPH NO GRAPHMAX 0 HELP "NSK System Name"; 

AT Sysnum GRID NO GRAPH NO GRAPHMAX 0 HELP "System Number"; 

AT Cpu GRID YES GRAPH NO GRAPHMAX 0 HELP "CPU Number"; 

 
Heading - EDL Attribute Property 

Heading String 

The Heading attribute property defines the string of text that appears in the heading 
for a user-defined attribute. 
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If the Heading is not specified then it defaults to the attribute-name. 

If heading is specified it appears in the heading instead of the attribute-name. 

Applies to: Client and Server 

This property appears in the ASAP Client Properties window as the Attribute name. 

Default: attribute-name 

Example 

AT Busy GRID YES GRAPH YES GRAPHMAX 100 HELP "Percent Cpu Busy" 

HEADING "Busy%"; 

 

HeadPickup - EDL Attribute Property 

HeadPickup Boolean 

The HeadPickup attribute property indicates whether the heading associated with a 
user-defined attribute is fixed or dynamically derived from the heading the ASAP 
Server displays. 

If HeadPickup is enabled (TRUE or YES), then the heading defined by the ASAP 
Server appears, rather than the Heading property associated with the attribute. 

If HeadPickup is not enabled, the heading is the defined by the Heading string. 

Applies to: Client 

Default: False 
 

Examples 

AT Metric01 GRAPH YES GRID YES HEADPICKUP YES; – use server 

AT Metric02 GRAPH YES GRID YES HEADPICKUP NO; – use client 
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Help - EDL Attribute Property 

Help String 

The Help string attribute property defines the Help text displayed by the ASAP Client 

when you move the mouse over a user-defined attribute in the grid portion of the ASAP 
Client Browse window. This help text also appears on the Attribute tab of the ASAP 
Client Properties window. 

Applies to: Client 

Default: "" - null 

Examples 

ENTITY CPU CI ASAP, 

COMMAND "CPU\*,RAW,TAB" , 

NodeKey NodeName, 

ObjectKey Cpu, 

RowKey "Date Time", 

ENABLED YES, 

HELP "Central Processor Unit"; 

AT NodeName GRID YES GRAPH NO GRAPHMAX 0 HELP "NSK System Name"; 

AT Sysnum GRID NO GRAPH NO GRAPHMAX 0 HELP "System Number"; 

AT Cpu GRID YES GRAPH NO GRAPHMAX 0 HELP "CPU Number"; 

 

AT Status GRID YES GRAPH YES GRAPHMAX 0 HELP "Operational Status" 

STATEPAIR YES, STATERULE UseStateGraphState, STATEISOP YES; 

AT OpState GRID NO GRAPH NO GRAPHMAX 9 HELP "Operational State"; 

AT Date GRID NO GRAPH NO GRAPHMAX 0 HELP "Date of Stats"; 

AT Time GRID YES GRAPH YES GRAPHMAX 0 HELP "Time of Stats"; 

AT Valid GRID NO GRAPH NO GRAPHMAX 0 HELP "Validity Flag"; 

AT CpuType GRID NO GRAPH NO GRAPHMAX 0 HELP "Processor Type"; 

AT ET GRID NO GRAPH NO GRAPHMAX 0 HELP "Elapsed Time Mins"; 

AT Busy GRID YES GRAPH YES GRAPHMAX 100 HELP "Percent Cpu Busy" 

HEADING "Busy%"; 

AT Queue GRID YES GRAPH YES GRAPHMAX 10 HELP "Queue Length"; 

 

MetricRule - EDL Attribute Property 

MetricRule String 

The MetricRule attribute property applies to the Application entity. 

The MetricRule property defines how the metric value is to be produced using a 
formula consisting of various Application entity DATAITEMs, constants, and time 
intervals. 

User-defined Application attributes must have a metric rule or formula associated with 
them. For complete details, see the ASAP Extension Manual. 
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The MetricRule string contains a formula in ASAP extension format for the metric so 
that its value can be properly computed. See Format - EDL Attribute Property on 
page 146. 

Applies to: Server 

Default: null 

Examples 

AT TranCount METRICRULE "#1"; 

AT TranRate METRICRULE "#1/S" FORMAT F10.2; 

AT OkPercent METRICRULE "#1/(#0+#1)*C100" FORMAT F6.2 

 

StatePair - EDL Attribute Property 

StatePair Boolean 

The StatePair attribute property indicates whether a user-defined attribute has a state 

associated with it in the form of a data, state pair. 

When the StatePair property is TRUE for a user defined attribute, this implies the 
attribute must be immediately followed by another attribute whose value represents the 
OEM state of the data attribute. 

In the ASAP Client, attributes can be assigned a state according to the StateRule 
property. Certain attributes can have a state value specifically associated with them. 
When they do, the StatePair property should be TRUE for those attributes. 

The ASAP Client performs state analysis of a user-defined attribute whenever the 
Graph property is enabled for that attribute. 

When you define an attribute, you can have the ASAP Client perform state 
determination for that property by setting the Graph attribute property TRUE. The state 
is assigned to the attribute using the StateRule attribute property. 

When the StatePair attribute is enabled, and StateRule is UseStateGraphState or 
UseStateGraphValue, the state of the attribute is derived directly from the associated 

state in the data, state pair. 

Notes 

The Client assigns a state to each graphed attribute based on the attribute's StateRule 
setting for that data attribute. For more information, see StateRule - EDL Attribute 
Property on page 153. 

When StatePair is specified for a user-defined attribute, that attribute must have its 
TypeData property defined. Specifying TypeData lets ASAP determine how to treat the 
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user-defined attribute; for example, what type of number the attribute represents. For 
more information, see TypeData - EDL Attribute Property on page 154. 

Applies to: Client and Server 

This property appears in the Attribute tab of the ASAP Client Properties window. 

Default: False 

Examples 

AT Status GRID YES GRAPH YES GRAPHMAX 0 

STATEPAIR YES –- Implies Status has associated state 

STATEISOP YES –- Implies State is operational state of obj 

STATERULE UseStateGraphState 

HELP "Operational Status"; 

AT OpState GRID NO GRAPH NO GRAPHMAX 9 

HELP "Operational State of object"; 

 

StateIsOp - EDL Attribute Property 

StateIsOp Boolean 

The StateIsOp attribute property indicates whether the state of an attribute represents 
the overall Operational State of the object. 

When the StateIsOp attribute is TRUE, the attribute is flagged as having an important 
distinction between it and all other attributes. The attribute flagged as StateIsOp 
indicates the overall operational state of the object. 

If the state associated with a StateIsOp attribute is warning, the operational state of the 
overall object is said to be in a warning state. Contrast this with a performance attribute 
such as busy when its state reaches a warning level, the utilization of the object has 
exceeded a warning level but is not necessarily in a warning state. 

Considerations 

When StateIsOp is TRUE, StatePair is typically also TRUE. 

Usually, only one attribute for an entity has its StatIsOp attribute property set to TRUE. 

Applies to: Client and Server 

Default: False 
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Example 

AT Status GRID YES GRAPH YES GRAPHMAX 0 

STATEPAIR YES –- Implies Status has associated state 

STATEISOP YES –- Implies State is operational state of obj 

STATERULE UseStateGraphState 

HELP "Operational Status"; 

AT OpState GRID NO GRAPH NO GRAPHMAX 9 

HELP "Operational State of object"; 

 

StateRule - EDL Attribute Property 

StateRule String 

The StateRule attribute property defines how the ASAP Client determines the state of 
an attribute. 

Where String must be one of: 

UseThresholds 

UseValueGraphValue 

UseStateGraphValue 

UseStateGraphState 

Applies to: Client 

Default: UseThresholds 

 

State Determination 
Rule Value 

Attribute State Information Determined More 
Information 

UseThresholds By the ASAP Client using the percentage 
thresholds specified with the Utilization 
Thresholds sliders. 

87 

UseValueGraphValue Directly by the value of the attribute. 88 

UseStateGraphValue By the state variable associated with that 
attribute. The attribute’s value is graphed. 

88 

UseStateGraphState By the state variable associated with that 
attribute. The state value is graphed. 

88 

For detailed descriptions, see State Determination Options on page 87. 
 

Examples 

AT Status GRID YES GRAPH YES GRAPHMAX 0 HELP "Operational Status" 

STATEPAIR YES STATERULE UseStateGraphState STATEISOP YES; 

 

AT TranCount METRICRULE "#1" 

STATEPAIR YES STATERULE UseStateGraphState; 

AT TranRate METRICRULE "#1/S" FORMAT F10.2 
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STATEPAIR YES STATERULE UseStateGraphState; 

 

TypeData - EDL Attribute Property 

TypeData String 

The TypeData attribute property defines the data type of a user-defined attribute. 
Possible data types are: 

INT | INT32 | INT64 | REAL64 | CHARnn 

 

Applies to: Server 

Default: NULL 

Example 

AT TranCount METRICRULE "#1" 

STATEPAIR YES STATERULE UseStateGraphState 

TYPEDATA REAL64; 

AT TranRate METRICRULE "#1/S" FORMAT F10.2 

STATEPAIR YES STATERULE UseStateGraphState 

TYPEDATA REAL64; 

 

EDL - DATA Statement 

The EDL includes a DATA statement that facilitates entity prototyping, testing, and 
demonstration. The DATA statement lets you associate data with an entity declaration. 

The DATA statement lets availability, statistics, and performance information be 
included as part of the EDL source file for an entity. DATA statements can be 
automatically generated along with entity definitions when the FILE… EXPORT EDL 
function is selected from the ASAP Browse window. This capability is useful for saving 
the environment, as well as prototyping what if scenarios. The DATA statement lets 
any type of data be imported into the ASAP Client. 

The layout of the DATA statement syntax is a what-you-see-is-what-you-get 
composition that mirrors the desired result: 

DATA entity-name 

heading1 heading2 heading3 ... 

-------- -------- -------- 

\col1dat col2data col3data ... 

\col1dat col2data col3data ... 

... 

.. 

; -- semicolon terminates statement 
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Considerations 
 

Each record after the DATA statement is stored in the ASAP object cache for the 

entity specified as entity-name. 
 

The DATA statement must be terminated with a semicolon after the first record that 

does not begin with a backslash. 
 

Column widths are determined by the number of dashes in the heading for each 

column. 
 

Data record attribute properties must align with the corresponding dashes 

character underlining headings. Data records represent the contents of attribute 

data columns. If columns are not aligned, data is truncated to fit under the column 

definitions. 

Applies to: Client 

Default: Null 
 

Example  

DATA CPU 

Node Num Cpu Stats Op Dateymd Time CpuType Et Bsy QL Disp 

-------- --- --- ----- -- ---------- ----- ------- --- --- -- ---- 

\CENTDIV 051 00 Up 2 1999/12/21 20:48 K10000 1 3 0 51 

\CENTDIV 051 01 Up 2 1999/12/21 20:48 K10000 1 5 0 97 

\CHITOWN 153 00 Up 2 1999/12/21 20:47 K1000 1 3 0 22 

\CHITOWN 153 01 Up 2 1999/12/21 20:47 K1000 1 2 0 19 

\WINE 242 00 Up 2 1999/12/21 20:48 K1000 1 2 0 18 

\WINE 242 01 Up 2 1999/12/21 20:48 K1000 1 1 0 8 

\DOME 245 00 Up 2 1999/12/21 20:48 S70000 1 2 0 158 

\DOME 245 01 Up 2 1999/12/21 20:48 S70000 1 1 0 57 

\ISLAND 249 01 Up 2 1999/12/21 20:47 K2000 1 2 0 22 

\ISLAND 249 02 Up 2 1999/12/21 20:47 K2000 1 1 0 12 

\ISLAND 249 03 Up 2 1999/12/21 20:47 K2000 1 0 0 3 

;            

 

EDL - INCLUDE Statement 

The INCLUDE statement lets you include multiple EDL files. This statement lets you 
distribute EDL information across multiple files, thus letting you separate entity 
definitions among various organizations and companies. 

INCLUDE filename ; 

 

Applies to: Client and Server 
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Example 

HPE developers must be able to define system entities in one EDL file, perhaps named 
AsapSys. 

Users must be able to define application entities in EDL files of your own, perhaps one 
of which is named AsapApp. 

Using this approach, INCLUDE statements let you modify application entity definitions 
in AsapApp, and lets development organizations contain their system entity definitions 
in AsapSys, without either group having to edit files belonging to the other. 

These notions can be extended to include third parties. 

Files can be brought together via wrapper EDL files: 

$System.System.AsapEDL: 

INCLUDE AsapSys; 

INCLUDE AsapApp; 

Include - Spanning Considerations 

Two restrictions relate to INCLUDE statements: 

Statement Spanning Restriction #1: 

No single EDL statement can span multiple EDL files. You cannot begin a statement in 
one file and complete it in another file. Any single EDL statement must be entirely 
contained within a single EDL file. 

Entity-Attribute Spanning Restriction #2: 

No single Entity definition can span multiple EDL files. A specific Entity definition must 
be entirely contained within a single file. This restriction refers not only to the Entity 
statement but to all associated Attribute statements. 

Thus both an Entity statement and all associated Attributes must be entirely contained 
within one EDL file. 

You cannot begin an entity definition in one file, and complete it in another file. 
 

Include - Default Path/Subvol 

The INCLUDE filename can either a fully qualified file name, or it can be a partially 
qualified file name. 

Examples 

INCLUDE "C:\My Projects\ASAP\EDL\Asap2 Factory"; 
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INCLUDE Asap2App; 

INCLUDE Asap2Sys; 

 

INCLUDE $SYSTEM.SYSTEM.ASAPEDL; 

INCLUDE Asap2App; 

INCLUDE Asap2Sys; 

When filename is partially qualified, the default path or subvolume for that file is the 

same as the path or subvolume of the parent file that included the INCLUDE 
statement. For example, if a file $SYSTEM.SYSTEM.ASAPEDL contains INCLUDE 
statements with simple file names, those INCLUDE files have a default subvolume of 
$SYSTEM.SYSTEM, which is the same as the parent EDL file name. 

INCLUDE $SYSTEM.SYSTEM.ASAPEDL; 

INCLUDE Asap2Sys; 

INCLUDE Asap2App; 

Path or subvolume inheritance lets related INCLUDE files be grouped or moved 
together without embedding fully qualified file names. 

 

File Names With Special Characters, or Embedded Blanks 

If a filename includes special characters or blanks, it must be enclosed in double 

quotes. For example: INCLUDE "C:\My Projects\ASAP\EDL\Asap2 Factory"; 

Included EDL file names do not have to have the .EDL extension in the INCLUDE 
statement. 

File Names Limited to 40 Characters 

An include filename is limited to a total of 40 characters in length. 

Statement Termination 

INCLUDE statements, like any other EDL statements, must be terminated with a 
semicolon. 

This example shows how to use the INCLUDE statement to distribute entity definitions 
across multiple files: 

$System.System.AsapEDL: 

INCLUDE AsapSys; 

INCLUDE AsapApp; 

 

$System.System.AsapSys: 

INCLUDE AsapCpu; 

INCLUDE AsapDisk; 

INCLUDE AsapExpand; 

 

$System.System.AsapApp: 
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INCLUDE Atm; 

INCLUDE Funds; 

INCLUDE Teller; 

INCLUDE $DATA.THIRD.PARTY; 

 

$Data.THIRD.PARTY: 

INCLUDE ACI; 

INCLUDE EDS; 

INCLUDE DATX; 

 

EDL-Relation Statement 

The RELATION statement allows you to define hierarchical relationships between EDL 
entities and container names. This aspect of EDL is sometimes referred to as RDL. 

The following describes the Relation statement syntax: 

RELATION OBJECT <ObjectID> 

PARENT <Parent-ObjectID> | NULL 

CAPTION <Container-Name> | INSTANCE 

<ObjectID> is an alpha-numeric symbol used as an abstract "handle" to declare 
hierarchical relationships between entities and containers. A container name can be 
declared with the CAPTION option. A container can be used to "contain" other entities 
and/or containers. An ObjectID's parent ObjectID can be declared using the PARENT 
option. 

PARENT defines the relationship between the ObjectID in the current Relation 
statement and the ObjectID in the next higher level of the hierarchy. NULL means you 
are at the top of the hierarchy. 

CAPTION defines either a fixed <container-name> such as CAPTION "TCP/IP". Or, a 

<container-name> can also be specified as CAPTION "*" to indicate any text can 
appear at that level of the hierarchy. If a Caption is declared then INSTANCE should 
not be declared for that Relation statement. 

INSTANCE indicates that the ObjectID in the current Relation statement is the name of 
an EDL Entity previously declared. 

Considerations 

ObjectID container and instance associations for an entity can be further specified with 
the EDL MAP <ObjectID> TO <EntityName> statements shown below. 

Entity Relationships defined with EDL RELATION statements must match the actual 
domain names used by all components of ASAP. For example, system entity object 
names and containers cannot be modified using Relation statements. 
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Applies To: Client 

Example 

-------------------------------------------------------------------- 

-- RELATIONs -- 

-------------------------------------------------------------------- 

RELATION OBJECT * PARENT NULL; -- clears all 

-------- Node container \Nodename 

RELATION OBJECT NodeClass PARENT NULL Caption *; 

-------- TCPIP container \Nodename\Tcpip 
 

RELATION 

-------- 

RELATION 

RELATION 

OBJECT 

ICMP 

OBJECT 

OBJECT 

TcpipClass 

 

IcmpClass 

TcpICMP 

PARENT NodeClass Caption "Tcpip"; 

\Nodename\Tcpip\Icmp\$Ztc01 

PARENT TcpipClass Caption "Icmp"; 

PARENT IcmpClass INSTANCE; 

-------- IP  \Nodename\Tcpip\Ip\$Ztc01 

RELATION OBJECT IPClass PARENT TcpipClass Caption "Ip"; 

RELATION OBJECT TcpIP PARENT IPClass INSTANCE; 

-------- QIO  \Nodename\Tcpip\Qio\$Ztc01 

RELATION OBJECT QioClass PARENT TcpipClass Caption "Qio"; 

RELATION OBJECT TcpQIO PARENT QIOClass INSTANCE; 

-------- ROUTE  \Nodename\Tcpip\Route\$Ztc01\#Rt1 

RELATION OBJECT RouteClass PARENT TcpipClass Caption "Route"; 

RELATION OBJECT RoutePidClass PARENT RouteClass Caption *; 

RELATION OBJECT TcpROUTE PARENT RoutePidClass INSTANCE; 

-------- RTE  \Nodename\Tcpip\Rte\$Ztc01 

RELATION OBJECT RteClass PARENT TcpipClass Caption "Rte"; 

RELATION OBJECT TcpRTE PARENT RteClass INSTANCE; 

-------- SUBNET  \Nodename\Tcpip\Subnet\$Ztc01\#Loop 

RELATION OBJECT SubnetClass PARENT TcpipClass Caption "Subnet"; 

RELATION OBJECT SubnetPidClass PARENT SubnetClass Caption *; 

RELATION OBJECT TcpSUBNET PARENT SubnetPidClass INSTANCE; 

-------- TcpProcess\Nodename\Tcpip\Tcp\$Ztc01 RELATION OBJECT

 TcpClass PARENT TcpipClass Caption

 "Tcp"; RELATION OBJECT 

 TcpProcess PARENT TcpClass INSTANCE; 

-------- PORT  \Nodename\Tcpip\Port\00021\$Ztc01\$Znes\1 

RELATION OBJECT PortClass PARENT TcpipClass Caption "Port"; 
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RELATION OBJECT  PortNumClass  PARENT PortClass   Caption   *; 

RELATION OBJECT PortPid1Class PARENT PortNumClass  Caption  *; 

RELATION OBJECT PortPid2Class PARENT PortPid1Class Caption  *; 

RELATION OBJECT TcpPORT PARENT PortPid2Class INSTANCE; 

-------- UDP \Nodename\Tcpip\Udp\$Ztc01 

RELATION OBJECT UDPClass PARENT TcpipClass Caption "Udp"; 

RELATION OBJECT TcpUdp PARENT UDPClass INSTANCE; 

-------- TELSERV \Nodename\Telserv 

RELATION OBJECT TelservClass PARENT NodeClass Caption "Telserv"; 

-------- TelservProcess \Nodename\Telserv\Process\$Ztn00 

RELATION OBJECT ProcessClass PARENT TelservClass Caption "Process"; 

RELATION OBJECT TelservProcess PARENT ProcessClass INSTANCE 

-------- TelservService \Nodename\Telserv\Service\$Ztn00\mmsw 

RELATION OBJECT ServiceClass PARENT TelservClass Caption "Service"; 

RELATION OBJECT ServicePidClass PARENT ServiceClass Caption *; 

RELATION OBJECT TelservService PARENT ServicePidClass INSTANCE; 

-------- TelservWindow \Nodename\Telserv\Window\$Ztn00\#Pt6bbzt 

RELATION OBJECT WindowClass PARENT TelservClass Caption "Window"; 

RELATION OBJECT WindowPidClass PARENT WindowClass Caption *; 

RELATION OBJECT TelservWindow PARENT WindowPidClass INSTANCE; 

 
 

MAP TcpipClass TO TcpProcess; 

MAP IcmpClass TO TcpIcmp; 

MAP IPClass TO TcpIP; 

MAP QioClass TO TcpQio; 

MAP RoutePidClass TO TcpRoute; 

MAP RouteClass TO TcpRoute; 

MAP RteClass TO TcpRte; 

MAP SubnetClass TO TcpSubnet; 

MAP SubnetPidClass TO TcpSubnet; 

MAP TcpClass TO TcpProcess; 

MAP PortClass TO TcpPort; 

MAP PortNumClass TO TcpPort; 

MAP PortPid1Class TO TcpPort; 

MAP PortPid2Class TO TcpPort; 
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MAP UdpClass TO TcpUdp; 

MAP TelservClass TO TelservProcess; 

MAP ServiceClass TO TelservService; 

MAP ServicePidClass     TO TelservService; 

MAP WindowClass TO TelservWindow; 

MAP WindowPidClass TO TelservWindow; 

MAP ProcessClass TO TelservProcess; 

 

EDL-MAP Statement 

The MAP statement allows you to assign a relationship between an ObjectID and an 
Entity. An abstract ObjectID is used as a "handle" to declare hierarchical relationships 
using the Relation statement. 

The following describes the MAP statement syntax: 

MAP <ObjectID> TO <Entity-Name> 

<ObjectID> is a symbolic ID used to define hierarchical relationships between entities 

and containers using the RELATION statement. 

TO <entity-name> indicates an ObjectID is associated with a specific entity name. 

Selecting a "mapped" ObjectID in its hierarchy selects the associated entity. 

Applies To: Client 

Example–See RELATION statement 


